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KATA PENGANTAR 

Buku ajar yang sekarang berada di tangan saudara-saudari merupakan wujud 
keinginan kami untuk ikut berpartisipasi dalam mencerdaskan kehidupan bangasa, 
utamanya para mahasiswa yang mendalami ilmu berkenaan dengan “Sistem 
Informasi Spasial” khususnya dibidang Kehutanan dan Sumberdaya Alam.  Buku ini 
juga merupakan perwujudan dari upaya Universitas Hasanuddin untuk berubah 
dalam pendekatan pendidikan dari “mengajar” (teaching) ke “belajar” (learning). 

Materi dalam buku ajar ini sebagian dikompilasi dari bahan-bahan yang dapat 
diunduh (download) secara gratis di internet, sebagian lagi berasal dari buku-buku 
panduan proyek “Marine and Coastal Resources Management Project”, dan tentunya 
berasal pula dari pengalaman kami yang telah mengajar, memberikan konsultasi dan 
membimbing selama lebih dari 15 tahun, baik di universitas, maupun diberbagai 
pelatihan.  Buku ajar ini tidak dimaksudkan sebagai referensi terhadap perangkat 
lunak apapun.  Bila dalam buku ini terdapat contoh-contoh yang menyebutkan dan 
menayangkan gambar tertentu berasal dari satu atau lebih perangkat lunak, maka 
hal ini semata-mata dimaksudkan untuk mempermudah penjelasan-penjelasan yang 
dikemukakan. 

Kami mengucapkan terima kasih kepada semua pihak yang telah 
berpartisipasi dalam mewujudkan buku ajar ini, utamanya rekan-rekan di 
Laboratorium Konservasi, Biologi dan Dendrologi, Laboratorium Perencanaan dan 
Sistem Informasi Kehutanan, Fakultas Kehutanan, Universitas Hasanuudin.  Ucapan 
terima kasih kami sampaikan kepada Pimpinan dan Staf Fakultas Kehutanan 
Universitas Hasanuddin yang telah mengupayakan insentif dalam penyusunan buku 
ajar ini. 

Kami berharap sumbangan pemikiran kecil ini bisa bermanfaat bagi 
peningkatan sumber daya manusia yang mendorong peningkatan pemakaian SIG 
untuk Kehutanan dan Pengelolaan SDA.  Tentunya tak ada gading yang tidak retak, 
namun kekurangan-kekurangan yang ada diharapkan dapat memicu semua pihak, 
baik penyusun dan pembaca serta para mahasiswa, untuk melakukan perbaikan di 
kemudian hari. 

 

 

Makassar, Oktober 2009 
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BAB I : PENGANTAR SISTEM INFORMASI GEOGRAFIS 

 

Sistem Infornasi Geografis, atau dalam bahasa Inggeris lebih dikenal dengan 

Geographic Information System, adalah suatu sistem berbasis komputer yang 

digunakan untuk mengolah dan menyimpan data atau informasi yang bereferensi 

geografis (Aronof, 1989). 

 

Beberapa terminologi lain yang memiliki pengertian kurang lebih sama adalah sebagai 

berikut: 

• Geographical Information system, merupakan terminologi yang digunakan di 

Eropa. 

• Geomatique, Terminologi yang dgunakan di Negara Kanada, utamanya negara 

bagian yang berbahasa Perancis. 

• Georelational Information system, Terminologi berdasar pada tekhnologi  

• Natural Resources Information system, Terminologi berdasar pada disiplin ilmu 

pengelolaan sumberdaya alam  

• Spatial Information System, Terminologi disiplin non-geography 

• Multipurpose Geographic Data System, Terminologi umum yang digunakan 

dikalangan pemerintahan. 

•  

Untuk kepentingan buku ini, terminologi yang akan digunakan adalah Sistem Informasi 

Geografis dan singkatannya SIG, sebagai terjemahan dari Geograpic Information 

System (GIS). 

 

Berbagai definisi lain berdasarkan fokus pendekatannya adalah sebagai berikut : 

 

1. PENDEKATAN PROSES (process oriented approach); seperangkat fungsi dengan 

kemampuan yang canggih yang   dapat digunakan oleh para profesional untuk 

menyimpan, menampilkan, dan memanipulasi/ mengoreksi data geografis/spasial 

(Ozemoy et al in Maguire, 1986) 
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2. PENDEKATAN KEGUNAAN ALAT (toolbox approach); seperangkat peralatan yang 

dipergunakan untuk mengoleksi, menyimpan, membuka,  mentransformasi dan 

menampilkan data spasial dari sebuah kondisi geografis yang sebenarnya (real 

world). 

3. PENDEKATAN DATABASE (data base approach); sebuah sistim basis data 

(database) dimana sebagian besar data diindex secara spatial/geografis dan 

dioperasikan dengan menggunakan seperangkat prosedur yang ditujukan untuk 

menjawab pertanyaan yang berkaitan dengan data spasial/geografi. 

 

Definisi yang terakhir ini yang umumnya digunakan dalam menjelaskan tentang 

pengertian SIG.  Dalam berbagai definisi di atas jelas selalu ditegaskan berkenaan 

data/informasi spatial/geografis.  Jadi kata kunci dalam SIG adalah data yang dikaitkan 

dengan letak geografis di permukaan bumi, atau dapat dikatakan keterkaitan antara 

data geografis dengan data atributnya.  Dengan demikian secara umum dapat 

dikatakan pengertian dari SIG sebagai berikut: 

 

” Suatu satuan/unit komponen yang terdiri dari perangkat keras, perangkat lunak, 

data geografis dan sumberdaya manusia yang bekerja bersama secara untuk 

memasukan, menyimpan, memperbaiki, memperbaharui, mengelola, memanipulasi, 

mengintegrasikan, menganalisa dan menampilkan data dalam suatu informasi berbasis 

geografis ”. 

 

Dari pengertiannya SIG berbasis pada komputer, namun konsep SIG itu sendiri dapat 

dilakukan secara manual, melalui “overlay” peta-peta dan menganalisis data yang 

terkait dengan peta-peta tersebut dalam format tabel.  Bila tidak tersedia perangkat 

lunak untuk bekerja dengan SIG, atau perangkat keras yang tersedia spesifikasinya 

kurang memadai untuk digunakan dalam SIG, maka secara manual “overlay” peta-peta 

dapat dilakukan dan data yang terkait dengannya dianalisis dengan bantuan perangkat 

lunak “spread sheet”, seperti Excel.  Uraian selanjutnya diasumsikan SIG berbasis 

komputer, walaupun sebagian darinya dapat berlaku juga bila dikerjakan secara 

manual.  
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SIG mempunyai kemampuan untuk menghubungkan berbagai data pada suatu titik 

tertentu di bumi, menggabungkannya, menganalisis dan akhirnya memetakan hasilnya, 

atau menampilkannya dalam format grafik dan tabel. Data yang akan diolah pada 

SIG merupakan data spasial yaitu sebuah data yang berorientasi geografis dan 

merupakan lokasi yang memiliki sistem koordinat tertentu, sebagai dasar referensinya. 

Dengan demikian aplikasi SIG dapat menjawab beberapa pertanyaan berkenaan 

dengan : 

 

1. Lokasi, ada apa di lokasi tertentu (di seberang sungai, di lereng gunung, di Desa A, 

dsb.), apa yang terjadi di lokasi tersebut (rawan banjir, ada deposit emas, curah 

hujannya tinggi, dsb.). 

2. Kondisi, dimana lokasi jalan yang paling macet, berapa besar potensi tambang yang 

ada di Kabupaten X, dimana lokasi yang paling tepat untuk pembangunan HTI 

Sengon, dsb. 

3. Kecenderungan/Trend, sebesar apa perkembangan perumahan di Tamalanrea 

pada tahun 2015, seberapa besar tingkat degradasi kawasan hutan lindung di DAS 

Bila, dsb. 

4. Pola, bagaimana hubungan antara jenis tanah dan produksi gondorukem, 

bagaimana pola penyebaran penyakit di sekitar kawasan industri kayu, bagaimana 

pola permudaan Mangrove di muara Sungai Cerekang, dsb. 

5. Simulasi/Modeling, berapa besar menurunnya erosi bila luas hutan di hulu Sungai 

Jeneberang meningkat sebesar 1.000 hektar, dsb. 

 

Telah dijelaskan diawal bahwa SIG adalah suatu kesatuan membentuk sistem yang 

terdiri dari berbagai komponen, tidak hanya perangkat keras komputer beserta dengan 

perangkat lunaknya saja, akan tetapi harus tersedia data geografis yang benar dan 

sumberdaya manusia untuk melaksanakan perannya dalam memformulasikan dan 

menganalisa persoalan yang menentukan keberhasilan SIG. 
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1.2. Basis Data Spasial dan Atribut 

1.2.1 Basis Data Spasial 

Sebagian besar data yang akan ditangani dalam SIG merupakan data spasial yaitu 

sebuah data yang berorientasi geografis, memiliki sistem koordinat tertentu sebagai 

dasar referensinya dan mempunyai dua bagian penting yang membuatnya berbeda dari 

data lain, yaitu informasi lokasi (spasial) dan informasi deskriptif (attribute) yang 

dijelaskan berikut ini : 

 

1. Informasi lokasi (spasial), berkaitan dengan suatu koordinat baik koordinat geografi 

(lintang dan bujur) maupun koordinat Cartesian XYZ (absis, ordinat dan ketinggian), 

termasuk diantaranya informasi datum dan sistem proyeksi. 

2. Informasi deskriptif (atribut) atau informasi non spasial, suatu lokasi yang memiliki 

beberapa keterangan yang berkaitan dengannya, contohnya : jenis vegetasi, 

populasi, luasan, kode pos, dan sebagainya.  Informasi atribut seringkali digunakan 

pula untuk menyatakan kualitas dari lokasi. 

 

Secara sederhana format dalam bahasa komputer berarti bentuk dan kode 

penyimpanan data yang berbeda antara file satu dengan lainnya. Dalam SIG, data 

spasial dapat direpresentasikan dalam dua format, yaitu: 

 

1. Data vektor merupakan bentuk bumi yang direpresentasikan ke dalam kumpulan 

garis, area (daerah yang dibatasi oleh garis yang berawal dan berakhir pada titik 

yang sama), titik dan nodes (merupakan titik perpotongan antara dua buah garis).  

Keuntungan utama dari format data vektor adalah ketepatan dalam 

merepresentasikan fitur titik, batasan dan garis lurus. Hal ini sangat berguna untuk 

analisa yang membutuhkan ketepatan posisi, misalnya pada basisdata batas-batas 

kadaster. Contoh penggunaan lainnya adalah untuk mendefinisikan hubungan 

spasial dari beberapa fitur. Kelemahan data vektor yang utama adalah 

ketidakmampuannya dalam mengakomodasi perubahan gradual.  Format data vektor 

dapat dilihat pada Gambar 1. 



5 
 

2. Data raster (atau disebut juga dengan sel grid) adalah data yang dihasilkan dari 

sistem Penginderaan Jauh. Pada data raster, obyek geografis direpresentasikan 

sebagai struktur sel grid yang disebut dengan pixel (picture element).  Pada data 

raster, resolusi (definisi visual) tergantung pada ukuran pixel-nya. Dengan kata lain, 

resolusi pixel menggambarkan ukuran sebenarnya di permukaan bumi yang diwakili 

oleh setiap pixel pada citra. Semakin kecil ukuran permukaan bumi yang 

direpresentasikan oleh satu sel, semakin tinggi resolusinya. Data raster sangat baik 

untuk merepresentasikan batas-batas yang berubah secara gradual, seperti jenis 

tanah, kelembaban tanah, vegetasi, suhu tanah dan sebagainya. Keterbatasan 

utama dari data raster adalah besarnya ukuran file; semakin tinggi resolusi grid-nya 

semakin besar pula ukuran filenya dan sangat tergantung pada kapasistas perangkat 

keras yang tersedia.  Masing-masing format data mempunyai kelebihan dan 

kekurangan. Pemilihan format data yang digunakan sangat tergantung pada tujuan 

penggunaan, data yang tersedia, volume data yang dihasilkan, ketelitian yang 

diinginkan, serta kemudahan dalam analisa. Data vektor relatif lebih ekonomis dalam 

hal ukuran file dan presisi dalam lokasi, tetapi sangat sulit untuk digunakan dalam 

komputasi matematik. Sedangkan data raster biasanya membutuhkan ruang 

penyimpanan file yang lebih besar dan presisi lokasinya lebih rendah, tetapi lebih 

mudah digunakan secara matematis.  Gambar 2 memberikan ilustrasi dari format 

data raster. 

 

 
Gambar 1. Format Data Vektor. 



6 
 

 
Gambar 2. Format Data Raster. 

 

1.2.2 Data Atribut 
 

Data atribut memberikan gambaran atau menjelaskan informasi berkaitan dengan 

fitur peta atau coverage SIG.  Data atribut dapat disimpan sebagai/dalam format 

angka (numbers) maupun karakter (characters).  Pada Sistem Informasi Geografis, 

utamanya di ArcView dan ARC/INFO, data atribut di hubungkan (linked) dengan 

data spasial melalui “identifier”, atau sering disingkat ID, yang terkait di fitur.  Pada 

ARC/INFO file data atribut disimpan sebagai file INFO disebut “feature attribute 

tables”.  Pada ArcView file dikenal dengan nama “shape” file (*.SHP) yang terdiri 

dari serangkaian file.  Atribu disimpan pada file dengan nama ekstensi *.dbf. 

 

Sebagai contoh dapat disimak Tabel 1, Tabel 2 dan Gambar 3 sebagai berikut. 

Tabel 1. Koordinat Fitur. 

ID Jalan Koordinat X,Y 

1 3,5 5,5 

2 5,5 9,5 

3 9,5 11,5 

4 6,8 6,7 5,6 5,5 

5 9,5 9,3 
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Tabel 2. Atribut Fitur. 

ID Jalan Kelas Jalan Permukaan Lebar Nama 

1 1 Aspal 48 Jl. Jati 

2 1 Aspal 48 Jl. Jati 

3 1 Aspal 48 Jl. Jati 

4 2 Aspal 36 Jl. Meranti 

5 3 Aspal 30 Jl. Akasia 

 

 

 
Gambar 3. Fitur Jalan 

 

Pada Gambar 3 terlihat fitur jalan dengan setiap potongannya memiliki ID yang unik.  

Untuk semua fitur yang terdapat di SIG ID nya harus unik, artinya dalam 1 coverage 

atau layer tidak boleh ada fitur yang sama ID nya.  Fitur kemudian terkait dengan 

tabel koordinatnya yang merupakan basis data geografisnya (Tabel 1).  Sedangkan 

penjelasan fitur disimpan dalam tabel atribut (Tabel 2) dimana dapat terdiri dari 

beberapa kolom (field) seperti misalnya kelas jalan, perkerasannnya dan namanya.  

Pada dasarnya jumlah kolom ini hanya dibatasi oleh kemampuan perangkat lunak 

dan memori komputer. 
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Tabel atribut fitur dapat berupa “PAT” (polygon atrribute table atau point attribut 

table) atau “AAT” (arc atribut table).  Tabel tabel ini terbentuk dengan sendirinya bila 

topologi dijalankan menggunakan ARC/INFO.  Tabel atribut ini dapat diolah 

menggunakan perangkat lunak SIG seperti ArcMAP, maupun menggunakan 

perangkat lunak lain yang dapat mengolah file database, seperti Excel, dBase, 

Foxbase, Quatro Pro, maupun Access.  Untuk mengembalikannnya pada SIG yang 

harus dijaga adalah kolom ID nya agar tidak terlepas dari data.  

 

1.2.3 Sumber Data Spasial 
 

Data spasial yang digunakan dalam proyek SIG dapat berasal dari berbagai sumber.  

Beberapa sumber yang umumnya digunakan dalam pembangunan basis data 

spasial adalah sebagai berikut: 

 

a. Peta Analog 

Peta analog (antara lain peta topografi, peta tanah, peta kawasan hutan dan 

perairan, dan sebagainya) yaitu peta dalam bentuk cetak. Pada umumnya peta 

analog dibuat dengan teknik kartografi, kemungkinan besar memiliki referensi 

spasial seperti koordinat, skala, arah mata angin dan sebagainya.  Peta analog 

yang meliputi wilayah yang luas, seperti peta topografi, peta penggunaan lahan 

dan peta lereng, umumnya bersumber pada citra satelit atau foto udara. 

Dalam tahapan SIG sebagai keperluan sumber data, peta analog dikonversi 

menjadi peta digital dengan cara format raster diubah menjadi format vektor 

melalui proses dijitasi (digitasi) sehingga dapat menunjukan koordinat 

sebenarnya di permukaan bumi.  Proses dijitasi dapat pula dilakukan langsung 

bila tersedia meja dijitasi.  Namun dewasa ini sebagian besar digitasi peta analog 

dilakukan “on screen”, atau langsung di monitor setelah peta dikonversi menjadi 

peta raster melalui pemindai (scanner).  

b. Citra Penginderaan Jauh 

Data Penginderaan Jauh (antara lain citra satelit dan foto-udara), merupakan 

sumber data yang terpenting bagi SIG, utamanya untuk memantau kondisi lahan, 
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karena ketersediaanya secara berkala dan mencakup area tertentu yang cukup 

luas (Landsat TM 185 Km2, SPOT 60 Km2, ALLOS 60Km2).  Dengan adanya 

bermacam-macam satelit di ruang angkasa dengan spesifikasinya masing-

masing, kita bisa memperoleh berbagai jenis citra satelit untuk beragam tujuan 

pemakaian. Data citra satelit sebagian besar disediakan dalam format raster. 

c. Data Hasil Pengukuran 

Data pengukuran lapangan yang dihasilkan berdasarkan teknik pemetaan 

tersendiri, pada umumnya data ini merupakan sumber data atribut, contohnya: 

batas administrasi, batas kepemilikan lahan, batas persil, batas hak 

pengusahaan hutan, trase (alur) jalan hutan dan lain-lain. 

d. Data Global Positioning System 

Teknologi Global Positioning System (GPS) memberikan terobosan penting 

dalam menyediakan data bagi SIG. Keakuratan pengukuran GPS semakin tinggi 

dengan berkembangnya teknologi. Data ini biasanya direpresentasikan dalam 

format vektor. Pengumpulan data dengan GPS merupakan pengganti pemetaan 

terestrial konvensional menggunakan Teodolit atau sejenisnya. 

Keterkaitan antara berbagai sumber data dalam SIG dapat dilihat pada Gambar 

4.  Sumber data utama adalah citra penginderaan jauh, peta yang dapat pula 

bersumber dari citra penginderaan jauh dan data hasil survey terestrial, termasuk 

yang menggunakan alat GPS.  Sedangkan data turunan dapat berupa hasil 

analisis geografis, maupun hasil analisis basis data atribut.  Sedangkan luaran 

dari SIG, sebagaimana dapat dilihat pada Gambar 4, sangat beragam, mulai dari 

informasi sederhana, peta-peta digital dan cetakannya, sampai buku laporan.  

Oleh karenanya dapat disimpulkan bahwa SIG/GIS adalah basis data geografis 

yang terkait dengan data atribut. 
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Gambar 4. Diagram Skematis Sistem Informasi Geografis. 

 

1.3. Sistem Penayangan Kartografis 

1.3.1 Peta 

Peta adalah gambaran sebagian atau seluruh muka bumi baik yang terletak di atas 

maupun di bawah permukaan dan disajikan pada bidang datar pada skala dan proyeksi 

tertentu (secara matematis). Karena dibatasi oleh skala dan proyeksi maka peta tidak 

akan pernah selengkap dan sedetail aslinya (bumi), karena itu diperlukan 

penyederhanaan dan pemilihan unsur yang akan ditampilkan pada peta.  Skala peta 

menggambarkan sejauhmana penyederhanaan dilakukan.  Pada peta skala kecil 

(misalnya 1:1.000.000) penyederhanaan dilakukan samapai tinkat yang cukup umum, 
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sehingga yang diperolah adalah gambaran umum tentang wilayah yang dipetakan.  

Sedangkan pada peta berskala besar (misalnya 1:5.000) informasi yang ditayangkan 

dapat sangat rinci.  Peta dapat dibuat dan ditayangkan dalam sistem proyeksi bumi, 

maupun sistem proyeksi, yang umumnya digunakan di Indonesia adalah Universal 

Transverse Mercator (UTM). 

 

Posisi suatu titik biasanya dinyatakan dengan koordinat (dua-dimensi atau tiga-dimensi) 

yang mengacu pada suatu sistem koordinat tertentu. Sistem koordinat itu sendiri dapat 

didefinisikan berdasarkan tiga parameter berikut, yaitu : 

 

1. Lokasi titik nol dari sistem koordinat. Posisi suatu titik di permukaan bumi umumnya 

ditetapkan dalam/terhadap suatu sistem koordinat terestris. Titik nol dari sistem 

koordinat terestris ini dapat berlokasi di titik pusat massa bumi (sistem koordinat 

geosentrik), maupun di salah satu titik di permukaan bumi (sistem koordinat 

toposentrik). 

2. Orientasi dari sumbu-sumbu koordinat.  Posisi tiga-dimensi (3D) suatu titik di 

permukaan bumi umumnya dinyatakan dalam suatu sistem koordinat geosentrik. 

Tergantung dari parameter-parameter pendefinisi koordinat yang digunakan, dikenal 

dua sistem koordinat yang umum digunakan, yaitu sistem koordinat Kartesian (X,Y,Z) 

dan sistem koordinat Geodetik (L,B,h), yang keduanya diilustrasikan pada Gambar 5. 

 
Gambar 5. Ilustrasi sistem koordinat Kartesian dan Sistem Koordinat Geodetik. 
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Koordinat 3D suatu titik juga bisa dinyatakan dalam suatu sistem koordinat toposentrik, 

yaitu umumnya dalam bentuk sistem koordinat Kartesian (N,E,U) yang diilustrasikan 

pada Gambar 6. 

 

 
Gambar 6. Ilustrasi Koordinat Kartesian 3D. 

 

Parameter - parameter (kartesian, curvilinear) yang digunakan untuk mendefiniskan 

posisi suatu titik dalam sistem koordinat tersebut. Posisi titik juga dapat dinyatakan 

dalam 2D, baik dalam (L,B), ataupun dalam suatu sistem proyeksi tertentu (x,y) seperti 

Polyeder, Traverse Mercator (TM) dan Universal Traverse Mercator (UTM). 

 

Pada dasarnya bentuk bumi tidak datar tapi mendekati bulat maka untuk 

menggambarkan sebagian muka bumi untuk kepentingan pembuatan peta, perlu 

dilakukan langkah-langkah tertentu agar bentuk yang mendekati bulat tersebut dapat 

didatarkan dan distorsinya dapat terkontrol, untuk itu dilakukan proyeksi ke bidang 

datar. 

 

Proyeksi UTM dibuat oleh US Army sekitar tahun 1940-an. Sejak saat itu proyeksi ini 

menjadi standar untuk pemetaan topografi. 
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Sifat-sifat proyeksi UTM dapat digambarkan sebagai berikut: 

1. Proyeksi ini adalah proyeksi Transverse Mercator yang memotong bola bumi pada 

dua buah meridian, yang disebut dengan meridian standar. Meridian pada pusat 

zone disebut sebagai meridian tengah.  

2. Daerah diantara dua meridian ini disebut zone. Lebar zone adalah 6 derajad 

sehingga bola bumi dibagi menjadi 60 zone. 

3. Perbesaran pada meridian tengah adalah 0,9996. 

4. Perbesaran pada meridian standar adalah 1. 

5. Perbesaran pada meridian tepi adalah 1,001. 

6. Satuan ukuran yang digunakan adalah meter. 

 

Untuk menghindari koordinat negatif dalam proyeksi UTM setiap meridian tengah dalam 

tiap zone diberi harga 500.000 mT (meter timur). Untuk harga-harga ke arah utara, 

ekuator dipakai sebagai garis datum dan diberi harga 0 mU (meter utara). Untuk 

perhitungan ke arah selatan ekuator diberi harga 10.000.000 mU.  Gambar 5 

memperlihatkan koordinat yang digunakan dalam proyeksi UTM. 

Wilayah Indonesia terbentang antara 90° – 144° BT dan 11° LS – 6° LU terbagi dalam 9 

zone UTM, dengan demikian wilayah Indonesia dimulai dari zona 46 sampai zona 54 

(meridian sentral 93° – 141° BT). 

 

 
Gambar 5. Sistem Koordinat Pada Proyeksi UTM. 
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1.3.2 Menampilkan Data Spasial 

1.3.2.1. Menampilkan Data Berdasarkan Kategori Data Attribut 
A. Menampilkan Data dalam Semua Kategori 

1. Jalankan ArcMap. 

2. Tambahkan layer vegetasi yang terletak pada direktori C:\BasicArcGIS\Data\Aceh 

Besar.mdb\AcehBesarVegetasi.shp 

Layer ini menunjukkan sebaran vegetasi yang terdapat di Kabupaten Aceh Besar 

berdasarkan hasil klasifikasi dari citra satelit. Perhatikanlah bahwa data tersebut 

belum dapat menggambarkan atau memberikan informasi apa-apa tentang 

vegetasi pada saat pertama kali ditampilkan di ArcMap. 

3. Gunakan tool ”identifikasi” untuk menampilkan klasifikasi vegetasi di beberapa 

areal. 

 
4. Buka table atribut dari layer Vegetasi untuk melihat lebih jelas gambaran sebaran 

vegetasi di Kabupaten Aceh Besar. 

Sekarang anda dapat melihat atributnya dan kita akan mencoba untuk mengubah 

tampilan layer berdasarkan informasi yang terdapat pada data tabel vegetasi aceh 

besar. 

5. Klik dua kali pada layer Aceh Besar Vegetasi, maka sebuah kotak dialog Layer 
properties akan muncul. Klik pada Tab Symbology. 

6. Arahkan kursor anda pada panel sebelah kiri dibawah daftar pilihan show, 

selanjutnya klik padapilihan Categories dan kemudian arahkan kursor anda ke 
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daftar pilihan Value Field dan pilih ”DESCRIPTIO”

 
Gambar 7.2 

 

7. Klik pada tombol Add All Values. Nilai data akan ditampilkan dengan warna yang 

telah disediakan. Non-aktifkan symbol all other values dengan cara 

menghilangkan tanda centang (√) pada bagian kotak dan kemudian klik pada 

tombol OK.  
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Gambar 7.3 

 

Tampilan peta akan berubah sesuai dengan kategori yang anda buat. ArcMap 

menyediakan beberapa pilihan warna dalam Color Ramp. Anda bisa menggunakan 

warna yang telah tersedia dan bisa pula merubahnya sesuai dengan kebutuhan dan 

keinginan anda. 

 

8. Untuk mengganti warna yang telah ada pada Categories dengan langkah sebagai 

berikut: 

 

1. Buka ulang kotak dialog Layer Properties kemudian klik pada Tab 

Symbology. 

2. Double klik pada kotak warna yang akan anda ganti warnanya (misalnya kotak 

Aquaculture ponds). 
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Gambar 7.4 

3. Selanjutnya akan tampil kotak dialog Symbol Selector, pilihlah warna yang 

anda sukai dan klik OK, kemudian kotak dialog Layer Properties akan muncul 

di layar anda. Klik OK pada bagian bawah kotak dialog Layer Properties dan 

anda akan melihat perubahan warna sesuai dengan yang anda pilih. 

 
Gambar 7.5 
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B. Menampilkan Data Berdasarkan Kategori yang Diinginkan 

1. Buka ulang kotak dialog Layer Properties, kemudian klik pada Tab Symbology. 

2. Klik pada tombol Remove All – semua nilai yang ada akan menghilang dari 

tampilan. 

3. Jika anda ingin menampilkan beberapa data tertentu. Klik pada tombol Add 
Values dan pilihlah data yang ingin anda tampilkan. 

 

 
Gambar 7.6 

 

Apabila anda ingin memilih lebih dari satu data, anda harus menekan tombol ctrl 
pada keyboard komputer anda dan pilihlah data yang akan ditampilkan secara 

bersamaan. 

4. Pilih warna yang anda inginkan, misalnya biru tua untuk tambak (aquaculture 

ponds), biru muda untuk sawah (paddi fields) dan hijau muda untuk padang 

rumput (grasslands). Klik OK pada kotak dialog Layer Properties. 

5. Peta akan berubah dan data tidak akan seluruhnya ditampilkan, hanya yang dipilih 

saja yang akan ditampilkan. 
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C. Membuat Layer Transparan 

Apabila ada data yang tumpang tindih dan anda ingin menampilkan keduanya pada 

saat bersamaan, maka anda harus membuat salah satu data menjadi transparan. Pada 

latihan ini anda akan belajar untuk membuat tampilan data yang transparan. 

1. Tambahkan layer kecamatan Aceh Besar yang terletak dalam direktori 

C:\BasicArcGIS\Data\AcehBesar.mdb\AcehbesarKec.shp 

2. Klik dua kali pada layer yang akan dibuat transparan (dalam latihan ini 

AcehbesarKec), setelah muncul kotak dialog Layer Properties, klik pada Tab 

Display. 

 
Gambar 7.7 

 

3. Atur transparansi sesuai keinginan anda (semakin tinggi nilai persentasi yang 

dibuat maka tampilan yang dihasilkan semakin transparan). 

4. Anda bisa melihat perubahan yang terjadi, layer yang terdapat pada bagian atas 

terlihat transparan sehingga anda dapat melihat layer yang ada dibawahnya. 

5. Simpanlah pekerjaan yang baru saja anda buat. 

6. Tutup ArcMap. 
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1.3.2.2. Menampilkan Data dalam Beberapa Kelompok (Class) 

A. Menampilkan Data dengan Gradasi Warna 

Pada awal pelatihan ini anda telah belajar menggunakan unique value untuk 

mengkategorikan tampilan data pada peta. Sekarang anda akan melakukan 

pengelompokan dengan gradasi warna. 

 

1. Start ArcMap 

2. Tambahkan data AcehBesarKec dalam direktori C:\BasicArcGIS\Data\Aceh 

Besar.mdb\AcehbesarKec.shp 

3. Double Klik pada layer AcehBesarKec, maka kotak dialog Layer Properties akan 

muncul pada layar monitor anda. Klik pada Tab Symbology. 

4. Klik pada Quantities dan selanjutnya pilih Graduated colours. Pilih POP_TH_1 

sebagai nilai yang akan akan ditampilkan dalam layer : 

 
Gambar 7.8 

 

5. ArcMap akan membantu menuntun anda dalam pemilihan warna berdasarkan 

kelas nilai data layer tersebut. Anda dapat menentukan sendiri berapa kelas yang 

anda inginkan. Setelah selesai anda ubah kemudian klik tombol OK.. 
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Gambar 7.9 

6. Peta akan berubah . Sekarang buka ulang kotak dialog Layer Properties dan 

ganti pengaturan warna, sorot kursor anda ke Color Ramp dan pilihkan warna 

yang sudah disediakan ArcMap sesuai dengan keinginan anda. 

 
Gambar 7.10 

B. Menampilkan Data dengan Gradasi Simbol 

1. Copy data layer AcehbesarKec dengan cara klik kanan pada mouse anda dan pilih 

Copy untuk menduplikasikan layer AcehbesarKec. 

2. Ganti nama layer yang diatas dengan Populasi Tahun ke 1 atau sesuai dengan 

keperluan anda agar lebih informatif, demikian juga dengan layer yang di bawah. 
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Gambar 7.11 

3. Buka Layer Properties pada layer Aceh Besar Kecamatan, klik pada Tab 

Symbology. 

4. Klik pada Quantities dan kemudian klik pada tabular Graduated symbols. Pilih 

POP_TH_1 sebagai nilai yang akan ditampilkan pada form isian Value: 

 
Gambar 7.12 

5. Klik pada tombol Background dan atur warna ke Hollow. Ganti warna di template 

sesuai dengan keinginan anda. 

 
Gambar 7.13 
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Gambar 7.14 

6. Klik Apply. Ubahlah ukuran simbolnya agar mudah terbaca jika diperlukan. 

7. Kita sudah mempelajari 2 cara menampilkan data yaitu dengan degradasi warna 

dan dengan symbol seperti yang terlihat pada gambar di bawah ini. Menurut anda 

cara manakah yang lebih mudah agar informasi yang ada di peta lebih mudah 

dibaca ? 
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Gambar 7.15 

8. Simpanlah dokumen peta yang sudah anda buat. 

 

C. Menampilkan Data dengan Grafik 

Kita telah mempelajari cara menampilkan data spasial dengan membagi-bagi dalam 

beberapa kelas dan juga menampilkan dalam katergori tertentu. Sekarang kita akan 

mempelajari menampilkan attribut data spasial dalam grafik. 

 

1. Double klik simbol layer AcehbesarKec, kemudian pilih tab Symbology. 
2. Pada jendela show pilih Charts. Dibawah kategori Chart anda menemukan 

beberapa tipe grafik yaitu Pie, Bar/Column dan Stacked. Untuk latihan ini kita akan 
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membuat grafik untuk membandingkan penduduk Aceh besar pada tahun pertama 

dengan tahun kedua. Tipe grafik yang tepat untuk kasus ini adalah Bar/Column. 

3. Karena kita akan membuat grafik Bar, maka pilih Bar/Column. 

4. Pada kolom Field Selection pilih POP_TH_1. Kemudian klik tombol “>” 

5. Kemudian pilih POP_TH_2. kemudian klik tombol “>”. 

 
Gambar 7.16 

 

6. Setelah kedua field selesai ditambahkan. Klik tombol OK. Anda akan melihat 

hasilnya seperti dalam gambar 7.17 

 



26 
 

 
Gambar 7.17 

 

D. Menampilkan Tabel Atribut dan Merubah Tampilannya 

1. Menampilkan Tabel Attribut 

a. Klik kanan pada layer AcehbesarKec pada TOC dan pilihlah Open attribute 
table 

 
Gambar 7.18 

Tabel atribut pada layer akan terbuka – lihatlah data yang dimilikinya. Data ini 

menunjukkan luas daerah, populasi dari kecamatan per tahun, dan lain-lainnya. 
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b. Klik pada bar judul berwarna abu-abu untuk Nama_Kec dan pindahkan kolom 

ini ke sebelah kiri. Anda dapat memindahkan kolom pada tabel atribut window 

untuk memudahkan anda membaca data. 

 
Gambar 7.19 

 

c. Sekarang pindahkan kolom ke ujung kiri atribut window. Klik kanan pada bar 

judul berwarna abu-abu untuk Nama_Kec dan pilihlah Freeze/Unfreeze 
Column dari menu. 

 
Gambar 7.20 

d. Sekarang scroll ke kanan window – perhatikan bahwa Nama_Kec telah 

menetap. 

e. Untuk membuat nama kecamatan agar mudah ditemukan, anda akan 

mengurutkan data. Klik kanan pada bar judul berwarna abu-abu untuk 

Nama_Kec dan pilihlah Sort Ascending dari menu. Nama kecamatan akan 

muncul pada ascending order. 

f. Untuk mendapat petunjuk dari maksimum dan minimum luas kecamatan, 

urutkan pada kolom SQKM pada ascending atau descending order. 

g. Sekarang set window untuk me–list kembali kecamatan pada ascending order 

(berdasarkan kolom Nama_Kec) 

h. Untuk melihat data lebih dekat gunakan langkah – langkah berikut ini : 
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1. Klik kanan bar judul berwarna abu-abu untuk SQKM dan pilihlah Statistics 
dari menu. 

2. Sebuah dialog akan muncul dengan jarak antara statistics dan grafik. Anda 

dapat melihat figure dari field lainnya dari dialog ini. Klik pada drop-down 

arrow untuk Field dan pilihlah POP_th_1. Lihatlah pada fields lainnya untuk 

mendapatkan petunjuk bagaimana nilai dapat berubah. 

 

 
Gambar 7.21 

2. Merubah Atribut Data 

Pada tabel attribut, perhatikan kolom judul tampil dengan warna abu-abu – ini 

menunjukkan bahwa anda tidak dapat merubahnya pada saat ini. Jika anda 

mencoba menulis nilai apapun dalam tabel anda tidak akan bisa. Sebelum anda 

melakukan perubahan anda harus ‘membuka kunci’ tabel. Dengan langkah berikut 

ini: 

a. Klik pada tombol Editor Toolbar 

 

 
Gambar 7.22 

b. Editor toolbar akan muncul. Dari toolbar klik pada Editor > Start Editing 
c. Buka tabel atribut layer AcehbesarKec 
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 Sekarang perhatikan semua kepala kolom pada atribut window memiliki latar 

putih menunjukkan mereka sudah dapat di edit.. Beberapa nama kecamatan 

yang tidak benar maka sekarang dapat anda perbaiki. 

d. Untuk mengubah atau menghilangkan nilai terdapat beberapa cara, yaitu ; 

1. Untuk mengubah nilai, pilih field record dan ketik pada nilai yang baru. 

2. Untuk menghilangkan nilai, pilih field record dan tekan kunci Delete. 

3. Gunakan Find & Replace tool (cara yang lebih cepat!). 

4. Sekarang anda akan memindahkan beberapa teks secara otomatis. Klik 

pada field Nama_Kec dan kemudian klik pada tombol Options. 

5. Dari menu pilihlah Find and Replace. Anda ingin menemukan teks yang 

tidak sesuai dan menggantinya dengan teks yang anda inginkan (teks ini 

tidak seharusnya ada disitu). Ketik teks yang salah pada field Find What dan 

ketik teks yang anda inginkan atau tinggalkan field Replace kosong. 

6. Klik pada Find Next dan kemudian Replace untuk melihat semua kesalahan 

pada tabel. 

7. Ketika selesai pilih Editor > Stop Editing (dari toolbar Editor). Klik pada Yes 
untuk menyimpan perubahan anda. 

8. Simpan pada dokumen peta. 

E. Memilih Features 

 

Sekarang anda akan melihat hubungan antara atribut data dan grafik pada data frame. 

Anda akan melihat hubungannya dengan memilih data – dari data atribut dan kemudian 

feature geografis pada peta. 

1. Klik pada kotak abu-abu di sebelah kiri jajaran pada window atribut. 
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Gambar 7.23 

2. Pada menu utama ArcMap pilih View > Zoom Data > Zoom to Selected 
Features. ArcMap akan men-zoom in dan batas kecamatan yang cocok dengan 

record yang anda pilih akan di-highlight. 

3. Coba kerjakan langkah – langkah di atas pada kecamatan lainnya. 

4. Tambahkan layer AcehbesarDesa yang terletak dalam direktori 

C:\BasicArcGIS\Data\AcehBesar.mdb\AcehbesarDesa.shp 

Sekarang anda akan memilih beberapa batas kecamatan dan kemudian 

memeriksa atributnya. Untuk menghindari kesalahan ketika memilih fitur dalam 

layer AcehbesarKec dengan layer AcehbesarDesa, anda akan membuat layer 

AcehbesarDesa non-selectable. 

5. Klik pada menu Selection dan pilihlah Set Selectable Layers. 

6. Matikan checkbox yang terpilih untuk Acehbesardesa dan klik Close. 
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Gambar 7.24 

7. Dari toolbar Tools klik pada tombol Select Features. 

8. Klik pada salah satu kecamatan – yang akan terpilih. Anda mungkin tidak dapat 

melihat hubungan atribut records pada window atribut. Anda dapat 

memperbaikinya dengan mudah. 

9. Dari window atribut pilih pada Show : tombol Selected (hal ini hanya akan 

menampilkan record yang terpilih). 

 
Gambar 7.25 

10. Cobalah pada beberapa kecamatan lainnya. Ketahuilah jika anda memilih fitur 

baru, pada satu waktu hanya satu yang terpilih–dengan kata lain setiap kali anda 

klik seleksi anda akan terhapus dan seleksi baru akan dibuat. Terdapat beberapa 

cara anda dapat menyeleksi lebih dari satu fitur. 

11. Klik pada menu Selection dan pilihlah Set Selectable Layers. Aktifkan kembali 

layer AcehbesarDesa sehingga jadi selectable. 

12. Memilih salah satu pedesaan. Sekarang tahan tombol SHIFT dan pilih yang 

lainnya – perhatikan ketika mereka ditambahkan pada selection. 

13. Sekarang klik dan drag melampaui area – perhatikan bahwa semua fitur yang 

dipindahkan dengan cursor telah selected. 

14. Hilangkan pilihan dengan meng-klik pada menu Selection dan pilih Clear 
Selected Features. Sekarang anda akan mengganti metode penggunaan 

ArcMap menjadi select features. 
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15. Sekarang klik pada beberapa pedesaan (jangan gunakan SHIFT atau drag) dan 

catat bahwa setiap kali anda klik fitur akan ditambahkan pada selection. Hal ini 

akan berpengaruh pada pemisahan data tekstual dari seleksi geografis. 

16. Ubah kembali metode pemilihan ke setting default dengan meng-klik pada menu 

Selection dan pilih Interactive Selection Method > Create New Selection. 

17. Simpan dokumen. 

 

1.4.  Digitasi Peta 

1.4.1. Pengertian Digitasi Peta 

Digitasi secara umum dapat didefinisikan sebagai proses konversi data analog ke 

dalam format digital. Objek-objek tertentu seperti jalan, rumah, sawah dan lain-lain yang 

sebelumnya dalam format raster. Pada sebuah citra satelit resolusi tinggi dapat diubah 

kedalam format digital dengan proses digitasi. 

 

1.4.2. Metode Digitasi 

Proses digitasi secara umum dibagi dalam dua macam: 

 

1. Digitasi menggunakan digitizer 

 Dalam provses digitasi ini memerlukan sebuah meja digitasi atau digitizer. 

2. Digitasi onscreen di layar monitor 

Digitasi onscreen paling sering dilakukan karena lebih mudah dilakukan, tidak 

memerlukan tambahan peralatan lainnya, dan lebih mudah untuk dikoreksi apabila 

terjadi kesalahan. 

 

1.4.3. Menambah Data Gambar 

Untuk menambah data gambar ke dalam ArcMap, File > Add Data di toolbar menu. 

Kemudian pilih gambar yang di perlukan. 
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1.4.4. Membuat Layer atau Shapefile 

Langkah – langkah untuk memulai digitasi onscreen adalah sebagai berikut berikut ini : 

1. Identifikasi terlebih dahulu objek-objek yang akan didigitasi. 

2.  Setelah objek teridentifikasi, buatlah shapefile untuk masing-masing kategori objek 

melalui ArcCatalog. Untuk membuka ArcCatalog klik menu ArcCatalog di menu 

toolbar. 

 
 

 

3. Setelah ArcCatalog terbuka, masuklah ke dalam folder dimana shapefile yang akan 

dibuat ingin disimpan. Pada contoh berikut kita akan menyimpan shape file yang 

akan dibuat di folder “data gis” di drive D. 
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4. Klik kanan jendela sebelah kanan ArcCatalog, kemudian akan muncul beberapa 

pilihan, kemudian klik New > pilih Shapefile. 

5. Kemudian akan muncul jendela “Create New Shapefile”. Isikan nama shapefile yang 

akan dibuat di text box Name, dan tentukan jenis feature (Feature Type) di dropdown 

list Feature Type. 
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6. Misalkan Anda akan mendigitasi objek jalan, maka isikan “Jalan” dalam text box 

Name, kemudian pilih Polyline di dropdown list Feature Type sebagai jenis feature-

nya. 

7. Feature Type atau jenis feature merupakan representasi objek-objek dalam dunia 

nyata ke dalam bentuk geometri yang lebih sederhana. Misalnya untuk objek yang 

memanjang seperti jalan, pipa air, telkom, jaringan listrik, dan lain-lain 

direpresentasikan dalam betuk garis (Line/Polyline). Untuk objek-objek yang 

berbentuk luasan seperti sawah, kolam, rumah, batas desa, dan lain-lain 

direpresentasikan dalam bentuk Polygon. Untuk objek-objek yang berbentuk titik-titik 

seperti tower, tiang listrik, sumur bor, dan lain lain dipresentasikan dalam bentuk 

Point. 

 

1.4.5. Menentukan Sistem Koordinat Shapefile 

1. Untuk menentukan sistem koordinat shapefile yang akan dibuat, tekan tombol Edit, 
kemudian akan muncul jendela “Spatial Reference Properties” seperti tampak pada 

gambar di bawah ini : 
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2. Tekan tombol Select, sehingga muncul jendela “Browse for Coordinat System”, 

kemudian pilih pilihan Projected Coordinate Systems seperti gambar berikut. 

Misalkan untuk daerah Aceh Besar kita tentukan sistem koordinatnya adalah UTM 

(Universal Transverse Mercator) zone 46N, dengan datum WGS 1984, maka pilih 

Utm, kemudian pilih Wgs 1984, setelah itu pilih WGS 1984 UTM Zone 46N.prj. 
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3. Apabila shape file telah berhasil dibuat, akan tampak di jendela kanan Arc Catalog. 

 

1.4.6. Digitasi 

1. Setelah shapefile dibuat, selanjutnya siap untuk dilaksanakan proses digitasi. Buka  

kembali ArcMap, kemudian tambahkan shapefile-shapefile yang akan digitasi, 

mengunakan tombol Add Data. 
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2. Untuk memulai digitasi, pilih menu Editor > Start Editing 

 
 
 
3. Kemudian akan muncul jendela seperti gambar di bawah ini. Dalam jendela tersebut 

akan muncul nama-nama layer yang akan diedit yang berada dalam satu folder yang 

sama. Tekanlah tombol Start Editing untuk memulai digitasi. 
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1.4.7. Snapping 

Snapping adalah suatu tool yang sangat berguna untuk mendeteksi titik (Vertex), ujung 

garis (End), atau tepi (Edge) dari vektor shapefile. Tool ini sangat bermanfaat untuk 

menghubungkan atau menghimpitkan antar garis atau titik dalam proses digitasi, 

sehingga bisa mereduksi kesalahan dalam digitasi berupa garis yang tidak bersambung 

atau berhimpit. 

1. Untuk mengaktifkan snapping pilih menu File > View > Toolbar > Editor Snapping. 

Selanjutnya akan muncul jendela “Snapping Environment”. Berilah tanda check 

pada masing-masing layer sesuai pilihan-pilihan snapping yang diinginkan. 
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1.4.8. Memulai Digitasi 

1. Pada Menu utama pilih View > Toolbars > Editor, kemudian pilihlah layer yang akan 

didigitasi di dropdown list Target. Misalnya layer jalan, pada dropdown list Task 
pastikan Anda memilih Create New Feature. Kemudian pilih tombol Sketch Tool, 
seperti pada gambar dibawah ini : 

 
 

 

2. Untuk memulai digitasi arahkan mouse ke objek “jalan” dalam gambar, klik pada 

sebuah titik permulaan, kemudian ikuti sepanjang jalan tersebut dengan mouse, klik 
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pada tiap-tiap belokan atau persimpangan jalan (setiap klik akan menghasilkan 

vertex), sehingga tergambar garis hasil digitasi tersebut. 

Proses Digitasi : 
Digitasi Line 
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Digitasi Polygon 

 
Digitasi Point 

 
 

3. Untuk mendigitasi layer-layer yang lain, ganti nama layer pada menu Target di 

toolbar menu Editor. 
4. Untuk menghentikan digitasi, cukup double click pada titik akhir digitasi. 
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1.4.9. Menyimpan Hasil Digitasi 

Untuk menyimpan hasil digitasi, klik menu Editor > Save Edits. Untuk menghentikan 

digitasi pilih Stop Editing. 

 
1.4.10. Annotasi Sederhana 

Anda akan memberikan annotasi dengan teks untuk memberikan tanda Kecamatan 

Jantho pada image dibawah ini. 

 

1. Sebelumnya buka dulu file AcehBesarKota yang terdapat di 

c:\BasicArcGIS\Data\AcehBesar.mdb\AcehBesarKota 
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2. Setelah itu akan muncul tampilan Aceh Besar Kota. 

3. Cara termudah menggambar obyek di ArcMap adalah menggunakan sistem annotasi 

dan toolbar drawing. Tombol Draw sama seperti yang terdapat di produk Microsoft 

dan memberikan pilihan dalam membuat bentuk, titik, garis dan teks di peta Anda. 

Tombol ini terletak di bawah kiri tampilan ArcGIS. 

 
4. Anda akan berlatih dengan beberapa annotasi di peta, meskipun tidak terdapat layer 

sesungguhnya tetapi hanya bentuk obyek dasar di peta. 

 

a. Dari panel Draw, klik tombol teks. Ketik Kecamatan Jantho pada peta. Anda akan 

berlatih untuk memberikan annotasi pada beberapa nama kota di peta. 

b. Tambahkan layer kota dari c:\BasicArcGIS\Data\Aceh Besar.mdb. Hal ini bisa 

dilakukan dengan mengklik tanda “+” di sebelah atas kiri layar ArcGIS Anda. 

 

 
c. Klik pada Edit > Find untuk mencari kota yang bersangkutan. Tombol ini ada di 

sebelah atas kiri, yaitu pada bagian Edit, lalu klik mouse kemudian pilih tombol 

Find. Lalu ketik Jantho pada bagan Find dengan bagan In diisi dengan pilihan 

pada AcehBesarKota. 
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d. Setelah didapatkan tabel hasil yang terletak di bawah bagan Find, maka Anda 

dapat mengklik pada Jantho yang terdapat di tabel hasil untuk mendapatkan lokasi 

Jantho di lapangan. Amati apa yang terjadi pada tampilan ArcMap pada saat Anda 

mengklik Jantho. 

 
e. Dengan mengetahui letak kota Jantho, Anda dapat memberikan nama pada point 

Jantho tersebut. Berilah annotasi pada Kecamatan Jantho atau beberapa 

kecamatan lainnya dengan menggunakan Callout pada panel Draw 
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f. Untuk memperindah tampilan nama Kecamatan, Anda dapat mengubah beberapa 

teks warna, ukuran maupun stylenya. Caranya : pertama, dengan memilih 

keterangan teks lalu ubahlah warna, style dan atau ukuran teks. Hal ini bisa 

dilakukan dengan bantuan drawing tools yang terdapat di bawah tampilan ArcGIS. 

 

 

 
g. Untuk titik, Anda dapat menandakan Kecamatan Jantho dengan memasukkan 

symbol. Untuk melakukannya, klik tombol Marker dan tambahkan point. Anda 

dapat memilih point yang diinginkan dan merubah warna maupun simbolnya. 

Caranya ialah dengan mengklik kanan pada point yang ada, lalu ubahlah tampilan 

point dengan mengklik Change Symbol. Pada bagan tersebut, Anda dapat 

merubah warna, ukuran maupun bentuk dari point yang ada. 
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h. Apabila Anda merasa perlu bentuk yang lain dari yang telah ada pada bagan 

pilihan bentuk Symbol Selector, Anda dapat mengklik More Symbols dan 

mendapatkan beberapa pilihan selain yang sudah tersaji sebelumnya di Symbol 
Selector. 
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i. Pastikan Anda tidak lupa untuk selalu menyimpan hasil latihan Anda. Simpanlah 

map document latihan ini dengan mengklik Save pada File tools yang terletak di 

pojok kiri atas tampilan ArcGIS. Setelah itu pilih folder penyimpanan di 

c:\BasicArcGIS\Data\filename.mxd 

 

 
 

 

Sebagai catatan, anotasi sederhana yang dilakukan sebelumnya adalah diperuntukkan 

untuk keindahan grafik bukan untuk pembuatan data spatial. Sehingga teks dan 

features (seperti titik dan garis) hanya bagian dari layout bukan informasi spasial. 
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1.4.11. Membuat Layer Point dari Teks File 

1. Buatlah sebuah map dokumen baru menggunakan file template yang sudah dibuat 

sebelumnya. Save As Map dokumen dengan pada direktori C:\ Basic ArcGIS \ 

Latihan \ Latihan10 \ Project10 \lokasi_sekolahdasar 

2. Tambahkan Batas administrasi dari direktori C:\Basic ArcGIS\Data\AcehBesarDesa 

dalam geodatabase. Layer administrasi digunakan untuk memberikan gambaran 

dimana lokasi data point sekolah dasar yang ada di Kabupaten Aceh Besar itu 

berada 

3. Anda dapat juga melihat data point sekolah dasar ini dengan menggunakan 

Program NotePad dengan cara jalankan program NotePad (Start > Program > 

Accessories > Notepad). Klik Open File, pilih tempat file disimpan pada direktori 

C:\ Basic ArcGIS \ Data \ AcehBesarSekolahDasar.csv di dalam Notepad. 

Titik-titik yang ditampilkan diatas adalah titik-titik lokasi sekolah dasar yang terdapat 

di Kabupaten Aceh Besar. Perlu diketahui bahwa titik koordinat setiap lokasi telah 

tercantum dalam tabel. Tanda koma yang digunakan dalam file ini untuk 

menunjukkan nilai data yang pertama dipisahkan dari data kedua (tanda pemisah), 

dan seterusnya atau dikenal dengan istilah format Comma Separated Value (csv). 

4. Tutup program Notepad dan kembali pada ArcMap. Klik tombol tambah data baru 

untuk menambah data baru dari direktori C:\BasicArcGIS\Data\ 

AcehBesarSekolahDasar.csv  sebagai layer baru. 

5. Perhatikanlah jendela TOC akan menampilkan data sources – bukan pada Tab 

Display. Klik pada Tab Display dan perhatikanlah, file yang mempunyai ekstensi 

.csv tidak terlihat sebagai layer karena tidak memuat feature grafik. 

 
6. Klik pada Tab Source pada Layar Table Of Contents 
7. Buatlah kelas feature point pada layer tersebut. Klik kanan pada data_ 

AcehBesarSekolahDasar.csv dan pilih DISPLAY XY data. 
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8. Untuk field X pilih X_COORD dan Field Y pilih Y_COORD. 

 
9. Selanjutnya Klik pada tombol Edit untuk melakukan seting sistem koordinat. 

Kemudian klik pada tombol Select, maka akan muncul kotak dialog Browse for 
Coordinate System. Pilih folder Projected Coordinate Systems > Utm > Wgs 
1984 > WGS 1984 UTM Zone 46N.prj, kemudian klik tombol Add 

10. Klik OK pada kotak dialog Spatial Reference Properties, kemudian klik OK pada 

kotak dialog Display XY Data maka feature point sekolah dasar di kabupaten Aceh 

Besar akan terbentuk. 

� Catatan : Layer sudah dibuat sebelumnya dalam TOC dengan nama data_ 
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AcehBesarSekolahDasar.csv. Layer ini adalah layer event. Klik Tab Display pada 

jendela TOC untuk melihat lebih jelas, pada layer tertulis 

AcehBesarSekolahDasar.csv Events 
11. Ganti nama layer event AcehBesarSekolahDasar.csv Events menjadi 

SD_AcehBesar 

12. Selanjutnya Anda akan mengeksport event layer tersebut menjadi shapefile. Klik 

kanan pada layer SD_AcehBesar pada jendela TOC dan pilih Data > Export Data 

pada pop-up menu. 

 
 

 

13. Pada export data dialog atur directory dan nama file untuk file baru 

menjadi:C:\BasicArcGIS\Latihan\Latihan10\Hasil10\SD-AcehBesar.shp 

 
14. Simpan Dokumen Peta hasil kerja Anda. 
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1.4.12. Membuat Link ke Database Acces 

Anda sudah mempelajari tentang bagaimana cara menambahkan layer (yang memuat 

feature geografis) dari sebuah personal geodatabase. Anda dapat mengambil data dari 

Access dalam format teks. Proses ini sederhana – sama dengan bekerja dengan file 

CSV – tetapi lebih sempurna jika data telah berada dalam format database. Salah satu 

cara adalah membuat link ke Acces database. Ada dua pilihan – membangun link ke 

database atau melakukan import ke dalam bentuk shape file. Catatan bahwa Anda 

dapat mengimport data dari format file csv atau non-database yang lain (seperti excel 

spresdsheet) ke dalam Access. Hal ini akan memungkinkan Anda untuk melakukan 

pengecekan integritas data sebelum data tersebut diimport ke dalam Sistem Informasi 

Geografis. 

 

1. Pertama, Anda akan melihat pada Database Access. Dengan menggunakan 

Windows Explorer atau My Computer, pilih lokasi folder latihan C:\Basic 

ArcGIS\Latihan\Latihan10\Project10 \data dan Double click pada file 

Acces_data.mdb 

 

 
2. Pada database Acces dialog, double-click pada Access_data table untuk 

membukanya. Silahkan dilihat pada data dalam tabel contains untuk menentukan 

data apa yang akan diimport ke ArcGIS. 

3. Tutup terlebih dahulu Access sebelum Anda menggunakan file Access tadi ke 

dalam ArcMap. 
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4. Dalam ArcMap gunakan tombol Add  data untuk memanggil data table 

access_data di Latihan\data\AcehBesarKecmtn.mdb sebagai layer. 

5. Sekarang Anda akan membuat kelas feature point map layer. Klik kanan pada 

access_data dan pilih Display XY data. 

 
6. Untuk Field X pilih X_COORD dan Field Y pilih Y_COORD 

7. Sekarang Klik pada button Edit untuk menentukan sistem koordinat. Tabel tersebut 

memuat nilai koordinat, namun perlu diberitahu ArcMap bagaimana 

menginterpretasinya. Klik pada button select dan pilih sistem koordinat berikut. 

 
WGS 1984 Geographic (pada Predefined > Geographic > World > WGS 1984 
Geographic) 
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8. Klik OK pada dialog dan feature point akan terbangun. Catatan bahwa layer baru 

telah dipanggil dalam TOC dengan nama AcehbesarKec events. Layer ini adalah 

Events layer . Klik pada Tab Display pada TOC untuk melihat lebih jelas. 

9. Ganti nama events layer baru tersebut menjadi data_access_point.  Sementara 

data belum diexport menjadi shapefile, kini Anda sudah membuat link antara 

database Access dengan feature point dan dapat dilihat pada Arcmap. 

10. Klik pada Windows Start menu dan pilih Documents > access_data.mdb (cara ini 

hanya sebagai jalan pintas untuk membuka dokumen/file yang pernah digunakan). 

11. Dalam Database dialog pada Access, double-click pada Tabel acces_data untuk 

membukanya. 

 

 



55 
 

12. Kini Klik pada button Add New Record pada bagian bawah table 

 
13. Masukkan data berikut dalam new record (Anda hanya memasukkan empat field 

data) 

ID : 23 

NAMA_KEC : <null> 

Murid_P_SD : 300 

Murid_L_SD : 465 

X_koordinat : 95.31878 

Y_koordinat : 5.5289 

 
Catatan: perhatikan agar koordinat dimasukkan dengan benar! 

14. Tutup Access (Anda tidak perlu menyimpan apapun – Access akan melakukan 

secara otomatis). 

15. Dalam ArcMap klik kanan pada layer AcehbesarKec Events lalu pilih Open Attribute 

Table. Pada Tabel Atribut, pilih tombol Move to End Records. 

 
16. Silakan lihat pada record terakhir, informasi yang baru ini sama dengan informasi 

yang dimasukkan melalui Access (pembaharuan data melalui Ms Access) 
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Penggunaan event theme juga akan memungkinkan pembuatan point dalam table 

Access database dan kemudian dikerjakan dalam Arcmap. Untuk lokasi baru yang 

koordinatnya dimasukkan dalam Access, ArcMap akan otomatis menghasilkan 

point untuk lokasi tersebut. Sekarang coba perhatikan ada dimana point tersebut. 

17. Klik pada Edit menu dan pilih Find. Pada Find dialog masukkan ID 22 dan pilih 

layer access_data untuk mencarinya : 

 
18. Klik pada Find. Satu record akan muncul. Right-click pada record dan pilih Zoom to 

Feature dan kemudian Flash feature untuk menentukan lokasi new point yang 

sudah dibuat untuk lokasi tersebut. 

 
 

19. Tutup Find dialog dan simpan Map Document. 
 

1.4.13. Import Data MapInfo 

Data yang dieksport dari MapInfo (MID/MIF) datafile memuat semua lokasi point untuk 

seluruh kabupaten. Catatan bahwa format data yang digunakan oleh mapinfo adalah 
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sebuah table (.tab). Format MID/MIF digunakan untuk mengeksport data – dan format 

tersebut akan digunakan atau dibutuhkan jika data mapinfo akan digunakan.  

Anda akan menggunakan ArcCatalog untuk mengimport data ini menjadi shapefile. 

 

1. Start ArcCatalog 

2. Klik View > Toolbars > ArcView 9.x Tools untuk membuka toolbar konversi 

3. Klik pada Conversion Tools > MIF to Shapefile tool. 

 
 

4. Pada MIF to Shapefile dialog pilih file MIF : 

C:BasicArcGIS\data\AcehbesarRoad.mif 
5. Set output shapefile menjadi \BasicArcGIS\Data\AcehbesarRoads.shp 
6. Perhatikan pada kotak dialog, harus muncul seperti berikut: dan Klik OK 

 
Pertanyaan 1 : Sistem koordinat apa (referensi) dari file yang Anda baru saja buat? 

(Gunakan Tab metadata untuk melakukan pengecekan hal tersebut) 

Shapefile baru sudah dibuat, dalam MapInfo sistem koordinat disimpan dalam data. 

Jika shapefile tersebut tidak memiliki informasi ini, maka Anda harus menambahkan 
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atau membuat sistem proyeksi (.prj) file sehingga ArcMap mengetahui informasi sistem 

koordinat tersebut. 

7. Gunakan ArcCatalog untuk melakukan langkah berikut : 

 

a. Dalam Catalog, klik kanan pada nama file (MapInfo.shp) dan pilih Properties. 

b. Klik pada Fields tab dan pilih field name Shape. 

 
c. Properties untuk field ini akan ditampilkan pada bagian bawah dialog. Catatan 

bahwa Spatial Reference property yang terbaca adalah 

GCS_Assumed_Geographic. Klik pada tombol titik-titik untuk selanjutnya 

melakukan setting sistem koordinat. 

d. Kini Anda akan terbiasa dengan dialog box berikut. Tentukan sistem koordinat 

menjadi WGS 1984 (under Projected > Geographics > World WGS 1984). 

 

8. Sekarang klik pada menu View dalam ArcCatalog dan pilih Refresh. Sebuah 

judul/heading untuk Informasi Sistem Referensi akan terlihat untuk file tersebut. Klik 

pada Link untuk melakukan pengecekan bahwa sistem koordinat telah tersimpan 

secara benar. 

9. Kini Klik dan geser file dari Arc Catalog ke TOC dalam ArcMap. 

10. Ubah tampilan untuk layer ini, untuk menampilkan kategori menggunakan unique 

values pada field Unit. Anda dapat membuka table attribute dulu untuk mengetahui 

data apa saja yang disimpan dalam layer ini. 
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11. Gerakkan Layer AcehbesarKec sehingga berada di bawah AcehbesarJalan dalam 

TOC. Ubah tampilan dengan merubah style layer AcehbesarKec sehingga warna 

kec_boundary menjadi hollowatau kosong. TOC Anda akan menjadi seperti berikut 

ini : 

 
12. Simpan map document Anda. 

 

1.4.14. Labeling Lanjutan 

Kadang Anda ingin menggunakan label untuk menyampaikan informasi dibandingkan 

dengan yang terdapat dalam single field. Anda dapat menampilkan teks dari banyak 

field – tetapi akan lebih sulit untuk dibaca. Alternatif lain adalah dengan mengubah jenis 

tampilan label berdasarkan nilai pada field kedua. 

 

1. Buka tabel atribut untuk layer Acehbesarsekolah. Perhatikan bahwa ada field yang 

berjudul Murid_P_SD (yang baru saja digunakan untuk membuat label) dan field 

yang memberikan nama tiap site yang dinamakan Nama_Kec Label yang dihasilkan 

dengan menggunakan “Murid_P_SD” akan memberikan informasi tentang berapa 

jumlah murid Sekolah Dasar yang perempuan-tetapi Anda tidak dapat 

mengidentifikasi kecamatan satu per satu kecuali dengan melihat pada field site. 

2. Sekarang Anda akan mendefinisikan kelas-kelas yang akan menentukan bagaimana 

label akan ditampilkan. Anda akan menampilkan label nama site dengan 

menggunakan warna teks yang berbeda tergantung pada Murid_P_SD. 

 

1. Buka kotak dialog Layer Properties untuk layer AcehbesarKec Events dan klik 

pada Label. 
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2. Pada Method pilih Define classes of features and label each class differently 

 
3. Kotak dialog akan muncul dan menunjukkan berbagai pilihan. Non aktifkan  

pemberian label untuk bentukan di kelas Default. 

 
4. Ini akan mencegah label lain tampil kecuali label-label yang mewakili kelas yang 

Anda definisikan. Sekarang Anda akan mendefinisikan kelas pertama Anda. Klik 

Add dan masukan nama sedikit untuk kelas pertama, lalu klik Ok. 

 
5. Klik SQL Query untuk mendefinisikan record mana yang akan masuk pada kelas 

ini. Klik pada field Murid_P_SD, lalu tanda “<=” dan nilai “200” untuk membuat 

query. Seluruh query akan berbunyi : ……………………. 

 
 

6. Periksa dialog yang ditampilkan dan klik Ok. 
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7. Klik Apply pada kotak dialog Layer Properties. 

8. Hanya daerah yang mempunyai kriteria mempunyai Siswa SD perempuan yang 

berjumlah di bawah 200 yang terlabel. Tetapi, ini tidak terlalu berguna karena field 

label hanya menunjukkan kepada Anda nama Kecamatan, pada kotak dialog 

Layer Properties ubahlah Label Field menjadi Site, lalu klik Apply. 

9. Nama-nama site akan tampil. Sekarang, ubah label teks untuk menampilkan teks 

dengan warna merah, lalu klik Apply. 

 
10. Sekarang Anda akan membuat kelas kedua. Pada kotak dialog Layer 

Properties klik Add dan masukkan nama Sedang untuk kelas 

200<Murid_P_SD>400 dan klik Ok. 

 
11. Klik pada SQL Query untuk mendefinisikan record mana yang masuk pada kelas 

ini. 
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12. Klik Ok 

13. Sekarang atur warna untuk label pada kelas ini dan ubah label teks yang akan 

tampil menjadi biru. 

14. Klik Apply pada kotak dialog Layer Properties 

 
15. Kecamatan yang diberi label adalah kecamatan yang memenuhi SQL Query tadi, 

tetapi dengan warna yang berbeda. 

16. Simpan dokumen peta. 

 

1.4.15. Pengaturan Advance Simbol Layer untuk Titik 

Sekarang Anda akan melihat beberapa simbol yang lebih advance untuk layer 

AcehbesarKec. 

 

1. Non aktifkan layer lain selain layer AcehbesarKec pada TOC 
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2. Ubah tampilan layer AcehbesarKec untuk menunjukkan tampilan kategori dengan 

menggunakan Unique Values pada field Pertmbhn 

 

 
3. Perhatikan efek menampilkan data pertumbuhan penduduk dengan menggunakan 

tampilan kategori. Site akan ditampilkan dengan warna berbeda – tetapi karena 

simbol tersebut kecil, maka sulit menentukan setiap warna yang mewakili setiap 

site. Anda dapat memperbaikinya dengan menggunakan simbol berbeda pada 

layer. 
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4. Buka kotak dialog Layer Properties untuk layer Acehbesarsekolah dan klik pada 

tab Symbology. 

5. Klik dua kali pada symbol yang sebenarnya untuk membuka jendela “symbol 
selector”. 

6. Klik pada More Symbols dan pilih Civic. Langkah ini akan menampilkan simbol 

yang berhubungan dengan kependudukan pada Symbol Selector 
7. Simbol kependudukan akan tampil di bawah symbol yang lain. Scroll down dan pilih 

simbol yang sesuai. 

 
8. Ubah ukuran tulisan menjadi 24 agar simbol dapat lebih mudah terlihat. 

9. Klik pada Properties, lalu klik tab Mask. Tambahkan halo 1 poin di sekitar simbol. 
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10. Klik Ok pada kotak dialog Layer Properties. Perhatikan perubahan pada peta 

(mungkin Anda perlu menggerakkan peta untuk melihat site yang berubah) 

 
11. Sekarang rapihkan TOC agar dapat terbaca dengan baik. Buka kotak dialog Layer 

Properties untuk layer Acehbesarsekolah dan klik pada tab Symbology. 

12. Pilih Quantities dan Graduated colors. Setelah itu pilih Field Value-nya 

Murid_P_SD dengan 5 kelas klasifikasi. 
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13. Klik ganda pada label symbol sehingga dapat memilih ukuran, bentuk serta warna 

dari symbol yang diinginkan. 

 
14. Untuk simbolnya, Anda dapat mengklik ganda, dan aktifkan Public Sign. Carilah 

symbol Women serta bedakan tiap kelas dengan warna yang terdegradasi. Selain 

itu juga, Anda dapat merubah label dari setiap kelas dengan nilai Sangat Sedikit, 

Sedikit, Sedang, Banyak dan Sangat Banyak. 
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15. Simpan dokumen peta. 

 

Latihan : 

Pertanyaan 1 : Apa sistem koordinat (referensi) file yang baru saja Anda buat? 

(gunakan tab metadata untuk memeriksanya) 
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Jawaban : File tersebut belum mempunyai sistem koordinat. Sistem koordinat awal 

yang tercantum adalah default dari ArcMap yaitu GCS Assumed Geographic. Koordinat 

sebenarnya adalah GCS WGS 1984 

 

Pertanyaan 2 : Apa perbedaan antara pengaturan kisaran skala dengan menggunakan 

tombol ini dan pengaturan kisaran skala dengan tab General pada kotak dialog Layer 
Properties? 

 

Jawaban : Pengaturan kisaran skala untuk label hanya akan mengendalikan tampilan 

label teks – bukan bentukan sebenarnya. Pengaturan kisaran skala dengan tab 

General akan mengendalikan tampilan seluruh layer (bentukan dan label teks). 

Anda sudah Selesai? 
 
Coba langkah tambahan ini: 

 

1. Buat kelas label untuk layer AcehbesarTsunami dan AcehbesarVegetasi yang 

terdapat pada geodatabase Aceh Besar 

2. Ubah tampilan layer untuk menunjukkan kategori dengan unique values pada field 

type. 

3. Atur transparansi untuk layer ini sampai 40% agar layer Acehbesartsunami dapat 

dilihat di balik layer AcehbesarVegetasi 

4. Ubah tampilan pada beberapa tipe tingkat kerusakan tsunami yang berbeda dengan 

mengklik simbol pada kotak dialog Layer Properties. 
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e. Anda mungkin ingin membuat beberapa layer lainnya (contohnya layer sungai, 

layer jalan maupun layer gunung berapi) menjadi lebih terang warnanya, atau 

menampilkan batas administrasi menggunakan tipe garis yang tebal. Untuk 

mengubah jenis fill, klik Properties pada Symbol Selector. 
6. Simpan dokuman peta. 
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BAB II : DATA SISTEM INFORMASI GEOGRAFIS 
 

Data pada sistem informasi geografis dapat dikemas menjadi geodatabase.  

Pengertian dari geodatabase dan cara pembentukan adalah sebagaimana telah 

diuraikan dalam modul MCRMP yang akan dikutip berikut ini.  Contoh yang 

digunakan adalah untuk kegiatan pengelolaan pesisir, namun tidak akan berbeda 

bila akan digunakan pada berbagai kegiatan pengelolaan sumberdaya 

hutan/kehutanan. 

 
 
2.1.  DESKRIPSI TEKNIS 
 
2.1.1.  PENGERTIAN TEMPLATE GEODATABASE MCRMP 
 
Template Geodatabase MCRMP merupakan sebuah geodatabase yang di rancang 

(disain) dalam ruang lingkup ArcGIS dengan menggunakan aplikasi ArcCatalog dan 

memiliki fungsi sebagai default database untuk standarisasi basis data pada Marine 

& Coastal Resources Management Project . Pengertian dari geodatabase itu sendiri 

adalah sekumpulan data spatial yang membentuk sebuah sistem pada suatu 

platform tertentu. Geodatabase merupakan komponen yang penting dalam bidang 

pengembangan Sistem Informasi Geografis (SIG). Konvensi penamaan dari 

template geodatabase MCRMP adalah sebagai berikut MarineYYMMDD.mdb, 

dimana YY menunjukkan tahun, MM menunjukkan bulan, dan DD menunjukkan hari. 

Hal tersebut dimaksudkan untuk menunjukkan tanggal dari pembuatan template 

database sehingga jika terdapat perubahan pada template geodatabase dapat 

diketahui versi berdasarkan tanggal dari pembuatan template geodatabase tersebut.  

Berdasarkan ruang lingkup ArcGIS terdapat beberapa bagian yang terdapat dalam 

template geodatabase MCRMP , yaitu : 

 
2.1.1.1. TEMA (  ArcGIS : Feature Dataset ) 

Tema adalah sekumpulan fitur dengan karakter atau fungsi yang sama. 

Pengelompokan tidak tergantung dari tipe data dari fitur dan field atribut. Tema 

menggabungkan fitur-fitur yang secara logis masuk dalam satu kelompok, misalnya 

bandara, pelabuhan, jalan dan jalan ka dikelompokkan dalam transportasi. Dalam 

ArcGIS Tema disebut dengan istilah Feature Dataset . Fitur dikelompokkan dalam 
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Tema. Masing masing tema bisa berisi satu atau lebih fitur dari tipe fitur yang 

berbeda. Kode tema disusun berdasarkan kata dalam Bahasa Indonesia dan 

Bahasa Inggris terdiri dari 6 karakter huruf besar.   

Tema yang terdapat pada template geodatabase MCRMP : 

 

Tema Deskripsi 

BATASB Daerah administrasi 

CONFLI Penggunaan konflik 

FUNGSI Penggunaan lahan 

GEOLGY Geologi  

HAZARD Daerah berbahaya 

INFRAS Infrastruktur 

LANSTA Status lahan 

LSUITB Kesesuaian lahan 

LUSLST  

NAVIGA Navigasi 

OSEANO Oceanografi 

PANTAI Objek pantai 

PENUTU Penutupan lahan 

PERAIR Sungai dan perairan lain 

RENCAN Perencanaan wilayah 

TOPOGR Topografi dan batimetri 

TRANSP Transportasi 

Tabel 1.1  Tabel Tema 

 

2.1.1.2.  FITUR / UNSUR ( ArcGIS : Feature Class ) 

Fitur (unsur) adalah obyek aktual yang ada di dalam basisdata spasial dan diwakili 

oleh tipe data yang sama (titik, garis dan area), misalnya sungai kecil diwakili oleh 

sumbu sungai (fitur garis), bangunan kecil (fitur titik), tutupan lahan (fitur area) atau 

sungai lebar diwakili oleh kedua tepinya (fitur area). Masing-masing fitur dapat 

memiliki satu atau lebih atribut yang ditempelkan pada fitur tersebut. Atribut yang 

dipakai untuk klasifikasi fitur pada peta RBI dan LPI mengacu pada atribut RBI/LPI 
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atau sebagai sub- fitur (sub-unsur) dalam sistem pengkodean RBI. Dengan demikian 

fitur harus memenuhi persyaratan sebagai berikut : 

 

• Tipe data yang sama, misalnya titik, garis atau area 

• Karakter utama yang sama, misalnya semua tipe jalan, air, tutupan lahan 

• Field atribut yang sama. 

Kode fitur disusun berdasarkan kata dalam Bahasa Inggris terdiri dari dari 6 karakter 

huruf besar. Huruf terakhir dari kode menunjukkan tipe dari fitur tersebut, A ( tipe 

area ), L ( tipe garis ) dan P ( tipe titik ). 

Fitur – fitur yang terdapat pada template geodatabase MCRMP  : 

Fitur / Unsur Deskripsi 

BDSTRA Kabupaten ( Area ) 

BDSTRL Batas kabupaten ( Line ) 

BNATIA Negara ( Area ) 

BNATIL Batas negara ( Line ) 

BPROVA Propinsi ( Area ) 

BPROVL Batas propinsi ( Line ) 

BSDSTA Kecamatan ( Area ) 

BSDSTL Batas kecamatan ( Line ) 

CONFLA Konflik ( Area ) 

CONFLP Konflik ( Point ) 

BUILDA Gedung ( Area ) 

BUILDP Gedung ( Point ) 

CEMETA Makam ( Area ) 

CEMETP Makam ( Point ) 

CSAREA Daerah konservasi atau proteksi ( Area ) 

FISHCA Perikanan komersial ( Area ) 

FISHTA Perikanan tradisional ( Area ) 

INDUSA Daerah industri ( Area ) 

LANDUA Tata guna lahan ( Area ) 

LEISUA Pariwisata ( Area ) 

LEISUP Pariwisata ( Point ) 

MININA Daerah pertambangan, gas, minyak ( Area ) 
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MININP Pertambangan ( Point ) 

URBANA Daerah pemukiman ( Area ) 

GEOLOA Formasi geologi ( Area ) 

GEOMOA Klas geomorfologi 

APRSKA Bahaya pengotoran udara ( Area ) 

EARTQA Bahaya gempa bumi ( Area ) 

ERISKA Bahaya erosi ( Area ) 

EROSIA Erosi ( Area ) 

ERUPTA Bahaya letusan gunung api ( Area ) 

FFRSKA Bahaya kebakaran hutan ( Area ) 

FLOODA Bahaya banjir ( Area ) 

IRISKA Bahaya perindustrian dan energi ( Area ) 

LSLIDA Bahaya tanah longsor ( Area ) 

POLLUA Pengotoran ( Area ) 

PRISKA Bahaya pengotoran darat ( Area ) 

STORMA Bahaya siklon / taifun ( Area ) 

TDRSKA Bahaya limbah toksik ( Area ) 

TOXDUA Limbah toksik ( Area ) 

TSUNMA Bahaya tsunami ( Area ) 

CBLCOL Jaringan telpon ( Line ) 

CBLPWL Kabel listrik ( Line ) 

INFRAP Menara air minum ( Point ) 

PIPELL Jaringan pipa ( Line ) 

POWERA Pusat listrik ( Area ) 

POWERP Pusat listrik ( Area ) 

TANKSA Tangki ( Area ) 

TANKSP Tangki ( Point ) 

TOWERP Menara transmisi ( Point ) 

LANSTA Kepemilikan lahan ( Area ) 

LUNISA Satuan pesisir dan laut ( Area ) 

LUNITA  Satuan lahan ( Area ) 

EASMNA Jalur penyangga ( Area ) 
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AIDNAP Bantuan navigasi ( Point ) 

BUOYNP Pelampung ( Point ) 

COSAMA Bangunan pantai ( Area ) 

NAVIGA Zona navigasi ( Area ) 

SPAREA Daerah laut istimewa ( Area ) 

WRECKP Rongsokan ( Point ) 

CURENP Arus ( Point ) 

OSEANP Karakteristik oseanografi ( Point ) 

SEABEA Morfologi laut ( Area ) 

WAVESP Gelombang ( Point ) 

WTRANP Tembus ( Point ) 

COASTL Jenis garis pantai ( Line ) 

COASTP Bangunan pemancingan ( Point ) 

LAMACA Penutupan lahan dan pesisir ( Area ) 

DRAINA Drainase permukaan ( Area ) 

DRAINL Sistem drainase ( Line ) 

HYDROA Perairan ( Area ) 

HYDROL Perairan ( Line ) 

HYDROP Perairan ( Point ) 

LAZOCA RTRWP ( Area ) 

SLOPEA Lereng lahan ( Area ) 

TOPOGL Garis kontur ( Line ) 

TOPOGP Titik tinggi ( Point ) 

AIRPOA Bandara udara ( Area ) 

AIRPOP Bandara udara ( Point ) 

HARBOA Pelabuhan ( Area ) 

HARBOP Pelabuhan ( Point ) 

RAILWA Stasiun kereta api ( Area ) 

RAILWL Jalan kereta api ( Line ) 

RAILWP Stasiun kereta api ( Point ) 

ROADWL Jalan ( Line ) 

ROADWP Unsur jalan ( Point ) 
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Tabel 1.2  Tabel Unsur ( Fitur ) 
 

2.1.1.3.   TABEL TEKSTUAL ( ArcGIS : Table ) 

Tabel tekstual adalah tabel yang dapat dihubungkan dengan tabel spasial dan 

berisi informasi tambahan mengenai fitur grafis, sering mengacu pada tema tertentu. 

Hubungan direalisir dengan identifier yang unik dari tabel textual pada atribut yang 

bersangkutan dalam tabel spasial. Nilai atribut pada tabel ini ditambahkan dan/atau 

diubah oleh user. 

 

2.1.1.4.  RELASI ( ArcGIS : Relationship Class ) 

Relasi adalah hubungan keterkaitan antara satu fitur dengan fitur yang lain, fitur 

dengan tabel, atau tabel dengan tabel yang lainnya.  

 

2.1.1.5.  TABEL LOOKUP ( ArcGIS : Domain ) 

Tabel Lookup ( Domain ) adalah tabel yang berfungsi sebagai acuan dari nilai 

suatu data / atribut dan akan mengembalikan nilai kepada data / atribut tersebut.  

 

2.2.  TAHAPAN PROSES PADA TEMPLATE GEODATABASE MCRMP 

Terdapat beberapa tahapan proses yang dilakukan pada template geodatabase 

MCRMP, yaitu : 

 

1. Tahap pembuatan template geodatabase MCRMP. 
2. Tahap persiapan sebelum melakukan proses Load Objects. 
3. Tahap proses Load Objects. 
 

Tahap pembuatan template geodatabase MCRMP merupakan tahap awal yang 

telah dilakukan, hasil dari tahap ini ( MarineYYMMDD.mdb ) berfungsi sebagai 

kerangka dasar untuk data spatial pada Marine & Coastal Resources Management 

Project. Selanjutnya adalah tahap persiapan dan tahap proses Load Objects yang 

merupakan tahap akhir Marine & Coastal Resources Management Project yang 

memiliki tujuan standarisasi basis data spatial. Berikut ini akan diuraikan mengenai 

tahapan proses pada template geodatabase MCRMP. 
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2.2.1.  TAHAP PEMBUATAN TEMPLATE GEODATABASE MCRMP 

Tahap pembuatan template geodatabase MCRMP dilakukan dalam ruang lingkup 

ArcGIS dengan menggunakan aplikasi ArcCatalog. Proses pembuatannya 

berdasarkan kepada Data Dictionary for Baseline and Thematic Spatial Databases. 

Hasil dari tahap inilah (MarineYYMMDD.mdb) yang akan digunakan sebagai 

kerangka dasar untuk data spatial dari berbagai daerah pada Marine & Coastal 

Resources Management Project.  

 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

 
Gambar 2.1  Tahap Pembuatan Template Geodatabase MCRMP 

 

Pada gambar 2.1 telah ditunjukkan mengenai proses pembuatan template 

geodatabase MCRMP, yaitu : 

 

1. Pembuatan sebuah geodatabase baru ( kosong ) dalam ruang lingkup ArcGIS 
dengan menggunakan aplikasi ArcCatalog. 

2. Pembuatan Feature Dataset dan penentuan sistem koordinat pada Feature 
Dataset ( GCS_WGS_84 , XYDomain MinX = 80 MaxX = 155 MinY = -23 MaxY = 
20 ). 

3. Setelah Feature Dataset terbentuk kemudian dilanjutkan dengan pembuatan 
Feature Class pada setiap Feature Dataset sesuai dengan pengelompokkan yang 
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Baru
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telah ditentukan pada guidelines ( Data Dictionary MCRMP ). Selain itu, pada 
Feature Class ditentukan aturan validasi untuk setiap atribut yang terdapat pada 
Feature Class. 

4.  Selanjutnya adalah pembuatan tabel tekstual. Pada tabel tekstual juga ditentukan 
aturan validasi untuk setiap atributnya. 

5. Pembuatan domain atau disebut juga tabel lookup, merupakan salah satu dari 
prosedur aturan validasi atribut data pada template geodatabase MCRMP. 

6. Pembuatan Relationship Class pada Feature Dataset, hal ini menunjukkan bahwa 
terdapat suatu relasi dari Feature Class pada Feature Dataset tersebut dengan 
suatu tabel tekstual. 

7. Pembuatan Relationship Class pada geodatabase yang tidak termasuk bagian 
dari suatu Feature Dataset, hal ini menunjukkan bahwa terdapat relasi dari suatu 
tabel tekstual ke tabel tekstual yang lainnya. 

8. Hasil akhir dari tahap pembuatan template geodatabase yaitu 
MarineYYMMDD.mdb . 

 

2.2.2.  TAHAP PERSIAPAN SEBELUM MELAKUKAN PROSES LOAD OBJECTS 

Tahap ini merupakan kelanjutan dari proses sebelumnya, pada tahap ini dilakukan 

beberapa proses sebagai persiapan untuk melakukan proses selanjutnya. Proses 

yang dilakukan pada tahap ini ditujukan pada Sumber Data Spatial dan Sumber 

Data Tekstual. 

 
 
 
 
 
 
 
 
 
 
 
 

Gambar 2.2 Tahap Persiapan Pada Sumber Data 

Pada Gambar 2.2 telah ditunjukkan tahap persiapan dari sumber data sebelum 

dilakukan proses Load Objects dari sumber data ke template geodatabase MCRMP, 

yaitu sebagai berikut : 

 

1. Proses validasi topologi dari sumber data spatial. 

Sumber Data 
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Reference 
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4 5

Pemeriksaan struktur atribut 

data berdasarkan guidelines

6 Sumber Data Tekstual 

setelah melalui tahap 
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2. Sumber Data Spatial, yang akan melalui beberapa proses sebelum dilakukan 
proses Load Objects. Sumber Data Spatial terdiri dari beberapa tipe Sumber 
Data yaitu, Shapefile, ArcInfo Coverage, MapInfo file, Autocad file.  

3. Sumber Data Tekstual, merupakan sumber data yang berupa tabel tekstual. 
4. Penentuan Spatial Reference ( Sistem Koordinat ) pada Sumber Data Spatial, 

jika hal ini tidak dilakukan maka ArcGIS akan memberikan Sistem Koordinat 
secara otomatis yaitu GCS_Assumed_Geographic_1. 

5. Pemeriksaan struktur atribut data pada Sumber Data Spatial dan Sumber Data 
Tekstual 

6. Sumber Data Spatial yang telah melalui tahapan proses persiapan. 
7. Sumber Data Tekstual yang telah melalui tahapan proses persiapan. 
 

Sebelum melakukan proses Load Objects ada beberapa hal yang harus dipenuhi 

dari struktur data pada Sumber Data Spatial & Sumber Data Tekstual, yaitu sebagai 

berikut: 

 

1. Struktur data pada Sumber Data Spatial & Tekstual diharapkan sudah sesuai 
dengan yang telah ditentukan pada guidelines data dictionary MCRMP . 

2. Untuk lebih jelasnya, berikut ini akan diuraikan mengenai beberapa kondisi dari 
struktur data yang telah ditentukan pada guidelines data dictionary MCRMP. 
 
- Disarankan konvensi penamaan pada Sumber Data Spatial & Tekstual 

disesuaikan dengan yang telah ditentukan pada guidelines data dictionary 
MCRMP karena akan mempermudah identifikasi atribut pada proses Load 
Objects. 

- Tipe data dari atribut pada Sumber Data Spatial & Tekstual disesuaikan 
dengan yang telah ditentukan pada guidelines data dictionary MCRMP. 

- Nilai atribut pada Sumber Data Spatial & Tekstual sesuai dengan yang telah 
ditentukan pada guidelines data dictionary MCRMP, jika terdapat atau 
dibutuhkan nilai atribut baru maka ajukan nilai atribut baru tersebut kepada 
MCRMP – B. 

 

2.2.3.  TAHAP PROSES LOAD OBJECTS 

Pada tahap ini dilakukan proses migrasi nilai atribut dari Sumber Data ke Template 

Geodatabase dengan menggunakan fasilitas Load Objects pada aplikasi ArcMap. 

Tahap Proses Load Objects merupakan tahap akhir dari keseluruhan tahapan 

proses pada Template Geodatabase MCRMP. 
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Gambar 2.3  Tahap Proses Load Objects 

 

Pada Gambar 2.3 ditunjukkan tahapan proses Load Objects sebagai kelanjutan dari 

tahapan proses sebelumnya. Berikut ini uraian mengenai tahapan proses Load 

Objects: 

 

1. MarineYYMMDD.mdb, hasil dari tahap pembuatan template geodatabase. 
2. Sumber Data Spatial dan Sumber Data Tekstual yang telah melalui tahapan 

proses persiapan. 
3. Proses Load Objects, merupakan proses migrasi nilai atribut data dari Sumber 

Data Spatial ke Feature Class pada template geodatabase dan proses migrasi 
nilai atribut data dari Sumber Data Tekstual ke Tabel Tekstual pada template 
geodatabase. 
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4. Feature Class atau Tabel Tekstual pada template geodatabase yang telah 
ditambahkan data dari Sumber Data. 

5. Prosedur validasi atribut data pada template geodatabase. 
6. Hasil akhir dari proses Load Objects, yaitu MarineYYMMDD.mdb yang telah 

melalui prosedur validasi dan telah berisi data yang berasal dari Sumber Data. 
 

Pada bagian selanjutnya akan dijelaskan mengenai langkah – langkah proses Load 

Objects dan prosedur – prosedur yang harus dilakukan sebelum dan sesudah 

proses Load Objects. 

 
2.3.  PROSES LOAD OBJECTS & PROSEDUR YANG MENYERTAINYA 

2.3.1.  PROSEDUR PENENTUAN SPATIAL REFERENCE SUMBER DATA 
SPATIAL 

 
Sebelum proses Load Objects dilakukan, sumber data yang akan diload harus telah 

ditentukan spatial reference-nya. Apabila sumber data belum memiliki spatial 

reference (sistem koordinat) maka ArcGIS akan memberikan default spatial 

reference yaitu GCS_Assumed_Geographic_1 dan harus ditentukan lagi spatial 

reference-nya. Berikut ini adalah langkah – langkah dalam menentukan spatial 

reference dari sumber data. 

 

2.3.1.1.  MENENTUKAN SPATIAL REFERENCE PADA SUMBER DATA BERTIPE 
SHAPEFILE 

 

Langkah – langkah untuk menentukan spatial reference pada sumber data bertipe 

shapefile sebagai berikut : 

 

1. Jalankan aplikasi ArcToolbox. 
 



81 
 

 
 

2. Pilih Data Management Tools > Projections > Define Projection Wizard ( 
shapefiles, geodatabase ) pada listbox. 

 
3. Double klik menu yang telah dipilih. 
4. Akan ditampilkan form Define Projection Wizard 
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5. Tambahkan data dengan menekan tombol Add Data  . 
6. Pilih sumber data shapefile yang akan ditentukan sistem koordinatnya. 

 
7. Sumber data yang dipilih akan ditampilkan di list pada form Define Projection 

Wizard. 

 
8. Untuk menambahkan data yang akan ditentukan spatial reference-nya, ulangi 

langkah 5, 6 dan 7. 
9. Klik next untuk melanjutkan proses. 
10. Pada form selanjutnya klik tombol Select Coordinate System untuk menentukan 

sistem koordinat yang akan digunakan pada sumber data. 



83 
 

 
11. Klik tombol Select pada form Spatial Reference Properties untuk memilih sistem 

koordinat yang telah disediakan oleh ArcGIS.  

    
 Untuk mengambil sistem koordinat dari sumber data yang telah memiliki sistem 

koordinat dapat dilakukan dengan menekan tombol Import. 

 

12. Sistem koordinat yang telah ditentukan akan ditampilkan pada listbox di form 
Define Projection Wizard. Klik Next. 
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13. Klik Finish untuk menyelesaikan proses penentuan sistem koordinat pada 

sumber data. 

 
 

2.3.1.2.  MENENTUKAN SPATIAL REFERENCE PADA SUMBER DATA BERTIPE  
COVERAGE 

 
Untuk melakukan penentuan sistem koordinat pada sumber data yang bertipe 

ArcInfo Coverage, perlu dilakukan proses konversi dari ArcInfo Coverage ke 

Geodatabase dengan menggunakan aplikasi ArcToolbox. Setelah itu dapat 

ditentukan spatial reference dari sumber data yang telah dikonversi tersebut. 

Sedangkan untuk file yang bertipe ESRI Coverage bisa langsung ditentukan spatial 

referencenya melalui aplikasi ArcCatalog. 

 

Berikut ini adalah langkah – langkah untuk menentukan spatial reference pada 

sumber data beripe ArcInfo Coverage : 

 

1. Jalankan aplikasi ArcToolbox. 
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2. Pilih Conversion Tools > Import to Geodatabase > Coverage to Geodatabase 

Wizard. 

 
3. Double Klik pada menu yang telah dipilih. 
4. Akan ditampilkan form Coverage to Geodatabase Wizard. 

 

5. Tambahkan data dengan menekan tombol Add Data . 
6. Pilih sumber data ArcInfo Coverage yang akan dikonversi.  
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7. Kemudian tentukan fitur dari coverage yang akan dikonversi. 

 
8. Klik Next. 

 
9. Kemudian buat sebuah geodatabase untuk menampung data yang dikonversi 

dengan menggunakan aplikasi ArcCatalog : 
 
• Jalankan aplikasi ArcCatalog. 
• Tentukan folder untuk menyimpan geodatabase pada browser, kemudian pilih 

menu File > New > Personal Geodatabase. 
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10. Tekan tombol  , pilih geodatabase yang telah dibuat sebelumnya  

 

 
11.  Klik Next 

 
12. Pilih option Specify remaining parameters untuk fitur yang dikonversi untuk 

menentukan spatial referencenya, klik next 
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13. Klik tombol   untuk menentukan spatial reference, kemudian klik 
next. 

 
14. Klik pada kolom kedua unuk mengganti nama dari fitur, klik next 

 
15. Klik Finish untuk melakukan proses konversi dan penentuan spatial reference 

dari sumber data. 
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Sedangkan untuk sumber data bertipe ESRI Coverage, langkah – langkah 
penentuan spatial referencenya sebagai berikut : 
 
1. Jalankan aplikasi ArcCatalog 
2. Pilih sumber data ESRI Coverage pada browser 

 
3. Klik kanan pada data dan pilih Properties 
4. Akan ditampilkan form Coverages Properties 

 

5. Klik Tab Projection, Klik tombol  untuk menentukan spatial reference 
dari sumber data 

6. Setelah selesai klik Ok 
 

2.3.1.3.  MENENTUKAN SPATIAL REFERENCE PADA SUMBER DATA BERTIPE  
CAD ( AUTOCAD FILE ) 

 
Untuk menentukan spatial reference pada sumber data bertipe CAD Drawing dapat 
dilakukan melalui aplikasi ArcCatalog, langkah – langkahnya adalah sebagai berikut: 
 
1. Jalankan aplikasi ArcCatalog 
2. Pilih sumber data CAD drawing pada browser 
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3. Klik kanan pada data yang telah dipilih > Klik Properties 
4. Akan ditampilkan form CAD Drawing Properties 

 

5. Klik tombol  untuk menentukan spatial reference dari sumber data 
seperti pada sumber data yang lainnya. 

6. Setelah selesai klik Ok 
 

2.3.1.4.   Menentukan Spatial Reference Pada Sumber Data Bertipe Map Info 
File 

 
Untuk menentukan spatial reference pada sumber data bertipe MapInfo file perlu 

dilakukan proses konversi ke bentuk shapefile dengan menggunakan fasilitas 

Universal Transalator yang tersedia pada aplikasi MapInfo, karena pada ArcGIS 

tidak terdapat fasilitas untuk mengolah file bertipe MapInfo file. 
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2.3.2.  Prosedur Load Objects Melalui Aplikasi Arcmap 

Proses load objects dilakukan melalui aplikasi ArcMap, langkah – langkah proses 

load objects sebagai berikut : 

 

1. Jalankan aplikasi ArcMap. 

2. Tambahkan data dengan menekan tombol Add Data    kemudian pilih 
Feature Class atau Tabel yang terletak pada Template Geodatabase 
(MarineYYMMDD.mdb) yang akan diisi data Sumber Data Spatial dan Sumber 
Data Tekstual. 

3. Lakukan kustomisasi pengambilan fungsi Load Objects… dengan cara : Klik 
kanan pada area toolbar  > pilih Customize > pilih tab Commands > pilih kategori 
Data Converters pada Listbox Categories > drag & drop command Load 
Objects… dari Listbox Commands ke area pada salah satu toolbar yang aktif. 

4. Setelah kustomisasi dilakukan, kemudian pilih Editor > Start Editing pada toolbar 
editor. Kemudian pilih target feature class yang akan diload pada combobox 

Target . 
 

 
 

5. Kemudian klik tombol Load Objects… yang sebelumnya diletakkan pada toolbar. 
 

 
 

6. Pilih file pada Sumber Data dengan menekan tombol open folder  > Klik 
tombol Add   > Klik Next. Ulangi langkah tersebut jika ingin 
menambahkan data yang lain pada Sumber Data. Tipe dari sumber data yang 
dapat ditambahkan adalah shapefile , CAD feature class ( AutoCAD file ),  
ArcInfo Coverage, MapInfo (*.tab). 

7. Untuk setiap field target, tentukan dan pilih field source yang harus diload ke field 
target, jika tidak ada maka pilih <None>> Klik Next. 
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8. Pilih Load all of the source data  > Next 

 
9. Pilih No untuk pilihan snapping environment > pilih Yes untuk validasi fitur >  klik 

Next 
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10.   Akan ditampilkan Summary untuk operasi load dari data > Klik Finish 

 
11. Proses load objects akan terlihat pada bagian kiri bawah dari window  ArcMap. 

 
12.Setelah proses Load Objects selesai, maka akan ditampilkan data yang telah 

diload pada area active view. Pada saat proses Load Objects, ArcMap 

melakukan proses validasi dari atribut data yang diload sesuai dengan validasi 

yang telah ditentukan sebelumnya pada template geodatabase. Untuk 

mengetahui hasil dari validasi tersebut dapat dilihat pada data yang telah 

ditampilkan pada active view, jika terdapat data yang dipilih secara otomatis 

maka itu menunjukkan bahwa pada atribut data yang diload masih terdapat 

kesalahan pada aribut data tersebut. Tetapi apabila tidak terdapat data yang 

dipilih secara otomatis maka atribut data yang diload telah memenuhi proses 

validasi.  
 
2.3.3.  Prosedur Validasi Nilai Atribut Pada Fitur 

Langkah – langkah untuk melakukan proses validasi nilai atribut pada fitur sebagai 
berikut : 
 
1. Klik Editor > Start Editing jika proses untuk Edit belum distart. 

2. Klik Edit Tool   
3. Pilih fitur ( dapat dilakukan pemilihan lebih dari satu  atau multiselect ) yang akan 

divalidasi.  
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4. Klik Editor > Validate Selection. 
5. Jika fitur yang diseleksi untuk divalidasi mengandung data yang invalid maka 

akan tampil pesan kesalahan > klik OK 

 
 

6. Klik tombol Attributes untuk melihat atribut dari fitur yang invalid tersebut. 

 
7. Klik nilai atribut yang invalid dan ubah nilai tersebut. 

 
8. Tutup form dialog atribut. Kemudian validasi kembali fitur tersebut, apabila 

validasi berhasil maka akan tampil pesan. 

 
9. Jika masih ada kesalahan maka nilai atribut dari data harus kembali diubah. 
 

2.3.4.  Prosedur Penambahan Record Baru Ke Tabel Yang Terelasi 

Langkah – langkahnya adalah sebagai berikut : 

1. ArcMap > Editor > Start Editing. 
2. Klik Tombol Edit. 
3. Pilih Target. 
4. Pilih Fitur. 
5. Klik Tombol Attributes. 
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6. Pada Form Attributes double klik OBJECT ID , pada panel di sebelah kiri akan 
ditampilkan nama dari tabel yang terelasi. 

7. Klik kanan nama tabel yang terelasi > pilih Add New. 
8. Lalu masukkan nilai atribut pada panel sebelah kanan. 
9. Editor > Save Edits / Stop Editing. 
 

2.3.5.  Prosedur Pembuatan Relasi Baru Antara Fitur Dan Obyek Non Spatial 

Langkah – langkahnya adalah sebagai berikut : 

1. Klik Edit Tool.  
2. Klik fitur yang akan direlasikan. 
3. Pada Table of Contents, klik kanan tabel yang akan direlasikan dengan fitur yang 

sebelumnya sudah dipilih tadi > Open. 
4. Klik obyek pada tabel. 
5. Klik Tombol Attributes. 
6. Double klik fitur yang dipilih sebelumnya > klik kanan nama tabel yang terelasi > 

pilih Add Selected. 
7. Obyek yang dipilih telah ditambahkan. 
 

2.3.6.  Prosedur Penyesuaian Tipe Atribut Dari Sumber Data 
 
1. Jalankan Aplikasi ArcMap, Tambahkan data dengan mengklik tombol Add Data 

 
 

2. Pilih data source yang akan diubah, klik Add 
3. Klik kanan nama data source pada Table Of Contents 

Add data 
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4. Pilih Open Attribute Table 
5. Akan tampil form Attributes dari data source 

 
6. Klik Options 
7. Pilih Add Field 
8. Akan tampil form add field 

 
9. Isi nama field dengan nama yang identik dengan nama field yang bertipe salah 
10. Pilih tipe data yang sesuai dengan tipe data field template geodatabase, klik Ok 
11. Klik kanan pada field baru lalu pilih calculate values 
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12. Akan tampil form konfirmasi, pilih yes 
13. Akan tampil form field calculator lalu pilih field yang bertipe data salah yang 

nilainya akan diambil dan dipindahkan ke field baru, klik ok 

 
14. Akan tampil form working yang menunjukkan proses calculating. 
15. Hapus field yang bertipe data salah, dengan cara klik kanan kemudian pilih 

delete field 

 
 

2.3.7.  Prosedur Validasi Nilai Atribut Kosong  

Setelah proses Load Objects dilakukan, tidak semua atribut data dari sumber data 

memenuhi prosedur validasi yang ditentukan sehingga mengakibatkan nilai data 

tersebut tidak dapat diload ke template geodatabase dan nilai atribut pada template 

geodatabase menjadi kosong. Maka harus dilakukan prosedur validasi kembali 

terhadap nilai atribut yang kosong pada template geodatabase. Untuk melakukan 

prosedur ini, diperlukan pemeriksaan secara cermat dan teliti terhadap struktur dan 

nilai atribut dari sumber data. Setelah itu dapat dilakukan prosedur validasi melalui 
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aplikasi ArcMap. Langkah – langkah prosedur ini sama seperti yang telah dilakukan 

pada prosedur validasi nilai atribut pada fitur yang sebelumnya telah dijelaskan pada 

bagian 3.3 . 

 
2.3.8.  Prosedur Validasi Nilai Atribut Date ( Tanggal ) 

Sebagai tahap akhir dari proses load objects perlu dilakukan prosedur untuk 

memvalidasi atribut Date yang ada pada template geodatabase, hal ini dikarenakan 

tidak ada fasilitas yang dapat memvalidasi secara otomatis pada ArcCatalog. 

Prosedur validasi ini dilakukan melalui aplikasi ArcMap, dengan langkah – langkah 

sebagai berikut : 

1. Jalankan aplikasi ArcMap, kemudian tambahkan data ( feature class ) dari 
template geodatabase yang akan divalidasi. 

 
2. Kemudian pilih feature class yang akan diload. Klik add 

 
3. Klik kanan feature class pada Table Of Contents, kemudian pilih Open Attribute 

Table. 

Add data 
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4. Akan tampil form Attribute dari feature class, kemudian klik kanan pada field date 

dan pilih Calculate Values 

 
5. Akan tampil form Field Calculator, sebelum memilih fungsi tipe Date perlu 

diperiksa apakah setting tanggal pada komputer yang digunakan sudah benar 
atau sudah sesuai dengan sistem waktu dan tanggal yang berlaku. Setelah itu 
pilih tipe function date dan pilih function NOW( ), klik ok 

 
6. Akan tampil form Working yang menunjukkan proses calculating. 



100 
 

 
 

Prosedur validasi field date tersebut harus dilakukan setelah proses load objects 

selesai sebagai kelanjutan dari proses load objects tersebut. 
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BAB III :  KONSEP BASIS DATA DAN ANALISIS SISTEM INFORMASI 
GEOGRAFIS 
 
3.1. PENGERTIAN GEOREFERENCING  
 
Adalah proses penempatan objek berupa raster atau image yang belum mempunyai 
acuan system koordinat ke dalam system koordinat dan proyeksi tertentu.  
Secara umum tahapan georeferencing pada data raster adalah sbb:  
 
Pada ArcMap  
A. Tambahkan data raster yang akan ditempatkan pada system koordinat dan 

proyeksi tertentu.  
B. Tambahkan titik control pada data raster yang dijadikan sebagai titik ikat dan 

diketahui nilai koordinatnya.  
C. Simpan informasi georeferensi jika pengikatan obyek ke georeference sudah 

dianggap benar.  
 
Anda dapat membuat nilai koordinat tetap untuk data raster setelah ditransformasi 
(proses georeferencing) dengan menggunakan perintah Rectify pada 
Georeferencing toolbar. Ssistem koordinat akan sama dengan koordinat acuan yang 
dipakai. 
 
3.2. TAHAPAN SECARA DETAIL PROSES GEOREFERENCING 

3.2.1 Dengan Membuat Link Antar Layer 

1. Tambahkan layer yang akan dijadikan acuan koordinat dan layer raster yang 
akan dilakukan proses georeferencing. 

 
2. Pada table of contents (TOC) klik kanan target layer (vector data-acuan 

referensi) dan klik Zoom to Layer. 
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3. Dari Georeferencing toolbar, klik/pilih layer raster/image yang akan diproses 

georeference . 

 
4. Klik Georeferencing dan click Fit To Display untuk menempatkan visual 

raster/image pada area display yang sama dengan target layer. 

 
5. Anda juga bisa menggunakan Shift dan Rotate tools memindahkan posisi 

raster/image sesuai keperluan. 

 
6. Klik Control Points tool untuk menambahkan titik control 

 
7. Untuk menambahkan link, klik mouse pada lokasi yang mempunyai 

karakteristik yang mudah dikenali pada target layer, seperti pada 
pojok/perpotongan obyek pada raster/image, kemudian klik pada target layer 
(the referenced data) obyek yang sama pada raster/image tsb (titik sekutu). 

8. Anda akan terbantu jika mengunakan Magnifier window utk mempertajam 
kenampakan titik sekutu. 

9. Tambahkan links secukupnya, minimal 4 titik, lebih banyak lebih baik. 
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10. Klik View Link Table untuk mengevaluasi nilai titik control tsb. 

 
11. Klik Georeferencing dan klik Update Georeferencing untuk menyimpan 

informasi transformasi dari suatu raster dataset sekaligus mempertahankan 
nilai koordinat/posisi georeferencing yang baru dengan nama layer 
raster/image yang sama dengan sourcenya. 

12. Hasil proses georeferencing bisa disimpan dengan nama baru (Save as) 
dengan perintah Rectify pada Georeferencing toolbar. 
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3.2.2 Dengan Memasukkan Nilai Koordinat yang Diketahui 
 

1. Klik View Link Table pada Georeferencing toolbar. 
2. Klik Control Points tool. 
3. Klik mouse di atas lokasi yang diketahui koordinatnya di atas layer 

raster/image untuk membuat link yang pertama. 
4. Klik kanan dan pilih input X and Y. 

 
5. Masukkan koordinat referensi pada Enter Coordinates dialog box. 
6. Klik OK. 

 
3.3 Edit Feature Spasial. 
 
Pada bagian ini akan dijelaskan tahapan untuk melakukan editing terhadap data 
spasial.  Cara editing yang diperkenalkan menggunakan Arcmap dari ARCGIS, dan 
tulisan ini diambil dari buku panduan MCRMP. 



106 
 

3.3.1. PENGENALAN ARCMAP 

3.3.1.1 Pengantar 

ArcMap adalah salah satu sub bagian dari kesatuan software ArcGIS Desktop yang 
memiliki banyak fungsi, mulai membuat, mengedit menampilkan, melakukan query 
dan analisis spasial hingga menghasilkan informasi spasial, baik dalam bentuk peta 
maupun dalam bentuk report dalam bentuk tabel. 
Pengenalan ArcMap pada bagian ini lebih ditujukan untuk menampilkan hal-hal 
dasar yang berkaitan erat dengan proses editing. Referensi lanjut tentang dasar-
dasar penggunaan Arcmap dapat anda lihat pada daftar referensi di bagian akhir 
manual ini. 
 
3.3.1.2 Menjalankan ArcMap 

Untuk menjalankan ArcMap anda dapat melakukannya dengan mengklik ikon 
ArcMap yang terdapat pada komputer anda. Salah satu caranya adalah sebagai 
berikut. 
 
1. Klik Start Menu 
2. Sorot Programs 
3. Sorot ArcGIS 
4. Klik ArcMap 
 



107 
 

 
 
3.3.1.3 Komponen-komponen ArcMap 

Beberapa komponen ArcMap adalah sebagai berikut : 
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A. Table of Contents (TOC), dapat dianggap sebagai daftar isi data yang terdapat 

dalam Map Area.. TOC terdiri atas Data Frame yang berisi layer-layer yang 
merepresentasikan data yang ada. Beberapa aksi yang dapat dilakukan dalam 
TOC antara lain : 
 
1. Mengatur susunan layer-layer yang ada 
2. Mendefenisikan properti data spasial seperti simbolisasi, query, transparansi, 

pelabelan berdasarkan attribut dll. 
3. Melihat sistem koordinat yang digunakan 
4. Membuka tabel attribut data spasial 

 
TOC memiliki 3 mode tampilan (untuk ArcGIS 9.0), yaitu : 
 

1. Mode Display, merupakan mode standar dan paling sering digunakan. 
2. Mode Source, digunakan untuk melihat sumber data spasial yang ditampilkan 
3. Mode Selection, digunakan untuk menentukan layer yang dapat dipilih dengan 

menggunakan selection tool. 
 

Untuk menampilkan/menyembunyikan TOC, pada menu bar klik menu Window > 
Table Of Contents 
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1. License Indicator, memberikan informasi tentang lisensi yang sedang 
digunakan. Level lisensi menentukan tingkat kemampuan ArcMap untuk 
melakukan operasi-operasi pengelolaan data. Hal ini berarti bahwa beberapa 
operasi hanya dapat dilaksanakan pada tingkatan lisensi tertentu. Pada 
gambar diatas, lisensi yang tersedia adalah pada tingkatanArcView. 

2. Toolbox, adalah kumpulan alat bantu yang disediakan untuk melaksanakan 
operasi-operasi tertentu. Toolbox dapat diaktifkan dari menu Window > 
ArcToolbox atau dengan mengklik icon ArcToolbox pada menu Toolbar 
Standar. 

3. Menu Bar, adalah kumpulan menu-menu yang ArcMap. 
4. Map Area, merupakan area yang memperlihatkan data spasial yang ada. 

 
3.3.1.4 Pengenalan Toolbar. 

Toolbar adalah kumpulan tool yang diletakkan didalam bar. Secara logis toolbar 
memiliki tool-tool yang berkaitan secara erat dalam melaksanakan operasi-operasi 
tertentu. Sebagaimana layaknya aplikasi modern lainnya yang mengandung konsep 
user friendly, toolbar dapat ditampilkan atau tidak ditampilkan, dikustomasi sesuai 
keinginan kita dll. Berikut ini adalah toolbar-toolbar yang umum dipergunakan dalam 
operasi editing ArcMap. 
 
3.3.1.4.1 Toolbar Standard 

Toolbar ini adalah toolbar yang memiliki tool-tool standar yang sangat sering 
digunakan dalam hampir semua operasi di ArcMap. 

 
 
3.3.1.4.2 Toolbar Tools 
 

Toolbar ini digunakan untuk navigasi dan explorasi data spasial yang ditampilkan. 

 
 

3.3.1.4.3 Toolbar Editor 

Toolbar ini digunakan digunakan pada saat pengeditan data. Pengenalan lebih lanjut 
tentang toolbar ini akan dibahas pada bab-bab selanjutnya. 
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3.3.1.4.4 Toolbar Advanced Editing 

Toolbar ini digunakan digunakan pada saat pengeditan data tingkat lanjut. Beberapa 
tool pada toolbar ini membutuhkan tingkat lisensi ArcEditor untuk dapat beroperasi. 

 
 

3.3.1.4.5 Toolbar Spatial Adjustment 

Toolbar ini digunakan digunakan pada saat pengeditan data tingkat lanjut. Beberapa 
operasi yang dapat dilakukan dengan menggunakan tool pada toolbar ini adalah : 
 

1. Perubahan geometri data (adjustment) dengan beberapa metode 
transformasi 

2. Edgemathing, pencocokan batas-batas tepi data. Umumnya operasi ini 
dilakukan sebelum penggabungan data yang berasal dari 2 atau lebih lembar 
peta yang bersebelahan. 

3. Attribut Transfer, digunakan untuk duplikasi/transfer attribut antar fitur, baik 
yang berlainan layer maupun pada layer yang sama. 

 
 

3.3.1.4.6 Toolbar Annotation 

Toolbar ini digunakan untuk mengedit annotasi yang berada dalam geodatabase. 

 
 
3.3.1.4.7 Toolbar Topology 

Toolbar ini digunakan untuk memastikan konsistensi topologi fitur karena memiliki 
kemampuan untuk mendeteksi kesalahan topologi sekaligus menawarkan solusi 
perbaikannya. 

 
 

3.3.1.4.8 Mengaktifkan Toolbar 

Toolbar dapat diaktifkan dengan beberapa cara : 
 

1. Klik kanan pada toolbar area kemudian klik pada nama toolbar yang 
diinginkan. 
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2. Klik menu View dari Main Menu Bar, selanjutnya pilih Toolbars, kemudian klik 

pada nama toolbar yang diinginkan. 
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3. Toolbar yang telah aktif memiliki tanda centang ( ) di depan nama toolbar. 
4. Untuk menghilangkan toolbar, lakukan langkah diatas kembali dengan 

memilih nama toolbar yang nampak. 
 
3.3.1.4.9 Mengkustomasi Toolbar 

tool yang sesuai dengan kebutuhan kerja kita. Aktifitas yang termasuk dalam bagian 
ini antara lain : 
 
1. Mengatur Posisi toolbar sedemikian rupa sehingga memudahkan kita dalam 

bekerja. 
2. Membuat toolbar sendiri yang diperlukan 
3. Menambahkan/menghilangkan tool-tool pada toolbar 

 
Kustomasi Toolbar dapat dilakukan dengan cara : 
 
1. Klik kanan pada Toolbar Area, kemudian klik Customize pada bahagian paling 

bawah dari daftar toolbar yang muncul sehingga kotak dialog Customize terlihat. 
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2. Untuk membuat toolbar baru klik pada Tombol New sehingga terlihat kotak dialog 

New Toolbar, Isilah Nama Toolbar kemudian 
3. Klik Oke sehingga terlihat toolbar baru yang siap untuk diisi dengan tool-tool yang 

diinginkan 

 
4. Klik Tab Commands pada Kotak Dialog Customize 
5. Pilihlah tool dengan memilih kategorinya terlebih dahulu kemudian klik sambil 

menyeret tool tersebut ke toolbar yang baru dibuat. Untuk menghapus tool dari 



114 
 

toolbar klik kanan tool kemudian klik delete. Lakukan langkah ini hingga semua 
tool yang dibutuhkan masuk di dalam toolbar tersebut. 

6. Klik Close untuk mengakhiri sesi kustomasi toolbar 
7. Toolbar baru yang terbentuk siap untuk digunakan seperti toolbar lain. 

 
 
3.3.1.5 Memasukkan Data 
 
Sebelum bisa diedit, data terlebih dahulu dimasukkan ke ArcMap. Hal demikian juga 
berlaku pada data yang digunakan sebagai referensi untuk editing, dimana data 
referensi ini digunakan sebagai acuan dengan menampilkannya di dalam ArcMap 
bersama-sama dengan data yang akan di edit. Arcmap dapat mengedit data spasial 
tipe Shapefiles dan Geodatabase. Langkah-langkah memasukkan data adalah 
sebagai berikut : 
 
1. Jalankan ArcMap dengan mengklik ikonnya di StartMenu atau Desktop. Secara 

standar Ikon ArcMap terdapat pada StartMenu > Programs > ArcGIS 
2. Klik menu File > Add Data dari Menu bar atau klik ikon AddData dari Standard 

toolbar 
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3. Dari kotak dialog AddData, pilihlah data yang akan dimasukkan kemudian klik 

tombol Add. Pemilihan beberapa data dapat dilakukan dengan mengklik data 
sambil menahan tombol kontrol (Ctrl) pada keyboard. 

 
4. Data yang terpilih kemudian ditampilkan dalam ArcMap. Secara logis ArcMap 

menambahkan data dengan hirarki berdasarkan urutan pemilihan dalam kotak 
dialog Add Data. 

5. Untuk membuang data, klik kanan nama layernya pada TOC, kemudian pilih 
Remove. 
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3.3.1.6 Simbolisasi Data 

Simbolisasi proses pengaturan simbol data dengan mendefenisikan tampilan fitur. 
Hal ini bertujuan memperlihatkan informasi yang terkandung dalam data secara 
jelas. Caranya adalah dengan menggunakan kotak dialog layer properties. 

1. Klik kanan pada layer yang akan diatur simbolnya 
2. Klik menu properties. Kotak dialog layer properties kemudian tampil. 
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3. Pada kotak dialog layer properties, klik tab Symbology 
4. Selanjutnya klik metode penampilan data yang diinginkan pada kotak 

pemilihan show 
5. Pilihlah field attribut data yang dijadikan acuan 
6. Klik Add All Value untuk menambahkan nilai sekaligus atau Add Value untuk 

menambahkan nilai satu persatu. 
7. Lakukan perubahan warna dengan melakukan klik ganda pada ikon warna di 

depan nilai data. 
8. Klik OK untuk menutup kotak dialog. 
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9. Layer selanjutnya tergambar sesuai dengan simbol yang ditentukan. 
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3.3.1.7 Explorasi Data 

Eksplorasi data adalah kegiatan melihat data yang ada secara detail, baik dari 
geometri maupun atributnya. 
 
3.3.1.7.1 Menggunakan Toolbar Tool untuk Explorasi Data 

Sebagaimana disebutkan sebelumnya, toolbar tool memiliki kumpulan tool yang 
sangat berguna untuk melakukan ekplorasi data. Berikut ini adalah Toolbar tool 
dengan bagian-bagiannya : 
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A. Zoom In, digunakan untuk melakukan pembesaran sehingga data dapat 

terlihat lebih jelas. Tool ini diikuti dengan pendefenisian acuan pembesaran 
dengan mouse pointer. Cara menggunakannya adalah dengan mengklik 
tombolnya kemudian diikuti dengan menentukan referensi pembesaran 
dengan menggunakan pointer mouse pada map area. 

 
B. Zoom Out, kebalikan dari tool zoom in. 
C. Fixed Zoom In, sama dengan tool Zoom In namun referensi pembesarannya 

tetap (fixed) 
D. Fixed Zoom Out, kebalikan dari tool Fixed Zoom In. 
E. Pan, digunakan untuk menggeser tampilan data tanpa mengubah skala. Cara 

menggunakannya adalah dengan mengklik tombolnya, kemudian melakukan 
klik kiri dan menahannya sambil menyeret pointer ke arah yang berlawanan 
dengan wilayah yang hendak dilihat. 

F. Zoom Extent, digunakan untuk melihat semua data yang ada. 
G. Previous Extent, digunakan untuk kembali ke tampilan data sebelumnya 
H. Next Extent, kebalikan dari Previous Extent. 
I. Identify Tool, digunakan untuk melihat informasi yang terdapat pada attribut 

fitur yang diklik. Cara menggunakannya adalah sebagai berikut : 
1. Klik Identify Tool 
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2. Pada Kotak dialog Identify Result, tentukan layer mana yang akan dilihat 
informasinya. 

3. Pada Map Area, klik fitur yang ingin dilihat informasinya hingga fitur 
tersebut akan berkedip (flashing). Untuk melihat attribut beberapa fitur 
tekan tombol Shift sambil melakukan klik pada fitur yang diinginkan. 

4. Informasi Fitur yang di klik terlihat pada kotak Identify Result. 

 
J. Measure Tool, digunakan untuk melakukan pengukuran jarak secara umum. 

Hasil pengukurannya ditampilkan di sudut kiri bawah window ArcMap (Status 
Bar). Satuan jarak yang digunakan adalah display unit yang ditentukan pada 
Data Frame Properties. 
 

3.3.1.7.2 Melakukan Zoom Layer 

Zoom Layer digunakan untuk melihat seluruh fitur yang terdapat dalam layer. Hal ini 
dilakukan dengan cara : 
 

1. Pada Table of Content, klik kanan layer yang diinginkan. 
2. Pada pop up menu yang muncul, pilihlah Zoom to Layer 

 
3.3.1.7.3 Melakukan Zoom Pada Skala Tertentu 

Zoom pada skala tertentu dilakukan dengan memilih atau mengetikkan langsung 
nilai skala yang diinginkan pada kotak map scale yang ada pada toolbar Standard 
dan diikuti dengan menekan tombol Enter pada keyboard. 
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3.3.1.7.4 Melihat Tabel Attribut Data 

Tabel attribut data dapat dilihat dengan melakukan klik kanan pada layer kemudian 
pilih menu Open Attribute Table. Tabel attribut menyediakan fasilitas yang 
memudahkan dalam melihat maupun mengedit attribut. Fasilitas itu antara lain, 
kemampuan untuk mengurutkan data, pencarian dan penggantian karakter ataupun 
angka tertentu, pemilihan data 
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3.4. DASAR DASAR PENGEDITAN 

3.4.1 Sekilas Tentang Proses Editing 

Editing fitur adalah kegiatan memanipulasi objek peta melalui serangkaian aksi 
editing. Secara umum kegiatan editing mencakup pembuatan fitur baru dan 
perbaikan fitur yang telah ada. Properti fitur yang dieditpun tidak hanya terbatas 
pada geometry (bentuk) fitur saja, tetapi juga mencakup attribut fitur itu sendiri. 
Tahapan yang umum dilalui dalam proses editimg fitur adalah : 
 

1. Menjalankan ArcMap 
2. Memasukkan data, baik yang hendak diedit maupun data referensi 

kedalam ArcMap. Data referensi adalah data lain yang dibutuhkan 
sebagai acuan dalam proses editing. 

3. Menampilkan Toolbar-toolbar Editing yang dibutuhkan. 
4. Mengaktifkan mode editing 
5. Melaksanakan operasi editing 
6. Mengakhiri mode editing yang disertai dengan penyimpanan hasil 

editing. 
 

Dukungan editing fitur pada Arcmap dapat dilakukan dengan menggunakan toolbar-
toolbar editing, baik yang terpasang built-in maupun yang dibuat oleh pihak ketiga. 
Contoh toolbar editing yang built in adalah Toolbar editing standar (standard editing 
toolbar), toolbar editing lanjutan (Advanced editor toolbar), toolbar georeferensi 
(georeferencing toolbar) sedangkan contoh toolbar editing yang dibuat oleh pihak 
ketiga adalah GeoTool ( http://www.ian-ko.com ). 
 
3.4.2 Toolbar-Toolbar untuk Editing 

3.4.2.1 Toolbar Editor Standar 

Tampilan standar toolbar editor standar dan bagian-bagiannya adalah sebagai 
berikut : 



124 
 

 
Gambar 1. Toolbar Editor 

Toolbar editor terdiri atas beberapa bagian, sesuai dengan kode nomor pada 
gambar 1 adalah sebagai berikut : 
 

1. Drop down menu editor. Dua sub menu teratas (Start editing dan Stop 
Editing), sesuai namanya digunakan untuk memulai dan menghentikan sesi 
editing. 

2. Edit tool . Digunakan untuk memilih fitur sebelum memodifikasi fitur tersebut. 
3. Tool Palette. Kumpulan tool yang digunakan untuk membuat sketsa. 
4. Current Task Drop Down List. Daftar tugas editing yang sedang dilakukan. 

Tool ini menentukan jenis tindakan yang dilakukan oleh sketsa. 
5. Target Drop Down List. Tool ini menentukan pada layer mana hasil operasi 

editing disimpan. 
6. Split Tool. Tool ini digunakan untuk membagi fitur garis menjadi 2 bagian 

pada lokasi tertentu 
7. Rotate Tool. Digunakan untuk memutar segment. 
8. Attribute Button. Tombol yang memperlihatkan atribut fitur terpilih. 
9. Sketch Properties. Tombol yang memperlihatkan attribut geometri (Posisi X 

dan Y) masing-masing vertex pada sketsa yang dibentuk. 
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3.4.2.2 Toolbar Editor Lanjutan 

Sesuai dengan namanya, toolbar ini digunakan untuk editing tingkat lanjut. Beberapa 
tool pada toolbar ini tidak bisa diakses oleh lisensi ArcView. Tampilan standar 
toolbar editor lanjutan dan bagian-bagiannya adalah sebagai berikut : 

 
Gambar 2. Toolbar Editor Lanjutan. 

 
1. Fillet Tool. Digunakan untuk membuat lengkungan (kurva pada pertemuan 2 

garis) 
2. Extend Tool. Digunakan untuk memanjangkan garis hingga menyentuh garis 

yang terpilih. 
3. Traverse Tool. Digunakan untuk membuat segment sketsa secara akurat 

dengan memasukkan parameter-parameter sketsa yang sesuai. parameter-
parameter yang digunakan sering disebut COGO (Coordinate Geometry). 

4. Explode Tool. Digunakan untuk memecahkan fitur yang terdiri atas banyak 
bagian (multipart fitur) menjadi banyak fitur tunggal (singlepart fitur). 

5. Smooth Tool. Digunakan untuk menghaluskan garis yang terpilih dengan cara 
mengubah segment yang kasar menjadi beberapa segment yang halus dengan 
penambahan titik-titik node/verteks. 

6. Circle Tool. Digunakan untuk menggambar lingkaran. Gunakan tombol ‘R’ untuk 
menentukan radius lingkaran. 

7. Rectangle Tool. Digunakan untuk menggambar segi empat. Tekan dan Tahan 
tombol ‘SHIFT’ pada keyboard untuk membuat bujur sangkar. 

8. Generalize Tool. Digunakan untuk menyederhanakan geometri fitur dengan 
menghilangkan verteks-verteks yang tidak vital. 

9. Inverse Tool. Digunakan untuk menambahkan deskripsi COGO kedalam tabel 
attribut fitur. 
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10. Proportion Tool. Digunakan untuk membagi garis secara proporsional. 
11. Trim Tool. Kebalikan dari extend tool. Tool ini digunakan untuk memotong garis 

tepat pada perpotongan dengan garis terpilih. 
12. Copy Features Tool. Digunakan untuk menduplikasi fitur terpilih. 
 
3.4.3 Sketsa 
 
Sketsa (sketch) adalah bentuk yang digambar dengan menggunakan sketch tool 
secara sementara dan berfungsi untuk melaksanakan tugas yang ditentukan dalam 
daftar tugas (dropdown list task). Sebagai contoh, untuk membuat fitur bangunan 
baru terlebih dahulu didefenisikan penugasan “Create New Feature”, kemudian 
menggunakan sketch tool untuk menggambar bentuk bangunan yang diinginkan. 
Fitur baru kemudian terbentuk sesuai dengan garis sketsa yang dibuat. Tipe dari 
sketsa, - titik, garis atau poligon-, ditentukan oleh tipe layer target. 
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3.4.3.1 Tool-tool Pembuat Sketsa 

Tool-tool sketsa, sering juga disebut Sketch Construction Tool terdiri atas : 

Sketch tool

Midpoint tool

Distance-Distance tool

Intersection tool

Arc tool

Tangent Curve tool

Trace tool

Direction-Distance toolEndpoint Arc tool
 

  
 
1. Sketch tool 

Digunakan untuk membuat fitur point dan digitasi fitur garis atau poligon. 
2. Midpoint tool 

Digunakan untuk mendapatkan titik tengah antara 2 titik yang di klik (titik awal & 
titik akhir) 

3. Distance-Distance tool 
Tool ini bekerja dengan memanfaatkan titik singgung antara 2 lingkaran yang 
ditentukan radiusnya. Bila kedua lingkaran tersebut tidak bersinggungan, maka 
tidak akan terdapat verteks yang dihasilkan oleh tool ini, sebaliknya akan terdapat 
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2 titik singgung yang dapat dipilih. Untuk memasukkan nilai radius yang akurat 
gunakan tombol “R”. 

4. Intersection tool 
Tool ini digunakan untuk menemukan titik singgung antara 2 garis. 

5. Arc tool 
Tool ini digunakan untuk membuat garis lengkungan yang membutuhkan 3 
parameter yaitu titik awal, titik aksis dan titik akhir. Garis sketsa yang terbentuk 
akan selalu melalui ketiga titik tersebut walaupun titik kedua (aksis) tidak terlihat. 

6. Endpoint Arc tool 
Hampir sama dengan Arc tool, namun parameter lengkungan kurva ditentukan 
pada sesi akhir dan dapat menggunakan nilai tertentu dengan menggunakan 
tombol “R” 

7. Tangent Curve tool 
Tool ini membuat segmen yang berbentuk tangensial terhadap segmen 
sebelumnya. Tool ini aktif jika telah ada segmen yang dibuat dengan 
menggunakan tool lain. 

8. Trace tool 
Digunakan untuk mengikuti bentuk fitur yang telah ada (tracing). Fitur yang akan 
diikuti geometrinya harus terseleksi terlebih dahulu. 

9. Direction Distance tool 
Tool ini digunakan untuk menentukan verteks berdasarkan 2 titik input. Satu titik 
input memerlukan parameter sudut (bearing), sedangkan titik input yang lain 
memerlukan parameter jarak. Salah satu contohnya adalah menentukan posisi 
tiang listrik yang berjarak X meter dari sudut bangunan A dan memiliki sudut arah 
sebesar θ derajat dari titik perpotongan (interseksi) jalan. Gunakan tombol “A” 
untuk memasukkan parameter sudut dan tombol “R” untuk parameter Jari-jari 
lingkaran secara tepat. 
 

Dengan mengingat bahwa konsep editing fitur di dalam ArcGIS banyak bergantung 
pada penggunaan sketch, kiranya perlu dipahami komponen-komponen yang 
membentuk sketch tersebut : 
 
1. Start Point, adalah titik mulainya garis sketch 
2. End Point, adalah titik berakhirnya garis sketch. 
3. Verteks, adalah titik-titik (node) yang berada diantara Start Point dan End Point 
4. Segment, adalah garis yang menghubungkan 2 titik (node) 
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Selama dalam sesi pembuatan sketsa, komponen-komponen pembentuk sketsa 
juga dapat diubah, misalnya : 
 
1. Menghapus/menambah verteks 
2. Membalik (flipping) sketsa 
3. Melihat/memindahkan posisi verteks secara relatif maupun absolut 
4. Memotong panjang garis sketsa (trim) 
5. Melihat properti sketsa 
Semua menu untuk memodifikasi sketsa tersebut dapat diakses dengan cara klik 
kanan pada sketsa sehingga muncul pop up menu untuk mengubah sketsa. Contoh 
dibawah ini memperlihatkan cara melihat properti sketsa. 

 
 
3.4.3.2 Bantuan Pembuatan Sketsa 

Fasilitas bantuan untuk pembuatan sketsa dapat diakses dengan melakukan klik 
kanan pada Map Area (bukan pada garis sketsa) selama dalam sesi pembangunan 
sketsa. 
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Untuk mengakses menu tersebut lakukan klik kanan pada saat pembuatan sketsa 
pada saat posisi pointer mouse tidak berada pada garis sketsa yang telah terbentuk. 
Ketersediaan menu tergantung pada tipe target layer dan banyaknya segment 
sketsa yang telah terbentuk. Beriku ini adalah penjelasan singkat tentang pilihan-
pilihan menu tersebut : 
 
1. Snap to Feature, digunakan pada pembuatan titik verteks sketsa secara yang 

berimpit (snap) dengan komponen segmen fitur (bukan sketsa) eksisting. Lihat 
topik snapping untuk keterangan lebih lanjut. 

2. Direction (shorcut = Ctrl + A), digunakan untuk membuat segmen dengan sudut 
tertentu. Tool ini Membutuhkan tipe target layer Poligon atau Line dengan 
minimum 1 verteks awal sketsa. 

3. Deflection (shorcut = Ctrl + F), digunakan untuk membuat segmen dengan sudut 
defleksi tertentu dari segment sketsa terakhir. Membutuhkan tipe target layer 
Poligon atau Line dengan minimum 1 segmen (2 verteks) sketsa yang telah 
terbentuk. 

4. Length (shorcut = Ctrl + L), digunakan untuk membuat segmen panjang tertentu 
dari titik verteks terakhir. Tool ini membutuhkan tipe target layer Poligon atau 
Line dengan minimum 1 verteks awal sketsa. 

5. Change Length, digunakan untuk mengubah panjang segment terakhir dengan 
tetap mempertahankan arah segmen tersebut. Membutuhkan tipe target layer 



131 
 

Poligon atau Line dengan minimum 1 segmen (2 verteks) sketsa yang telah 
terbentuk. 

6. Absolute X,Y (shorcut = F6), digunakan untuk menggambar verteks yang 
diketahui posisi absolutnya. Tool ini bekerja pada tipe target layer titik, line atau 
poligon. 

7. Delta X,Y (shorcut = Ctrl + D) digunakan untuk menggambar verteks yang 
diketahui posisi relatifnya terhadap posisi verteks terakhir. Tool ini bekerja pada 
tipe target layer titik, line atau poligon dengan minimum 1 verteks sketsa yang 
telah terbentuk. 

8. Direction/Length (shorcut = Ctrl + G), digunakan untuk membuat segmen 
dengan arah dan panjang yang tertentu dalam sekali aksi (Gabungan antara 
menu Direction dan Length). Tool ini membutuhkan tipe target layer Poligon atau 
Line dengan minimum 1 verteks awal sketsa. 

9. Paralel (shorcut =Ctrl + P), digunakan untuk membuat segmen sketsa yang 
sejajar dengan segmen fitur yang diklik. Tool ini membutuhkan tipe target layer 
Poligon atau Line dengan minimum 1 verteks awal sketsa. Tipe fitur yang diklik 
harus berupa fitur garis atau poligon. 

10. Perpendicular (shorcut =Ctrl + E ) digunakan untuk membuat segmen sketsa 
yang tegak lurus terhadap segmen fitur yang diklik. Tool ini membutuhkan tipe 
target layer Poligon atau Line dengan minimum 1 verteks awal sketsa. Tipe fitur 
yang diklik harus berupa fitur garis atau poligon. 

11. Segment Deflection (shorcut = F7) digunakan untuk membuat segmen sketsa 
yang membentuk sudut tertentu terhadap segmen fitur yang diklik. Tool ini 
membutuhkan tipe target layer Poligon atau Line dengan minimum 1 verteks 
awal sketsa. Tipe fitur yang diklik harus berupa fitur garis garis atau poligon. 

12. Replace Sketch, mengganti/membuat garis sketsa dengan bentuk fitur yang di 
klik. Tool ini membutuhkan tipe target layer Poligon atau Line. Tipe fitur yang 
diklik harus berupa fitur garis garis atau poligon. 

13. Tangent Curve (shorcut =Ctrl + T), membuat segment kurva tangen, Tool ini 
membutuhkan tipe target layer Poligon atau Line dengan minimum 1 segmen 
awal sketsa. 

14. Streaming (Shorcut = F8), mengaktifkan mode streaming pada penggambaran 
sketsa dengan menggunakan sketch tool. Mode streaming adalah 
penggambaran garis sketsa dengan mengikuti pergerakan kursor mouse tanpa 
harus melakukan klik. Verteks sketsa ditambahkan pada jarak yang ditentukan 
dalam kotak dialog Editing Option yang diakses melalui menu Editor > Option. 

15. Delete Sketch (shorcut = Ctrl + Delete), digunakan untuk menghapus sketsa. 
16. Finish Sketch (shorcut = F2), digunakan untuk mengakhiri pembuatan sketsa. 
17. Square and finish, digunakan untuk mengakhiri pembuatan sketsa sambil 

menambahkan 2 segment pada sketsa. Segmen pertama yang ditambahkan 
tegak lurus terhadap segmen terakhir yang telah ada dan segmen kedua yang 
ditambahkan tegak lurus terhadap segmen pertama yang telah ada. Tool ini 
membutuhkan minimum 2 segmen yang berbeda arah. 
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18. Finish Part, digunakan untuk menghentikan pembuatan 1 bagian sketsa dan 
dilanjutkan dengan pembuatan bagian sketsa yang lain. Kegunaan fasilitas ini 
antara lain untuk membuat Multipart Feature dan pemilihan banyak objek 
dengan garis sketsa. 
 

Beberapa hal yang berguna pada waktu pembuatan sketsa antara lain : 
 
1. Tombol Esc dapat digunakan untuk membebaskan pembatasan yang 

diperlakukan pada pembuatan segment seperti pembatasan sudut segment, 
panjang dll. 

2. Kombinasi tombol Ctrl + Z dapat digunakan untuk menghapus verteks terakhir 
pada garis sketsa atau mengulang operasi editing terakhir yang dilakukan. 

3. Unit yang digunakan pada saat editing adalah Map Unit yang bergantung pada 
sistem koordinat data frame yang digunakan, jadi walaupun layer yang diedit 
memiliki unit meter (mis : UTM), namun koordinat sistem data frame yang 
digunakan adalah koordinat Geografis yang memiliki unit Desimal Degree, maka 
nilai input yang diisikan haruslah nilai Desimal degree. Properti map unit dapat 
dilihat pada kotak dialog Data Frame Properties. 

4. Pada tool-tool yang membutuhkan nilai input, biasanya telah terdapat nilai yang 
menunjukkan posisi mouse pointer pada saat klik kanan dan format input yang 
valid. Nilai dapat digunakan sebagai acuan dalam memasukkan nilai yang 
diinginkan. 

 
3.4.3.3 Membuat Segment dengan Menggunakan Parameter Arah dan Panjang  

Garis Untuk membuat segmen sketsa berdasarkan parameter arah dan 
panjang garis gunakan langkah-langkah sebagai berikut : 

 
1. Setelah membuat paling tidak 1 titik vertex, pilih sketch tool dari Sketch 

Construction Tool Palette 
2. Klik kanan pada map area sehingga muncul menu popup, kemudian pilih 

Direction. 
3. Isilah nilai sudut yang diinginkan kemudian tekan Enter 
4. Oleh ArcMap arah segment kemudian dibatasi sesuai dengan input yang 

diberikan. 
5. Klik kanan kembali pada map area sehingga muncul menu popup, kemudian pilih 

Length. 
6. Isilah nilai panjang segment yang diinginkan kemudian tekan Enter 
7. ArcMap selanjutnya menggambar segmen pada arah dan panjang yang 

diinginkan. 
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3.4.3.4 Membuat Segment dengan menelusuri fitur yang telah ada 
 
1. Pilihlah fitur yang hendak ditelurusi. Indikator fitur terpilih akan segera terlihat. 

Fitur yang dipilih tersebut tidak harus berada pada workspace yang diedit, namun 
layernya harus dapat dipilih (selectable layer) 

2. Dari tool pembentuk sketsa, pilihlah Trace Tool. Tool ini hanya aktif untuk layer 
target garis atau poligon. 

3. Klik titik awal penelusuran pada fitur yang terpilih 
4. Tekan tombol O untuk memberikan nilai offset, jika mengginginkan segmen yang 

terbentuk tepat berimpit dengan fitur terpilih masukkan nilai 0. Nilai negatif (-) 
menunjukkan bahwa penelusuran dilakukan pada sisi yang berlawanan dari nilai 
positif (+). Klik Ok untuk menutup kotak dialog Trace Option tersebut. 

5. Telusurilah fitur terpilih dengan menggerakkan mouse mengikuti bentuk fitur. 
ArcMap memperlihatkan petunjuk visual segmen yang terbentuk. 

6. Klik pada titik akhir penelusuran. 
7. Segmen sketsa baru segera terbentuk berdasarkan fitur terpilih. 
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3.4.4 Tombol Pintas (keyboard shorcuts) 
 
Pada proses editing terdapat banyak tombol pintas yang diasosiasikan dengan 
perintah-perintah editing tertentu. Adanya tombol-tombol pintas ini terasa sangat 
membantu dalam meningkatkan kinerja dan produktifitas pengeditan. Tombol pintas 
yang standar dapat anda lihat pada lampiran manual ini.. Tombol pintas tambahan 
juga dapat ditentukan sendiri melalui menu View > Toolbar > Customize. 
 
Mode Editing Tombol Keyboard Aksi Keterangan 
Umum    
 Z Zoom in  
 C Pan  
 X Zoom out  
 V Show Vertices Memperlihatkan 

vertex dari fitur 
 E Toggle Edit Tool Berpindah mode 

editing (seleksi, 
annotasi dan sketsa) 

 Esc Cancel  
 Ctrl + Z Undo  
 Ctrl + Y Redo  
 Spacebar (tombol 

spasi) 
Suspend Snapping Tekan sambil tahan 

tombol spasi untuk 
menghentikan 
sementara fasilitas 
snapping. 

 F5 Refresh Mengupdate tampilan 
layar. 

Seleksi dengan 
Edit Tool 

   

 Shift Add/Remove 
Selection 

Menambah dan 
Mengurangi fitur 
terpilih 

 Ctrl Move selection 
anchor 

Memindahkan ttk 
Jangkar fitur terpilih 

Sketsa    
 Ctrl + A Direction Arah, menunjuk pada 

jurusan, 
menggunakan Sistem 
arah yang ditentukan 
pada setting Editor > 
Option 

 Ctrl + F Deflection  
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Mode Editing Tombol Keyboard Aksi Keterangan 
 Ctrl + L Length Menentukan panjang 

sketsa secara 
spesifik  

 F6 Absolute X,Y Memasukkan nilai 
koordinat vertex 
berikutnya. (nilai 
mutlak) 

 Ctrl + D Delta X, Y Memasukkan vertex 
berikut dari garis 
sketsa dengan jarak 
X dan Y yang relatif 
dari titik verteks 
terakhir. 

 Ctrl + G Direction/Length Menentukan posisi 
vertex sketsa 
berikutnya dengan 
memasukkan 
parameter Jurusan 
(arah) dan Jarak, 
sering disebut sistem 
koordinat polar atau 
koordinat kutub. 

 Ctrl + P Parallel Membuat segment 
yang paralel/sejajar 
dengan segment lain. 

 Ctrl + E Perpendicular Membuat segment 
yang tegak lurus 
terhadap segment 
lain. 

 F7 Segment Deflection Membuat segment 
yang memiliki sudut 
defleksi tertentu 
terhadap segment 
lain. 

 Ctrl + T Tangent curve  
 F8 Streaming Memulai dan 

mengakhiri mode 
streaming pada garis 
sketsa. 

 Ctrl + Delete Delete Sketch Menghapus garis 
sketsa 

 F2 Finish Sketch Mengakhiri sketsa 
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Mode Editing Tombol Keyboard Aksi Keterangan 
 T Show Tolerance Memperlihatkan 

Toleransi Snapping 
 
3.4.5 Pengaturan Sistem Koordinat dan Proyeksi 

Didalam ArcMap terdapat 2 tingkatan Penggunaan Sistem Koordinat, Tingkatan 
tertinggi berada pada level dataframe sedangkan tingkatan terendah berada pada 
level layers. Pada proses penampilan data spasial, apabila terdapat perbedaan 
sistem koordinat pada kedua level tersebut maka level layer akan diproyeksikan 
secara on the Fly terhadap level Dataframe. Untuk mendapatkan akurasi geometri 
yang terbaik pada saat melakukan pengeditan maka sebaiknya kedua level sistem 
koordinat tersebut disamakan dengan cara mengubah sistem koordinat Data Frame 
mengikuti sistem koordinat Layer sebagai berikut : 
 

1. Klik Ganda DataFrame sehingga Kotak Dialog Data Frame Properties 
muncul. Alternatif lain adalah dengan melakukan Klik kanan pada Data Frame 
kemudian memilih menu Properties 

2. Selanjutnya klik Tab Coordinate Systems 
3. Pada kotak pilihan Select a Coordinate System Pilihlah folder layers, 

selanjutnya pilih coordinat system layer yang hendak diedit. Klik Ok untuk 
menutup kotak dialog Data Frame Properties. 
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3.4.6 Pengesetan Sistem Pengukuran (Arah dan Unit) 
 
Pada proses editing, terdapat beberapa tool yang membutuhkan parameter arah dan 
system pengukuran. Parameter yang digunakan dalam ArcMap adalah sebagai 
berikut: 
 
A. Direction Measuring System (Sistem Arah) 

 
Terdapat 4 jenis direction system yang dapat digunakan  
 

1. Polar Angle, adalah sistem arah yang titik 00 dimulai dari timur dan 
pertambahan positip sudutnya bergerak berlawanan arah jarum jam (counter 
clockwise) 

2. Quadrant Bearing, adalah sistem arah yang besar sudutnya selalu dihitung dari 
garis meridian, Utara maupun Selatan kearah Timur maupun Barat. Sistem ini 
selalu mencantumkan 2 Karakter penunjuk referensi yang mengapit nilai besar 
sudutnya, dimana karakter 1 (Utara atau Selatan) menunjuk pada posisi titik 0 
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derajat ssedangkan karakter akhir (Timur atau Barat) menunjuk pada arah 
pengukuran sudut. Contoh, U 22° B menunjukkan arah 22° dari Utara kearah 
Barat. 

3. North Azimuth, adalah adalah sistem arah yang titik 00 dimulai selalu dari Utara 
dan pertambahan positip sudutnya bergerak searah jarum jam (clockwise). 

4. South Azimuth, adalah adalah sistem arah yang titik 00 dimulai selalu dari 
Selatan dan pertambahan positip sudutnya bergerak searah jarum jam 
(clockwise). 

Secara standar, sistem arah yang digunakan oleh ArcMap adalah Polar Angle. 

 
B. Direction Measuring Unit 

Unit yang digunakan dalam pengukuran arah adalah : 

1. Degrees, sering juga disebut desimal degree dan merupakan standar yang 
digunakan ArcMap dimana 1(satu) degrees setara dengan 1/360 lingkaran, 
fraksinya dinyatakan dalam desimal. 

2. Degree Minutes Seconds (DMS), hampir sama dengan Degrees, hanya fraksinya 
yang dinyatakan dalam bilangan Menit (minutes) dan Detik(seconds), dimana 1 
menit setara dengan 1/60 degree dan 1 detik setara dengan 1/60 menit. 
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3. Radians, adalah unit Standar Internasional untuk pengukuran sudut bidang datar. 
1 radian kurang lebih setara dengan 57,296 degree. 

4. Gradians, adalah unit pengukuran yang membagi satu kuadran lingkaran kedalam 
100 bagian, jadi 1 lingkaran yang terdiri dari 4 kuadran setara dengan 400 
gradians. 

5. Gon, Sama dengan gradian. Istilah ini digunakan pada beberapa negara seperti 
Jerman dan Swedia dimana istilah unit gradian menunjuk pada unit degrees. 
 

Adapun langkah yang dilakukan untuk mengubah unit dan sistem pengukuran 
adalah melalui Toolbar Editor sebagai berikut : 
 

1. Klik Editor pada toolbar editor 
2. Klik Option dari daftar menu yang muncul. 
3. Pada kotak dialog Editing Options, klik Units 
4. Pilih direction type dan direction unit dari kotak yang pilihan 
5. Klik Ok untuk mengakhiri sesi pengesetan dan mengaplikasikan pilihan 

tersebut. 

 
 
3.4.7 Memulai dan Menghentikan Sesi Pengeditan 

1. Dari toolbar Editor, klik tombol Editor , 
2. Klik Start Editing 
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3. Bila Data yang ada dalam Arcmap terdiri atas beberapa workspace, maka kotak 
dialog konfirmasi pemilihan workspace yang diedit akan muncul. Pada kotak 
dialog ini pilihlah workspace yang menyimpan layer yang hendak di edit. 

4. Klik Ok. 

 
5. Selanjutnya ArcMap segera mengaktifkan status editing data. Hal ini ditandai 

dengan aktifnya tombol-tombol yang ada pada toolbar editing. 
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6. Untuk menyimpan hasil editing klik Editor pada toolbar editor, kemudian pilih 
menu Save Edit. Pilihan ini menyimpan hasil editing dengan tetap berada pada 
mode editing. 

7. Untuk menghentikan mode editing klik Editor pada toolbar editor, kemudian pilih 
menu Stop Editing. Kotak dialog konfirmasi penyimpanan selanjutnya ditampilkan, 
klik pada pilihan yang diinginkan dan Arcmap akan mengakhiri sesi editing. 

 
 
3.4.8 Snapping 

Snapping adalah salah satu fasilitas editing ArcMap yang memegang peranan 
penting dalam menghasilkan output editing yang akurat dengan cara mengatur 
perilaku sketsa. 
 
A. Type Snapping 

 
Pada proses editing fasilitas snapping dapat diberlakukan berdasarkan layer, sketsa 
atau topologi. Berdasarkan dasar inilah tipe snapping dibedakan atas layer 
snapping, sketch snapping dan topology snapping. Penentuan properti snap yang 
diaktifkan diatur dalam kotak dialog snapping environment Window. Berikut ini 
adalah properti snapping berdasarkan tipenya : 
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B. Snapping Environment Window 

 
Kotak dialog ini dapat diakses melalui menu Editor pada Toolbar Editor dan hanya 
bisa diakses dalam mode editing. 
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C. Mematikan fasilitas snapping 

1. Untuk mematikan fasilitas snapping secara sementara tekan tombol “Spasi” 
(SPACEBAR) pada keyboard sambil melakukan editing. Snapping akan 
kembali aktif segera tombol tersebut dilepas. 

2. Untuk mematikan fasilitas snapping secara tetap, bersihkan tanda centang 
yang ada pada kotak dialog Snapping Environment. 

D. Snapping to Feature Command 
Pada saat pembuatan sketsa, terdapat juga bantuan snapping yang dapat diakses 
melalui klik kanan pada fitur lain yang telah ada sehingga muncul pop up menu. 
Berikut adalah tipikal urutan penggunaan perintah tersebut : 

1. Dengan menggunakan salah satu tool sketsa, klik kanan pada fitur eksisting 
2. Pada pop up menu yang muncul, sorot menu snap to feature, selanjutnya pilih 

tipe snapping yang diinginkan 
3. Verteks sketsa yang terbentuk akan segera di-Snap sesuai dengan tipe 

snapping yang dipilih. 
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3.4.9 Pemilihan Fitur 

Dalam konsep editing fitur eksisting di ArcMap, sebagian besar operasi editing 
diawali dengan pemilihan fitur. Terdapat banyak metode pemilihan fitur, antara lain : 
 
A. Pemilihan dengan menggunakan Edit Tool 

1. Klik Edit Tool pada Toolbar Editor. Tool ini hanya aktif dalam mode editing 
2. Klik Fitur yang hendak dipilih. Bila terdapat banyak layer yang dapat dipilih 

fiturnya (selectable layer) dan pemilihannya dengan klik tunggal, maka fitur 
pada layer terataslah yang terpilih, sebaliknya jika pemilihannya adalah tipe 
persegi (menekan tombol mouse sambil menyeret kemudian melepasnya), 
maka fitur tepilih adalah semua fitur yang memiliki interseksi dengan kotak 
tersebut dari semua layer terpilih. 

3. Untuk memilih banyak fitur gunakan tombol “SHIFT” sambil menggunakan Edit 
Tool untuk Pemilihan. 

4. Fitur yang terpilih kemudian memiliki indikator pemilihan (highlighted). 
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B. Pemilihan dengan menggunakan Sketsa 
Pemilihan dapat juga dilakukan dengan menggunakan garis sketsa dengan 
mengatur pilihan tugas pada Kotak Daftar Tugas yang dilanjutkan dengan membuat 
garis sketsa. Pada kotak Daftar Tugas terdapat dua opsi pemilihan fitur : 

1. Select Fitur by Line, pilihan menggunakan metode pemilihan garis; dimana fitur 
yang bersinggungan dengan garis sketsa tersebut akan menjadi terpilih setelah 
sketsa diakhiri. Untuk mengakhiri pembuatan sketsa, gunakan shorcut F2 pada 
keyboard. 

2. Select Fitur by Area adalah metode pemilihan poligon yang memilih fitur yang 
bersinggungan dengan poligon sketsa atau yang berada dalam wilayah poligon 
sketsa. 

 
Metode pemilihan berdasarkan sketsa memiliki urutan sebagai berikut : 

1. Aktifkan sesi editing jika belum aktif 
2. Dari kotak Daftar tugas pada toolbar editor pilihlah bentuk penugasan seleksi 

yang sesuai 
3. Dengan menggunakan Skech Construction Tool buatlah garis/poligon sketsa 

pemilihan 
4. Hentikan pembuatan sketsa dengan menekan tombol F2 pada keyboard atau 

dengan klik kanan kemudian memilih menu Finish Sketch. 
5. Fitur selanjutnya akan terpilih. 
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C. Pemilihan dengan menggunakan Attribut Data dan Lokasi 

Metode pemilihan fitur eksisting yang lain adalah dengan menggunakan attribut 
data. Metode ini dapat diakses melalui menu Selection pada Main Menu Bar. 

 
D. Membebaskan Fitur Terpilih 

Untuk membebaskan fitur terpilih, Klik Menu Selection pada Main Menu, 
selanjutnya klik pada menu Clear Selected Features atau menekan tombol 
kombinasi tombol Control, tombol Alternative dan tombol A secara bersamaan 
(Ctrl + Alt + A). 
 

E. Menentukan Layer yang dapat dipilih. 
Pada saat editing data yang menggunakan banyak layer penggunaan fasilitas ini 
sangat membantu dalam mengurangi kemungkinan kesalahan pemilihan. Untuk 
mengatur Layer yang dapat dipilih, gunakan menu Selection > Set Selectable 
Layer. Berilah tanda centang pada layer yang dapat dipilih. 



148 
 

 
Khusus untuk ArcGIS 9.x pengaturan ini juga dapat dilakukan dengan mengklik tab 
Selection pada bahagian bawah Table of Contents. Window Table of Content dapat 
diaktifkan melalui menu Window > Table of Contents. Untuk 
membersihkan/mengaktifkan tanda centang tekan tombol Ctrl sambil melakukan klik 
kiri pada kotak kecil yang ada di depan nama layer. 

 
Hal ini terasa lebih memudahkan pada saat editing, karena pada tab tersebut juga 
terdapat informasi jumlah fitur yang terpilih pada masing-masing layer. Klik kanan 
pada nama layer untuk mengakses menu-menu tambahan yang tersedia. 
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3.4.10 Memindahkan Fitur 

1. Pilih fitur yang akan dipindahkan 
2. Dengan menggunakan Edit Tool, gerakkan pointer mouse hingga ikonnya 

memiliki tanda + ( ) Bila tanda tersebut tidak muncul kemungkinan 
penyebabnya adalah bahwa layer yang memiliki fitur tersebut tidak berada dalam 
workspace yang sedang di edit walaupun fiturnya dapat dipilih. 

3. Tekan mouse sambil seret (drag) mouse ke lokasi yang diinginkan. Selama 
mouse masih ditekan, fitur yang diseret akan terlihat garis outline dan bordernya 
yang berbentuk persegi (envelope) untuk memberikan panduan visual selama 
proses drag fitur. Gunakan tombos Escape (Esc) pada keyboard untuk 
membatalkan proses ini. 

4. Lepas tekanan pada mouse dan fitur yang terpilih akan berpindah. 
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3.4.11 Copy & Paste Fitur 

1. Pilih fitur yang hendak dicopy 
2. Dari toolbar standar, klik icon Copy atau dengan shorcut Ctrl + C. Icon ini akan 

aktif bila ada fitur yang terpilih. 
3. Kemudian klik icon Paste. Fitur akan digandakan tepat pada lokasinya semula 

dan berada pada layer target 
4. Perintah ini juga dapat diakses dengan klik kanan pada Map Area. 
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3.4.12 Menghapus Fitur 

1. Pilih fitur yang hendak dihapus 
2. Dari toolbar standar, klik icon delete yang akan aktif bila ada fitur yang terpilih. 

Cara lain adalah dengan memilih menu Delete setelah melakukan klik kanan pada 
Map Area. Secara praktis dapat juga dilakukan dengan menekan tombol Delete 
pada Keyboard. 

3. Fitur yang terpilih kemudian dihapus. 

 
 
 
3.5. MEMBUAT FITUR BARU 

3.5.1 Membuat Fitur Titik 

Pembuatan fitur baru diawali dengan pemilihan target layer yang bertipe Point dan 
dilanjutkan dengan membuat titik sketsa dengan menggunakan sketch contruction 
tool. 



152 
 

1. Dari kotak daftar tugas pada toolbar editor, pilihlah bentuk penugasan “Create 
New Feature” 

2. Dari kotak target pada toolbar editor, Pilihlah target layer. Tipe layer target harus 
yang berupa layer titik. 

3. Dengan menggunakan skecth construction tool, klik pada lokasi yang diinginkan. 
4. Bila fitur titik yang akan dimasukkan diketahui posisi geografisnya, klik kanan 

pada map area, kemudian pilih menu Absolute X,Y (shorcutnya adalah F6). 
5. Pada Kotak input yang muncul, isikan nilai koordinat titik yang hendak 

dimasukkan 

 
 
3.5.2 Membuat Fitur Garis dan Poligon 

Untuk membuat fitur garis dan poligon, langkahnya sama dengan membuat fitur titik. 
Perbedaannya hanya pada tipe target layer dan bentuk sketsa. Gunakan shorcut F2 
atau klik ganda pada verteks terakhir untuk mengakhiri sesi sketsa sekaligus 
membuat fitur baru berdasarkan garis sketsa yang terbentuk. 
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3.6. Penyesuaian Spasial (Spatial Adjustment) 

3.6.1. Pengertian Spatial Adjustment 

Adalah proses pembetulan data spasial agar sesuai/mendekati karakteristik data 
yang benar sesuai dengan kaidah GIS data dan logika kebenaran data dan 
informasi. Proses Spatial Adjustment bisa berupa : 
 

• Transformasi 
• Penarikan obyek (rubber sheet) 
• Penyesuaian obyek pada batas tepi peta (edgematching) 

 
3.6.1.1 Transformasi 

Adalah salah satu tool dalam lingkup Spatial Adjustment yang berfungsi untuk 
mentransform (merubah nilai koordinat) dari suatu feature sehingga akan 
menghasilkan feature yang baru dengan koordinat yang berbeda dengan koordinat 
aslinya, sedangkan bentuk dari feature itu endiri akan dipertahankan sesuai aslinya. 
Transformasi memerlukan paling tidak 4 (empat) titik awal dan 4 (empat) titik target. 
Semakin banyak jumlah titik sekutu akan semakin baik hasil yang dicapai. 
Tahapan transformasi adalah sbb: 
ArcMap -> Add Data 

 
Klik Editor-> Start Editing 
Klik Editor->Option�masukan snapping tolerance, lakukan pengukuran jarak terlebih 
dulu untuk menentukan snapping tolerance nya. 
Klik Editor->Snapping, check semua checkbox yang ada 
Klik Spatial adjustmen, pilih Transfomasi Affine 
Klik Spatial Adjustmen->Set Adjust Data, check data yg akan ditransformasi 
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Create link transformasi: 

 
 
 
Klik Links ->View link table utk melihat nilai titik sekutu transformasi 
Klik Adjust->Finish: 
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3.6.2 Membuat link table: 

Parameter nilai koordinat transformasi dapat dibuat dengan membuat table koordinat 
sekutu pada text file (Notepad). 
Formatnya adalah sbb: 

 
 
Anda tidak perlu menuliskan judul table. File ini akan disimpan format txt file, dan 
digunakan dalam proses transformasi dengan cara memanggil fie tsb dengan 
mengklik ->links->open links file 
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3.6.3 Rubbersheeting Vs Edgematching 

Rubbersheeting bisa merubah bentuk di semua segment line, bisa dilakukan multiple 
links untuk menambah akurasi feature. 
Edgematching akan merubah/mempengaruhi vertex terakhir dari segment line saja 
Rubbersheeting : bisa dilakukan pembatasan pada area mana akan dilakukan 
justifikasi. 
A. RUBBER SHEETING : 

1. Proses Rubber Sheeting 
ArcMap, Add data 
Editor -> Start Editing 
Editor->Option, snapping tolerance 
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Editor�Snapping, check vertex, edge, end checkbox 
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Klik Spatial Adjustment ->Rubbersheeting 
Klik Spatial Adjustment ->Adjust Data, check peta2 (source) 

 
Klik Spatial Adjustment ->Option 
Pilih source dan target layer 
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Klik Link, created 4 link 
Buat limit area 
Adjust 
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B. EDGEMATCING 

Proses Edgematching 
ArcMap, Add data 
Editor -> Start Editing 
Editor->Option, snapping tolerance 
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Editor->Snapping, check vertex, edge, end checkbox 
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Klik Spatial Adjustment ->Edge Snap 
Klik Spatial Adjustment ->Adjust Data, check peta2 (source) 
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Klik Spatial Adjustment ->Option 
Pilih source dan target layer 

 
Klik Link, created 4 link 
Adjust 
Finish 
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3.6.4 Memakai Fungsi Transfer Attribut Pada Spatial Adjustment Pada ArcMap 
 

• Add data, misalnya peta1 dan peta2 
Lakukan Editing Table agar ada kesesuaian field antar keduanya. 

• Start Editing 
Editor Option, isi Snapping Tolerance missal 0.0001map units 
Spatial adjustment, klik Option: 
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• Pilih Source dan Target layer, check Use Attributes, klik Attributes 

 
• Pilih Field yg berkesesuaian atau akan disesuaikan nilai attributenya, klik 

Add�Ok. 
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• Klik Attribute transfer tool 

 
• Klik satu kali pada Source layer dan arahkan ke layer target klik satu 

kali�Finish. 
• Check apakah attribute sudah sesuai, klik kanan pada layer target open 

attribute. 
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Pada prinsipnya Field antar layer akan sama karena masih dalam satu feature class, 
tetapi dimungkinkan ada kesalahan/tidak matching dalam nilai attributenya. 
 
3.7. Membangun Topology 

Topology adalah pendefinisian secara matematis yang menerangkan hubungan 
relative antara objek yang satu dengan objek yang lain. Dalam GIS topology 
didefinisikan oleh user sesuai dengan karakteristik data seperti line, polygon maupun 
point/titik. Setiap karakteristik data tertentu mempunyai rule/aturan tertentu. Rule 
atau aturan tersebut secara default telah disediakan oleh software GIS. 
 
Sebagai contoh untuk objek type polygon aturan yang umum di berlakukan adalah : 
 
1. Antar Polygon tidak boleh saling bertampalan. 
2. Antar Polygon tidak boleh ada celah (gap). 
 
3.7.1 Langkah-Langkah Topology 

Untuk memulai membangun topology dengan menggunakan ArcGIS 9.x dapat 
dilakukan tahapan-tahapan sebagaimana berikut. 
 
3.7.1.1 Menentukan direktori kerja 

Hal ini dilakukan untuk memudahkan kita dalam pengelolaan dan penempatan data-
data yang akan dibangun seperti berikut . 
 



170 
 

1. Buat direktori ArcLatihan pada windows explore yang akan kita gunakan 
sebagai tempat penyimpanan data seperti pada gambar a. 

2. Pilih ArcMap pada program ArcGIS kemudian klik menu bar ArcCatalog 
seperti pada gambar b. 

 
 

3. Selanjutnya akan tampil jendela kerja ArcCatalog seperti gambar dibawah, 
untuk membangun topology langkah-langkahnya seperti pada gambar berikut 
: 
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4. Pada Content personal geodatabase ketik RiauWGS84 yang merupakan 

system proyeksi yang akan digunakan dalam direktori kerja kita. Kemudian 
pada direktori tersebut klik kanan pilih Feature dataset… seperti gambar 
berikut. 
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5. setelah muncul menu New Feature…. Ketik Topology pada Name, klik Edit 
akan muncul kotak dialok Spatial Reference Properties Klik select kemudian 
pilih Coordinate System seperti pada gambar berikut 
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6. Pada kotok dialok Browse for dataset akan muncul pilihan system koordinat. 
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7. Setelah memilih system koordinat yang akan digunakan dalam latihan ini, 
maka pada kotak dialok Feature dataset akan muncul Deskripsi coordinate 
system Seperti pada gambar berikut. 
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8. Selanjutnya akan muncul Featuredataset didalam Geodatabase RiauWGS84 

dengan nama Topology . Tahap selanjutnya adalah mulai bekerja dengan 
membangun topology seperti pada gambar berikut. 

 
9. Lakukan import data dari direktori sumber data atau server seperti pada 

gambar berikut : 
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10. Kemudian pilih data yang akan di input misalnya penggunaan lahan seperti 

pada gambar berikut : 

 
11. Masukan input data 
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12. Hasil proses geodatabase untuk topology pada penggunaan lahan 
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3.7.2 Membangun Topology pada Geodatabase 

Untuk topology data penggunaan lahan ataupun data-data lainya, jendela ArcMap 
terlebih dahulu di tutup kemudian proses topology dapat dilakukan pada ArcCatalog 
seperti gambar dibawah. 

 
Akan muncul kotak dialog New topology kemudian klik next 
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Di sini akan muncul kotak dialog yang mengahruskan kita untuk melakukan 
pemilihan (pengaktifan) feature yanag akan dilakukan topology dan pemilihan rule 
yang akan dipakai terhadap feature tsb. 

 
Pada tampilan selanjutnya akan muncul list rule yang bias kita pilih sesuai 
karakteristik datanya. 
Rule yang dipilih bias lebih dari satu sesuai dengan karakteristik data yang akan 
diterapkan topology. 
Lihat ilustrasi berikut ini: 
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Untuk data penggunaan lahan berupa polygon dapat kita terapkan dua aturan (rule) 
yaitu: 
 
1. Must Not Overlap dan 
2. Must Not Gap 

 
Pilih rule yang ke_2 seperti gambar berikut: 

 
Sehingga akan muncul kotak dialog yang menapilkan ke-2 rule sebagai berikut : 
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Proses validating Topology : 

 

 
 
3.7.3 Editing Topology pada ArcMap 

Untuk memulai pengeditan topology langkah awal adalah klik ArcMap untuk 
menjalankan proses pengeditan polygon-polygon yang terdapat pada spatial data 
yang terdapat di geodatabase seperti pada gambar berikut. 
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Pilih feature yang memiliki kesalahan topology (warna merah tua) setelah feature 
yang di select/pilih menjadi warna hitam kemudian klik kanan. Untuk melakukan 
koreksi data pilih salah satu feature seperti pada gambar berikut. 

 

 
 



185 
 

BAB IV : APLIKASI SISTEM INFORMASI GEOGRAFIS 

Untuk bagian ini akan disampaikan beberapa tulisan yang dapat menggambarkan 
aplikasi sistem informasi geografis dibidang yang terkait dengan kehutanan dalam 
arti luas.  Tulisan-tulisan yang kami sampaikan ini hanya merupakan beberapa 
contoh yang dapat diunduh secara gratis di Internet.  Diharapkan mahasiswa dapat 
memperkaya wawasannya dengan mencari lebih banyak contoh-contoh yang ada. 
 
4.1 Perkembangan Pemanfaatan Aplikasi Sistim Informasi Geografis untuk 

pengelolaan hutan 
 
Tulisan ini disampaikan oleh Belinda Arunarwati dan Lely Rulia Siregar.  
Selengkapnya isi tulisan ini adalah sebagai berikut. 
 
4.1.1.  Pendahuluan 

Pengelolaan sumber daya hutan merupakan tugas dan tanggung jawab Departemen 
Kehutanan. Dalam pelaksanaannya, tugas dan tanggung jawab tersebut perlu 
didukung suatu prakondisi pengelolaan hutan di Indonesia yang mantap, antara lain 
melalui tersedianya data dan informasi sumber daya hutan yang akurat, terintegrasi, 
dan mutakhir. Badan Planologi Kehutanan selaku salah satu unit kerja dalam 
Departemen Kehutanan berwenang dan bertanggung jawab untuk mengelola data 
dan informasi sumber daya hutan. 
 
Data sumber daya hutan bersifat dinamis dan berubah sesuai dengan kebutuhan 
dan waktu. Data ini terbagi dalam dua kategori utama yaitu bersifat keruangan 
(spasial) dan berupa angka atau keterangan (non spasial). Mengingat volume data 
yang besar dan adanya tuntutan untuk selalu memutakhirkan sesuai dengan 
perubahan dan kebutuhan yang terjadi, serta konsistensinya, maka pengelolaan 
data sumber daya hutan di Departemen Kehutanan telah dilakukan dengan 
memanfaatkan teknologi Sistem Informasi Geografis (SIG). 
 
Dengan latar belakang perlunya informasi mengenai perkembangan aplikasi SIG di 
Departemen Kehutanan dalam kaitannya dengan kemampuan untuk mengatasi 
berbagai permasalahan yang dihadapi, maka makalah ini disusun dengan 
membahas kondisi dan arah pengembangan sistem informasi geografis di bidang 
kehutanan.  
 
4.1.2 SIG untuk pengelolaan hutan 

A. Aplikasi SIG 

Pembangunan SIG di lingkup Departemen Kehutanan telah dimulai pada awal 1989 
dengan dilaksanakannya proyek Inventarisasi Hutan Nasional (NFI). Optimalisasi 
pemanfaatan perangkat SIG telah dilakukan untuk hal-hal sebagai berikut : 
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o Penyusunan Basis data spasial kehutanan 

Seluruh data digital spasial dikelola secara sistematis dalam bentuk library 
dengan unit akses (tile) propinsi, sehingga akses terhadap data dapat 
dilakukan dengan mudah dan cepat. Melalui Jaringan lokal yang ada data 
tersebut dimungkinkan untuk diakses dari tempat lain di lingkup intern 
departemen. Data dalam library selengkapnya adalah sebagai berikut : 
a. Informasi dasar dalam arti umum : batas perairan dan daratan, jaringan 

jalan, jaringan sungai, anotasi, kontur dan administrasi propinsi dan 
kabupaten 

b. Informasi dasar kehutanan : fungsi kawasan, penutupan lahan dan Daerah 
Aliran Sungai (DAS) 

c. Informasi tematik kehutanan ; Hak Pengusahaan Hutan (HPH), Hutan 
Tanaman Industri (HTI), Pelepasan kawasan untuk budidaya pertanian, dan 
transmigrasi 

d. Kondisi fisik lahan : Jenis tanah, Sistem lahan. 
o Monitoring  

Sebagian besar dari data tersebut pada point 1 merupakan data yang cepat 
perubahannya sehingga secara teratur dilakukan updating guna menyajikan 
informasi yang selalu terkini. Oleh karena itu beberapa data tersedia secara 
time series sehingga dimungkinkan untuk dilakukan monitoring untuk 
mengetahui perubahan yang telah terjadi dan kecenderungan perubahan yang 
akan terjadi. Contoh monitoring yang dilakukan adalah terhadap penutupan 
lahan 1990, 1997 dan 2000, sehingga diketahui perubahan penutupan lahan 
berhutan per tahun pada setiap propinsi. 

o Pengambilan keputusan 
a. Penentuan kawasan 

Pada waktu yang lalu penentuan fungsi kawasan sudah dilakukan dengan 
menggunakan SIG walaupun masih sangat sederhana, yaitu dengan 
menumpangsusunkan peta dan penghitungan dilakukan dengan kalkulator. 
Pada saat ini penentuan kawasan dilakukan melalui kegiatan overlay data 
tanah, lereng dan curah hujan. Analisa dilakukan secara komprehensif, 
karena tidak hanya sekedar mengoverlaykan peta tersebut tetapi juga 
menganalisasi secara numerik dengan memberikan kelas dan pembobotan 
untuk sampai pada fungsi kawasan. 

 
b. Rehabilitasi kawasan hutan dan lahan 

Kawasan hutan dan lahan yang perlu dilakukan rehabilitasi diperoleh melalui 
analisa spasial (overlay) kawasan hutan, kelompok penutupan lahan, 
prioritas dari suatu das dan batas administrasi, sehingga diperoleh informasi 
luas dan penyebaran kawasan yang harus direhabilitasi pada suatu 
kabupaten ataupun propinsi diseluruh Indonesia. 
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o Modelling 
Kegiatan modeling dilakukan untuk kebakaran hutan dengan mengambil lokasi 
di propinsi Kalimantan Timur. Modelling tingkat kerawanan kebakaran hutan 
tersebut disusun dengan pertimbangan bahwa propinsi tersebut mempunyai 
sejarah kebakaran hutan yang terburuk di Indonesia. Kriteria yang 
dipertimbangkan dalam pembuatan model ini adalah sebaran titik api (hot 
spot), kawasan hutan dan perkembangan tata batasnya, penutupan lahan 
dengan NDVI, serta penggunaan lahan (HPH, HTI, pelepasan untuk kebun dan 
transmigrasi). Pada waktu yang lalu kegiatan ini memang mendapat porsi yang 
sedikit, karena sebagian besar waktu, biaya dan tenaga tercurah untuk 
menyusun basis data, dan bagaimana mengoptimalkan data yang ada untuk 
menyelesaikan masalah di kehutanan.  

 
 
B.  Pengembangan kebijakan 

Kegiatan pengelolaan sistem informasi geografis Departemen Kehutanan 
dilaksanakan oleh masing-masing unit eselon I teknis. Meskipun demikian 
mengingat tugas dan wewenang serta tingkat pengembangannya yang telah dimulai 
lebih awal yaitu dengan adanya proyek NFI maka pengembangan SIG di 
Departemen Kehutanan lebih dipusatkan di Badan Planologi Kehutanan. Selain itu 
sesuai dengan tugas dan kewenangannya, unit pengelola SIG di Badan Planologi 
Kehutanan akan terus dikembangkan sebagai pusat/simpul data spasial kehutanan.  
 
Dimasa mendatang pusat/simpul data tersebut tidak hanya melayani kebutuhan 
akan informasi kehutanan lingkup departemen, akan tetapi juga untuk memenuhi 
kebutuhan antar instansi diluar departemen. Dengan demikian Badan Planologi 
Kehutanan dapat berperan sebagai salah satu simpul jaringan SIGNAS yang 
berwenang sebagai pusat dan “clearing house” data dan informasi kehutanan. 
 
Sampai dengan akhir tahun 1999, masing-masing eselon I teknis Departemen 
Kehutanan telah membangun SIG dan memanfaatkannya sesuai dengan 
permasalahan yang dihadapi. Aplikasi pemanfaatan SIG boleh berbeda (sesuai 
dengan tupoksi) tetapi data dasar yang digunakan harus sama, sehingga pada 
waktunya akan diintegrasikan tidak menjadi masalah. Tahun 2000 semakin gencar 
pembangunan dan penyempurnaan SIG daerah, khusus Badan Planologi 
Kehutanan melalui Balai Inventarisasi dan Perpetaan Hutan (BIPHUT : ada 10 
BIPHUT untuk seluruh Indonesia) dan Sub BIPHUT (yang tersebar diseluruh 
propinsi) pada waktu Itu. Kebijaksanaan pembangunan GIS daerah tersebut sejalan 
dengan rencana kebijakan otonomi daerah, dimana diharapkan setiap unit pengelola 
GIS daerah, terutama BIPHUT dan Sub BIPHUT dapat berperan sebagai 
perpanjangan Badan Planologi di daerah dalam fungsi sebagai pusat dan "clearing 
house" data dan informasi kehutanan.  
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Sebagai tindak lanjut peran “clearing house” tersebut Badan Planologi Kehutanan 
telah menyampaikan data dasar digital kepada seluruh unit pengelola SIG di pusat 
dan daerah, dengan tujuan agar data tematik yang dihasilkan oleh masing-masing 
unit pengelola SIG tersebut, mempunyai keseragaman atau dasar yang sama. 
 
 
C. Kebijakan Otonomi Daerah 

Dengan berlakunya kebijakan otonomi daerah, terjadi perubahan organisasi di 
daerah yang sangat berpengaruh pada rencana pembangunan SIG daerah 
sebagaimana yang telah disusun. Sub BIPHUT yang tersebar diseluruh propinsi, 
ada yang lebur dan bergabung dengan dinas kehutanan propinsi, ataupun dengan 
dinas kehutanan kabupaten. Sedangkan 10 BIPHUT yang ada berubah menjadi 
BPKH (balai Pemantapan Kawasan Hutan), dan dengan ditambahkannya 1 BPKH 
lagi yang berwilayah untuk seluruh Jawa, maka jumlah BPKH menjadi 11. BPKH 
tersebut tetap direncanakan sebagai perpanjangan tangan Badan Planologi 
Kehutanan dengan fungsinya sebagai simpul data dan informasi kehutanan di 
daerah. Namun demikian dikarenakan BPKH tidak ada pada setiap propinsi, maka 
terjadi kesulitan didalam menjalankan perannya sebagai simpul di daerah.  
 
Selain itu perlu dicermati pula bahwa banyak instansi sektor kehutanan maupun non 
kehutanan (seperti BPN, Kimpraswil, dan BPS di pusat, ataupun Dinas Kehutanan 
Propinsi, Dinas Kehutanan Kabupaten, dan BAPEDA di daerah) juga telah dan 
sedang membangun serta mengaplikasikan SIG untuk kepentingan masing-masing 
dengan cakupan wilayah kerja yang sama. Bahkan beberapa instansi di pusat pada 
saat ini telah banyak mengumpulkan data dan informasi sesuai dengan bidang tugas 
dan wilayah kerja yang menjadi tanggungjawabnya. Sedangkan beberapa instansi di 
daerah sedang berusaha untuk terus mengumpulkan atau membangun data dan 
informasi sesuai dengan bidang tugas dan wilayah kerjanya. 
 
Kondisi yang terjadi adalah masing-masing unit pengelola SIG telah membangun 
basis data sesuai dengan wilayah cakupan kerjanya, baik cakupan nasional maupun 
regional dengan tema yang bervariasi. Mengingat permasalahan kehutanan yang 
semakin kompleks, dengan banyaknya kepentingan yang harus dipertimbangkan, 
telah mendorong perlunya penyusunan data dan informasi yang lebih komprehensif. 
Terlebih apabila diperkirakan bahwa pada beberapa tahun mendatang, masih akan 
terus banyak kegiatan yang terutama akan diarahkan pada pembangunan basis data 
secara digital, sesuai dengan kebutuhan masing-masing sektor ataupun lembaga. 
 
4.1.3 Masalah yang dihadapi 

Akan timbul ketidak efisienan dan kekurang efektifan jika masing-masing unit 
pengelola SIG, baik itu di pusat (antar eselon I teknis Departemen kehutanan dan 
antar instansi/lembaga lain) maupun di daerah (antar propinsi dan antara kabupaten) 
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mengembangkan sistem yang ada tanpa koordinasi dengan pengelola SIG yang 
lain. Kesamaan peran sebagai pengelola SIG sesungguhnya bukanlah menjadikan 
suatu masalah, dan tidak perlu dihindari, karena pada dasarnya SIG kabupaten, 
propinsi, dan pusat dalam tiap eselon I yang ada merupakan subsistem-subsistem 
dari sistem SIG yang lebih besar yaitu SIG-Kehutanan.  
 
Hal yang perlu diutamakan adalah koordinasi dan penyeragaman persepsi dalam 
mengelola data SIG kehutanan, minimal untuk penyeragaman data dasar. Walaupun 
detil dapat dibuat secara berbeda, sesuai dengan kepentingannya masing-masing, 
namun data yang dipergunakan sebagai dasar haruslah selalu sama. Untuk 
koordinasi antar pengelola SIG tersebut, baik di pusat maupun di daerah, diperlukan 
suatu peraturan berjenjang yang mengatur tata hubungan kerja dan keterkaitan data 
dan informasi SIG yang dikelola oleh masing-masing pengelola SIG tersebut. 
Sedangkan untuk menyeragamkan persepsi yang menyangkut berbagai aspek data 
spasial sebagai input maupun output utama dalam SIG, perlu dibuat pembakuan 
kodefikasi data spasial serta hal-hal yang berkaitan dengan data spasial. Diharapkan 
jika peraturan berjenjang yang sesuai, dan pembakuan ini diterapkan secara 
bersama, maka komunikasi pengguna SIG di kalangan Kehutanan akan dapat 
berjalan dengan optimal. 
 
Permasalahan tersebut di atas tidak semuanya dapat diatasi oleh lembaga di lingkup 
Departemen Kehutanan saja, keterlibatan instansi luar terutama untuk masalah layer 
dasar seluruh wilayah Indonesia masih tetap diperlukan. Peranan BAKOSURTANAL 
selaku koordinator survey dan pemetaan nasional untuk memecahkan masalah ini 
sangat diharapkan. 
 
Permasalahan-permasalahan yang terjadi di Departemen Kehutanan pada saat ini 
kemungkinan besar juga mencerminkan kondisi pengelolaan SIG dilingkup nasional. 
Hal ini dapat dilihat dari kurangnya informasi tentang apa yang telah dilakukan oleh 
masing-masing institusi dalam melaksanakan pengelolaan SIG dan tingkat 
pertukaran data yang masih rendah antar instansi.  
 
4.1.4. Pengembangan lebih lanjut 

 
Pengelolaan data tersebar dengan pengendalian terpusat merupakan suatu konsep 
yang akan dilaksanakan untuk mengantisipasi permasalahan kesenjangan 
koordinasi antar pengelola data SIG. Konsep tersebut akan diterapkan dengan cara 
dibentuk pusat-pusat atau simpul-simpul data ditiap daerah dengan peran dan 
tanggungjawab masing-masing yang saling melengkapi, dan dibangun suatu sistim 
jaringan yang kuat serta komprehensif diantara simpul-simpul tersebut, dan antara 
simpul-simpul tersebut dengan pusat.  
 
Selanjutnya perlu semakin ditekankan perlunya pembuatan model-model analisa 
SIG untuk kepentingan pemantauan sumber daya hutan, seperti misalnya indikasi 
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areal illegal logging, model deforestasi, dsb. Dengan sistim pengelolaan tersebut, 
aplikasi SIG secara berjenjang dan komprehensif, termasuk pembuatan model untuk 
suatu kebutuhan tertentu menjadi sangat terbantu. 
  
A. Mekanisme 

Pengelolaan dan pengembangan SIG bidang Kehutanan memerlukan keterlibatan 
dan peranan beberapa instansi atau lembaga terkait baik yang berasal dari dalam 
Departemen sendiri maupun dari luar. Dilihat dari  fungsinya maka lembaga tersebut 
dapat berfungsi sebagai pemasok ataupun pengguna data dan informasi kehutanan. 
Adanya keterkaitan antar lembaga ini memerlukan suatu mekanisme pengaturan 
hubungan yang menyangkut koordinasi dan mekanisme pertukaran data. Walaupun 
koordinasi dilakukan secara formal melalui pertemuan-pertemuan yang bersifat 
sporadis maupun hubungan interpersonal antar pengelola SIG, peraturan yang 
berlandaskan hukum yang jelas dan memayungi seluruh kegiatan yang ada dalam 
bentuk Keppres ataupun undang-undang sangatlah diperlukan. 
 
Sementara itu mekanisme pertukaran data di lingkup Departemen Kehutanan telah 
dapat dilakukan relatif secara lancar mengingat hal ini dilaksanakan dilingkup sendiri 
dan telah adanya pembakuan kodifikasi data spasial di lingkup Departemen 
Kehutanan. Untuk mengatasi permasalahan karena adanya beberapa sumber peta 
dasar tersebut, Departemen Kehutanan telah mencoba menentukan skala prioritas 
penggunaan peta dasar berdasarkan ketersediaan peta. Prioritas tersebut dimulai 
dengan Peta RBI disusul dengan Peta Topografi dan Peta JOG, kalau ketiganya 
tidak ada baru digunakan peta yang lain misalnya peta RePPProT. 
 
Tata laksana pengelolaan data SIG tidak saja mengatur masalah mekanisme 
pertukaran data akan tetapi secara tidak langsung akan merangsang adanya 
standarisasi data. Hal ini dikarenakan pertukaran data perlu didukung oleh data yang 
berstandar. 
 
Mekanisme pertukaran data tidak saja diperlukan oleh pengelola data SIG akan 
tetapi juga oleh pengguna. Mekanisme ini akan terlaksana dengan baik apabila 
semua pihak bersepakat dalam beberapa hal sebagai berikut : 

1. Standar skala peta optimal untuk level yang berbeda 
2. Kode yang sama untuk obyek yang sama 
3. Keunikan tugas pokok dan fungsi masing-masing instansi sehingga tidak 

timbul duplikasi data 
4. Legalitas suatu data dari sektor tertentu 
5. Media koordinasi pertukaran. 
6. Prosedur pemanfaatan atau pertukaran data 
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B. Standardisasi 

Kodefikasi data spasial yang baku sangat dibutuhkan untuk memberi arah  
penyusunan basis data serta menjamurnya perkembangan SIG baik di Departemen 
Kehutanan, maupun di daerah yang berkaitan dengan sektor kehutanan. Badan 
Planologi sebagai instansi yang bertanggungjawab terhadap inventarisasi hutan dan 
penataan kawasan sudah lebih dari sepuluh tahun mengoperasikan SIG dalam 
menunjang kegiatannya terutama dalam Inventarisasi Hutan Nasional (NFI). Sudah 
banyak tema baik secara nasional maupun parsial (pulau) disusun dan dimanfaatkan 
oleh berbagai instansi intern dan extern Departemen kehutanan. Untuk terus 
mendukung optimalisasi pemanfaatannya, dipandang perlu untuk menyusun kode 
baku untuk membaca maupun berkomunikasi antar pengguna, penyumbang 
maupun pengelola data spasial.  
 
Diharapkan dengan adanya pembakuan ini masing-masing instansi juga akan jelas 
tugas dan kewajibannya dalam menyusun basis data serta data yang disusun sesuai 
dengan pembakuan yang ada, sehingga selalu komunikatif dengan pengguna SIG 
lain.  
 
Di sisi lain, dengan adanya pembakuan kodefikasi data spasial juga diharapkan 
dapat menyadarkan bahwasannya SIG yang ada merupakan subsistem dari 
Informasi Geografis yang lebih luas yaitu sistem informsi geografis Kehutanan 
sehingga pada gilirannya akan mengakselerasi penyusunan basis data secara 
nasional di bidang kehutanan. 
 
Perlu disadari pula bahwasanya pada tingkat tertentu pada saat ini masing-masing 
instansi telah memiliki basis data, yang mungkin belum sesuai dengan kodefikasi 
yang ada. Untuk itu agar tidak menambah kesimpangsiuran komunikasi data digital 
pada saat ini dan di kemudian hari, akan lebih baik jika secepat mungkin masing-
masing melaksanakan penyeragaman sesuai dengan standarisasi yang ada. 
Kodefikasi dari layer yang digunakan di suatu instansi/unit pengelola SIG mungkin 
sekali belum tercakup dalam standarisasi, oleh karena itu peran aktif pengguna GIS 
sangat diharapkan untuk menginformasikan ke Badan Planologi kehutanan cq Pusat 
Perpetaan Kehutanan agar betul betul diperoleh standarisasi yang komprehensif 
untuk Departemen Kehutanan. 
 
Untuk memacu standardisasi data digital spasial di Departemen Kehutanan telah 
disyahkan SK Menhutbun No. 251/Kpts-VII/1999 mengenai Pedoman Pengolahan 
dan Penyajian Data Digital Sistem Informasi Geografis untuk keperluan 
Pembangunan Kehutanan yang diantaranya menyebutkan Badan Planologi 
berwenang menetapkan data dasar digital kehutanan.  
 
Pada saat ini juga sedang dirintis suatu standard pembakuan penafsiran citra satelit 
Landsat, sebagai salah satu sumber data untuk tema penutupan lahan. Tema 
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tersebut merupakan salah satu tema yang menjadi tanggung jawab Departemen 
Kehutanan sebagai salah satu simpul data digital spasial kehutanan. Standard 
pembakuan tersebut akan dilengkapi dengan standardisasi dan kodefikasi setiap 
kenampakan penutupan lahan, sehingga nantinya suatu kenampakan penutupan 
lahan dengan kode penutupan lahan tertentu di suatu tempat, akan konsisten 
dengan kenampakan penutupan lahan yang sama dan berkode sama di tempat 
yang lain.  
 
4.2. Sistem Informasi Geografis Untuk pengelolaan sumberdaya alam 

Tulisan ini disusun oleh Atie Puntodewo, Sonya Dewi dan Jusupta Tarigan.  Secara 
lengkap tulisan ini dibuat dalam 5 bagian, namun bagian yang terakhir yang secara 
spesifik membahas aplikasi dibidang pengelolaan sumberdaya alam. 
 
4.2.1. Prioritas Area Rehabilitasi Hutan dan Lahan (RHL) 

A. Formulasi permasalahan 
Upaya Rehabilitasi Hutan dan Lahan (RHL) sangat penting untuk memulihkan 
kembali fungsi lahan yang kritis. Yang dimaksud dengan lahan kritis adalah lahan 
yang telah mengalami kerusakan sehingga kehilangan atau berkurang fungsinya 
sampai pada batas toleransi.  
Sasaran kegiatan RHL adalah lahan-lahan dengan fungsi lahan yang ada kaitannya 
dengan kegiatan rehabilitasi dan penghijauan, yaitu fungsi kawasan hutan lindung, 
fungsi kawasan hutan lindung di luar kawasan hutan dan fungsi kawasan budidaya 
untuk usaha pertanian. 
B. Kriteria yang digunakan 
Kriteria kegiatan Rehabilitasi Hutan dan Lahan mengacu kepada dokumen ’Standar 
dan Kriteria Rehabilitasi Hutan dan Lahan’, yang merupakan Lampiran dari SK 
Menteri Kehutanan No. 20/Kpts-II/2001 tentang Pola Umum dan Standar serta 
Kriteria Rehabilitasi Hutan dan Lahan. Dari peta Kabupaten Kutai Barat diatas, 
daerah yang keberadaan data yang relatif lengkap adalah daerah di dalam kotak 
merah. Oleh karena itu, upaya pelaksanaan kegiatan Rehabilitasi Hutan dan Lahan 
akan difokuskan pada daerah tersebut. Jika data untuk daerah lainnya sudah 
terkumpul, langkah-langkah yang sama bisa diterapkan untuk seluruh luasan Kutai 
Barat. 
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C. Konsep Dasar 
• RHL adalah segala upaya untuk memulihkan dan mempertahankan fungsi 

sumberdaya hutan dan lahan. 
• RHL diselenggarakan pada semua kawasan hutan dan lahan yang kritis dan 

tidak produktif. 
• RHL dilaksanakan berdasarkan kondisi spesifik biofisik dan potensi masyarakat 

setempat. 
• RHL dilaksanakan dengan pendekatan partisipatif dalam rangka pengembangan 

kapasitas masyarakat. 
 
D. Metodologi 
Sebelum kita bisa menentukan langkah-langkah yang diperlukan, kita harus 
memformulasikan permasalahan, menyesuaikan dengan data yang ada dan memilih 
operasi yang perlu diambil untuk menjawab permasalahan. Langkah-langkah yang 
perlu dijalankan adalah identifikasi data dasar, pemrosesan data dasar menjadi data 
yang dapat menentukan tingkat kekritisan suatu area, dan yang terakhir adalah 
analisa hasil. 
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E. Identifikasi data dasar 
Dalam hal pembuatan peta Lahan Kritis (LHK), kita mengidentifikasi data-data dasar 
yang berkaitan dengan kekritisan lahan sebagai berikut: 
• DEM (Digital Elevation Model) dari peta kontur yang diambil dari Peta Rupabumi 

Indonesia, skala 1:50.000 produksi Bakosurtanal. DEM adalah suatu citra yang 
secara akurat memetakan ketinggian dari permukaan bumi. DEM ini dibuat dari 
peta kontur, 

• peta aliran sungai dan peta titik tinggi dengan resolusi 30 meter. 
• Peta Tata Guna Hutan Kesepakatan, diperoleh dari Departemen Kehutanan. 
• Peta Rencana Tata Ruang dan Wilayah Propinsi, diperoleh dari Bappeda Tk I. 
• Peta Penutupan Lahan 1996 hasil klasifikasi citra Landsat TM. 
• Peta Kebakaran Hutan 1997/1998 produksi GTZ/IFFM. 
• Peta Kesesuaian Lahan 1:250.000 produksi RePPProT. 
 
F. Proses pengolahan data dasar 
Menjadi data yang dapat digunakan untuk menentukan tingkat kekritisan suatu area. 
Proses yang dijalankan adalah: 
• Kelas kelerengan dibuat dari data dasar DEM dengan cara membuat peta lereng, 

kemudian diklasifikasikan (1:0-8%, 3:8-15%, 5:15-25%, 7:25- 
• 40%, 10:>40%). 
• Kelas fungsi dibuat dari peta TGHK (1:perairan, 2:area penggunaan lain, 4:hutan 

produksi yang bisa konversi, 6:hutan produksi, 6:hutan produksi terbatas, 
10:hutan lindung, hutan suaka alam dan wisata). 

• Kelas peruntukkan dibuat dari peta RTRWP (1:kawasan lindung dan perairan, 
7:kawasan budi daya kehutanan, 10:kawasan budi daya nonkehutanan). 

• Kelas kerusakan dibuat dari peta Kebakaran hutan (1:no data, 5:tingkat 
kerusakan rendah, 7: tingkat kerusakan sedang, 10: tingkat kerusakan tinggi). 

• Dari peta kesesuaian lahan dibuat peta jenis tanah untuk menghasilkan kelas 
erosi (1:gambut, 3:alluvium, 5:balsa tuff, 7:limestone, 10:sandstone). 

• Kelas vegetasi dibuat dari peta penutupan lahan (1:hutan, 2:karet, 3:belukar tua, 
8:belukar muda dan semak, 10:alang-alang dan daerah terbuka). 

 
G. Pelaksanaan pemodelan 
Untuk keperluan pemodelan, kelas-kelas yang di dapatkan ini kemudian di-overlay 
berdasarkan skema pembobotan yang dibuat berdasarkan pengalaman pemodel 
sebagai berikut: 
• kelas lereng (15). 
• kelas fungsi (5). 
• kelas peruntukkan (5). 
• kelas kerusakan (10). 
• kelas vegetasi (50). 
• kelas erosi (15). 
Berikut disajikan urut-urutan proses di atas dalam bentuk diagram alur: 
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H. Perangkat lunak untuk pemodelan 
Anda bisa menggunakan beberapa perangkat lunak yang mempunyai fasilitas 
pengolahan data raster seperti IDRISI, ArcView Spasial Analyst dan sebagainya. 
Dalam pelatihan, kami menggunakan ekstension ModelBuilder yang merupakan 
bagian dari Spasial Analyst (untuk versi 2 atau yang lebih baru). Langkah-langkah 
yang diperlukan jika menggunakan ModelBuilder: 
 
• Aktifkan perangkat lunak ArcView dan buka sebuah view kosong. Masukkan 

kedalam view tersebut, seluruh data dasar yang akan digunakan dalam proses 
seperti yang terdapat pada diagram alur diatas.  

• Setelah itu, aktifkan ekstension ModelBuilder dengan cara memilih File - 
Extensions. Beri tanda centang pada ModelBuilder. Perhatikan bahwa ada 
tambahan ikon ’Model’ pada menu utama, klik ikon tersebut dan pilih ’Start Model 
Builder’ yang akan membuka satu windows tersendiri. 

• Kemudian, pada window tersebut masukkan data dasar yang akan diproses 
dengan mengklik tombol   yang merupakan tombol input akan muncul kotak 
dengan nama Data. Misalkan kita akan mulai dengan memasukkan data DEM, 
maka klik kotak data tadi, dan ganti dengan Theme. Isi properties nya seperti 
nama, berasal dari data yang mana, field apa yang akan dijadikan acuan dan 
diakhiri oleh OK. 

• Tahap kedua adalah memasukkan proses apa yang akan dikenakan pada data 
kita tadi, dengan mengklik tombol  yaitu tombol proses. Sekarang muncul 
elipse bertuliskan Function untuk menginformasikan fungsi apa yang akan kita 
lakukan terhadap data dan kotak bertuliskan Derived Data yang merupakan 
tempat data baru yang dihasilkan. 
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• Hubungkan kota Theme yang berisi data DEM kita dengan elipse Function 

dengan menggunakan tombol . Kemudian klik Function dan pilih Terrain yang 
berisi fungsi untuk membuat Slope, Aspect, Hillshade, Contour. Untuk data kita 
memilih Slope.  

• Sekarang windows ModelBuilder akan tergambar seperti berikut. 
 

 
• Lakukan hal yang sama untuk semua data dasar yang akan digunakan pada 

proses pemodelan dengan fungsi yang disesuaikan dengan tujuan seperti yang 
telah dijabarkan dalam metodologi. Setelah seluruh data dasar yang kita inginkan 
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masuk kedalam ModelBuilder dan di proses maka hasilnya seperti terlihat pada 
halaman 118. 

• Tahap selanjutnya adalah proses overlay dari seluruh data, pilih Add Process – 
Overlay – Weighted Overlay.. seperti gambar berikut 

 
• Kemudian muncul menu selanjutnya, dan masukkan nilai bobot, seperti yang 

sudah ditentukan, yaitu kelas lereng (15), kelas fungsi (5), kelas peruntukkan (5), 
kelas kerusakan (10), kelas vegetasi (50), kelas erosi (15). Jumlah bobot harus 
sama dengan 100. Maka pada layar tampak sebagai berikut: 
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Hasil proses data dasar 

 
• Setelah dilakukan overlay, kita mendapatkan hasil akhir berupa Peta Lahan 

Kritis, seperti terlihat pada halaman 119. 
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Hasil akhir 

 
 
4.2.2. Estimasi Potensi Rotan di DAS Kedang Pahu  
 
A. Formulasi permasalahan 
Aplikasi selanjutnya adalah aplikasi untuk menggunakan SIG untuk mengestimasi 
potensi rotan yang ada di Daerah Aliran Sungai (DAS) Kedang Pahu. 
Pada aplikasi ini, kita melihat potensi rotan dari berbagai aspek, berdasarkan data 
penunjang dan pengalaman lapang yang kita miliki. Dalam aplikasi ini, suatu daerah 
dikategorikan berpotensi rotan tinggi apabila secara biofisik rotan bisa tumbuh 
dengan baik, dan secara infrastruktur dan secara legal bisa dijangkau oleh 
masyarakat untuk pemanenan. 
 
B. Asumsi yang digunakan 
• Rotan yang bisa dipanen ada di daerah dengan tutupan lahan belukar tua (di 

atas 10 tahun) dan hutan. 
• Berjarak kurang dari 4 km dari pemukiman atau kurang dari 4 km dari sungai 

yang bisa dicapai kurang dari 8 jam perjalanan menggunakan ketinting dari 
pemukiman. 

• Secara biofisik areal tersebut cocok untuk tumbuhnya rotan. 
• Seandainya terkena kebakaran pada tahun 1997 hanya sampai tingkat 0-1. 
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• Tidak terdapat pada area di sekitar jalan logging, HTI, perkebunan dan 
pertambangan. 

 
C. Metodologi 
Setelah memformulasikan permasalahan yang ada dan menyesuaikannya dengan 
data yang ada, maka kita dapat menentukan langkah-langkah yang akan dijalankan. 
 
D. Identifikasi data dasar 
Data-data dasar yang dapat dikumpulkan adalah: 
• Peta Jaringan Sungai.  Data tersebut diambil dari peta topografi skala 1:50.000 

dari BAKOSURTANAL. 
• Peta Jaringan Jalan.  Diambil dari peta topografi skala 1:50.000 produksi 

Bakosurtanal dan delineasi dari Landsat TM. 
• Peta Pemukiman.  Diambil dari peta topografi skala 1:50.000 produksi 

Bakosurtanal. 
• Peta Penutupan Lahan 1996.  Merupakan hasil klasifikasi citra Landsat TM. 
• Peta Kebakaran Hutan 1997/1998 produksi GTZ/IFFM. 
• Peta Kesesuaian Lahan 1:250.000 produksi RePPProT. 
• Peta DEM  
 
E. Proses pengolahan data dasar. 
• Dari data jaringan sungai dilihat dari dua aspek yaitu aspek biofisik dan aspek 

aksesibilitas. 
o Aspek biofisik 

Potensi rotan dihitung berdasarkan estimasi mengenai tempat dimana dia 
dapat tumbuh yang direpresentasikan menurut jaraknya dari sungai. 
Kemudian dari jarak yang didapat diberi skor menurut prioritas 
ditemukannya (1:0-0.5 km, 3: >5.0 km, 8:3.0-5.0 km, 10:0.5-3.0). 

o Aspek aksesibilitas 
Potensi rotan dihitung berdasarkan tingkatkemudahannya dicapai melalui 
sungai.  Dari jarak yang didapat diberi skor (2:>4 km, 5:2-3 km, 8:1-2 km, 
10:0-1 km). 

• Sama halnya dengan jaringan sungai, data jaringan jalan juga dilihat dari dua 
aspek: 

o Aspek biofisik 
Potensi rotan dihitung berdasarkan kemungkinan tumbuhnya di sekitar 
jalan. Mula-mula buat buffer 5 km untuk masing-masing kelas jalan dengan 
asumsi bahwa lebih dari 5 km sudah tidak ada pengaruh jalan terhadap 
kemungkinan tumbuhnya rotan. Kemudian beri skor berdasarkan kelas 
jalan (1:Jalan PU, 3: Jalan aspal, 5: Jalan tambang, 7:Jalan logging, 
10:Jalan swadaya). 

o Aspek aksesibilitas 
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Potensi rotan dihitung berdasarkan kemudahan dicapai dari lokasi 
pemukiman. Pertama-tama buat buffer sebesar 30 km dari pemukiman, 
kemudian ekstrak hanya jalan kelas 1, 3 dan 4 yang tercakup dalam buffer. 
Beri skor berdasarkan jarak tempuh (1:>6 km, 5:4-6 km, 10:0-4 km). 

• Berdasarkan aksesibilitasnya dari pemukiman, potensi rotan dihitung berdasarkan 
kemauan petani berjalan kaki dari pemukiman untuk mencapai area dimana rotan 
ditemukan. Skor dibuat berdasarkan waktu tempuh (1:>10 jam, 4:7-10 jam, 8:4-7 
jam, 10:0-4 jam). 

• Berdasarkan penutupan lahan yang ada dicari 
kemungkinan daerah tumbuhnya rotan, lalu diberi skor berdasarkan potensinya 
(1:daerah terbuka, alang-alang, karet, 2:semak, 6:hutan, 8:belukar muda, 
10:belukar tua). 

• Dari peta kebakaran hutan dicari tingkat kerusakan 
karena kebakaran, lalu diberi skor potensi kemungkinan tumbuhnya rotan 
(1:tingkat kerusakan sedang dan tinggi, 10: tidak terbakar dan tingkat kerusakan 
rendah). 

• Berdasarkan peta Kesesuaian Lahan untuk agro-forest, 
beri skor potensi rotan (1:tidak sesuai, 10:sesuai). 

• Dari peta DEM dibuat peta kelerengan, kemudian 
beri skor potensi rotan (1:>40%, 4:25-40%, 6:15-25%, 8:8-15%, 10:0-8%). 

• Pelaksanaan pemodelan 
Overlay-kan hasil yang didapat berdasarkan skema pembobotan yang dibuat 
berdasarkan pengalaman pemodel, sebagai berikut: 
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Overlay multiple layer potensi rotan berdasarkan masing-masing variabel dengan 
skema pembobotan yang disesuaikan dengan expert judgement, menggunakan 
ArcView/Model Builder. 
Adapun hasil proses data dasar yang dijalankan untuk mengestimasi potensi rotan 
yang ada adalah sebagai berikut: 
 
Hasil proses data dasar 

 

 
 
Hasil akhir: Peta Potensi Rotan 
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Peta Potensi Rotan Peta ini dihasilkan dari overlay yang dilakukan terhadap data 
seperti diatas. Hasil akhir yang didapat adalah daerah yang merah yaitu yang 
mempunyai potensi rotan tinggi. 

  
 
Tabel estimasi potensi rotan per kecamatan per kelompok potensi 
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Catatan: 
•  Hasil estimasi yang diperoleh sangat tergantung kepada asumsi yang dipakai; 

semakin dekat asumsi yang dipakai dengan kenyataan, semakin akurat estimasi 
yang dihasilkan. 

•  Keterbatasan data juga mempengaruhi hasil estimasi, contoh: citra yang tertutup 
awan dan ketiadaan peta kontur untuk sebagian area menjadi faktor penghambat 
dalam mendapatkan estimasi dari seluruh area. 

 
• Dalam menginterpretasi hasil estimasi untuk perencanaan business dan 

management terutama yang berbasiskan masyarakat lokal, kita harus 
mempertimbangkan banyak faktor lain seperti kebijakan, institusi, pasar, persepsi 
masyarakat, mata pencaharian lain, dsb. 
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